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Preface

This guide contains information and instructions necessary for the
normal operation and management of the Scalar i6000 library. This
guide is intended for system administrators, operators, or anyone
interested in learning about or using the Scalar i6000 library after its
initial installation and configuration. Be aware that you must have
administrator privileges to use many of the features that this guide
describes.

Caution: Be sure to read all operating instructions in this manual
and in the System, Safety, and Regulatory Information
Guide before operating this product.

Product Safety Statements

This product is designed for data storage and retrieval using magnetic
tape. Any other application is not considered the intended use.
Quantum will not be held liable for damage arising from unauthorized
use of the product. The user assumes all risk in this aspect.

This unit is engineered and manufactured to meet all safety and
regulatory requirements. Be aware that improper use may result in

Quantum Scalar i6000 User’s Guide ix
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Mechanical Locks

Power Button on the
Library’s Indicator Panel

Mercury Statement

bodily injury, damage to the equipment, or interference with other
equipment.

Caution: Be sure to read all operating instructions in this manual
and in the System, Safety, and Regulatory Information
Guide before operating this product.

WARNING: Before powering on or using this equipment, read THE
System, Safety, and Regulatory Information Guide. Keep
the Guide for future reference.

Note: When drive sled positions are empty, drive cover plates must be
installed and in place at all times to prevent access into the
empty drive sled Positions.

The access and service doors can only be opened with a key. The key
should be kept by an authorized person at your company. Access to the
interior of the library is both a data-integrity and safety issue.

Switching off the Power button on the indicator panel, located on the
front of the library, removes power from the electronics, which causes
the picker to stop immediately. This button also removes power from
the drives.

WARNING: This power button functions as a power interrupt only. To
completely remove all power before servicing or in an
emergency, turn off the circuit breaker on the power
distribution unit, and then disconnect the power cord
from the electrical source.

Projectors, LCD displays, and some multifunction printers may
use lamp(s) that contain a small amount of mercury for

energy-efficient lighting purposes. Mercury lamps in these

products are labeled accordingly. Please manage the lamp

Quantum Scalar i6000 User’s Guide
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according to local, state, or federal laws. For more information, contact
the Electronic Industries Alliance at www.eiae.org. For lamp-specific
disposal information check www.lamprecycle.org.

Disposal of Electrical
and Electronic
Equipment

This symbol on the product or on its packaging
indicates that this product should not be disposed of
with your other waste. Instead, it should be handed
over to a designated collection point for the
recycling of electrical and electronic equipment. The
separate collection and recycling of your waste
equipment at the time of disposal will help to
conserve natural resources and ensure that it is
recycled in a manner that protects human health and
the environment. For more information about where you can drop off
your waste equipment for recycling, please visit our Web site at: http:/
gcare.quantum.com or contact your local government authority, your
household waste disposal service or the business from which you
purchased the product.

Product Model Number

The Scalar i6000 Regulatory Model Number is as follows:
SCi6000.

Explanation of Symbols and Notes

The following symbols appear throughout this document to highlight
important information.

Note: Indicates important information that helps you make better
use of your system.

Quantum Scalar i6000 User’s Guide Xi
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Caution: Indicates a situation that may cause possible damage to
equipment, loss of data, or interference with other
equipment.

WARNING: Indicates a potentially hazardous situation which, if not
avoided, could result in death or bodily injury.

Other Documents you Might Need

The following documents are also available for this product. These
documents can be found at www.quantum.com/support.

* Scalar i6000 Planning Guide (6-66882-xx)

* Scalar 16000 Release Notes (6-66883-xx)

e Scalar 12000/i6000 Maintenance Guide (6-66880-xx)
e Scalar 16000 Installation Guide (6-66881-xx)

* Scalar i6000 Unpacking Instructions (6-00771-xx [Gen 1] or 6-
67467-01-xx [Gen 2])

* System, Safety, and Regulatory Information Guide (6-00618-xx)

Note: Release Notes are also available for this product. The Release
Notes describe changes to your system or firmware since the
last release, provide compatibility information, and discuss any
known issues and workarounds. The Release Notes can be
found at www.quantum.com/support.
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Contacts

Quantum company contacts are listed below.

Quantum Corporate Headquarters

To order documentation on the <Product Name> or other products
contact:

Quantum Corporation (Corporate Headquarters)
1650 Technology Drive, Suite 700
San Jose, CA 95110-1382

Technical Publications

To comment on existing documentation send e-mail to:

doc-comments@qguantum.com

Quantum Home Page

Visit the Quantum home page at:

http://www.quantum.com

Getting More Information or Help

Quantum.
Global Services

StorageCare™, Quantum’s comprehensive service approach, leverages
advanced data access and diagnostics technologies with cross-
environment, multi-vendor expertise to resolve backup issues faster and
at lower cost.

Accelerate service issue resolution with these exclusive Quantum
StorageCare services:

* Service and Support Website - Register products, license software,
browse Quantum Learning courses, check backup software and
operating system support, and locate manuals, FAQs, firmware
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downloads, product updates and more in one convenient location.
Benefit today at:

http://www.quantum.com/ServiceandSupport/Index.aspx

eSupport - Submit online service requests, update contact
information, add attachments, and receive status updates via
e-mail. Online Service accounts are free from Quantum. That
account can also be used to access Quantum’s Knowledge Base, a
comprehensive repository of product support information. Sign up
today at:

http://www.quantum.com/osr

StorageCare Guardian - Securely links Quantum hardware and the
diagnostic data from the surrounding storage ecosystem to
Quantum's Global Services Team for faster, more precise root cause
diagnosis. StorageCare Guardian is simple to set up through the
internet and provides secure, two-way communications with
Quantum'’s Secure Service Center. More StorageCare Guardian
information can be found at:

http://www.quantum.com/ServiceandSupport/Services/

Guardianinformation/Index.aspx

For further assistance, or if training is desired, contact the Quantum

Customer Support Center:

United States

800-284-5101 (toll free)
949-725-2100

EMEA 00800-4-782-6886 (toll free)
+49 6131 3241 1164
APAC +800 7826 8887 (toll free)

+603 7953 3010

For worldwide support:

http://www.quantum.com/ServiceandSupport/Index.aspx
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Chapter 1
Description

The Scalar i6000 library automates the retrieval, storage, and control of
tape cartridges. Application software on the host can use the library’s
robotics to mount cartridges into tape drives and retrieve them without
operator intervention.

The library can be installed on a solid or raised floor. It has a standard
19-inch rack footprint and can be placed in a standard server rack space.
Because the library provides access by way of the access and service
doors, the library can be placed with either side against a wall or
between racks.

In December, 2011, the library robotics were redesigned. The redesign
accommodates either a single robot or dual robotics. The original robot
hardware is referred to as Gen 1; the new robot hardware is referred to
as Gen 2.

With firmware version i11, robots in a dual-robot system work in an
active/active manner, where both robots perform move commands and
other library operations.

In March 2013, the library electronics were redesigned, including a new
second generation Management Control Blade (MCB 2). The electronics
redesign is referred to as Gen2 Electronics and is required for to support
new features, such as Active/Active operation for Dual Robots and the
High-Density Expansion Module (HDEM).

In June 2015 new Series 3 modules were released for the Control
Module (CM3), Drive Ready Expansion Module (DREM3) and Storage



Chapter 1: Description

Figure 1 Robot Tab

Expansion Module (SEM3). These new modules are capable of a higher
number of drive support than the previous modules.

Dual robotics libraries require special modules on either end called
parking modules, which house the robots when not in use. See Dual
Robotics Configurations and Parking Modules on page 7 for more
information.

You can tell which generation robot you have via the library user
interface. The library displays which generation of robot hardware is
installed. Select Monitor > System from the menu, click the Robot tab,
and look in the Generation column (see Figure 1).

Mame Status State Serial # | Version Generation Parke:
Left Active Online AMJ0010140025 |630Q.DP166 Gen 2 Yes
Right Passive Qnline AMJO010140012 |630Q.DP166 Gen 2 Yes

Ll

[ Send ][ Close ][ Help ]

To determine what generation electronics your library is running, select
Monitor > System from the menu, click the Components tab and look in
the Name column. If you have MCB2 and RCU2, you have gen2
electronics. Any other MCB or RCU level means gen1 electronics.

Quantum Scalar i6000 User’s Guide



Figure 2 Components Tab
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p
B System Status &F
[ Components | @ Robots r (& Drives |

Name I ID I Status I Version
Library: hubble 273100107 Online 710Q.GS01600i12.2.1
MCB2B MCB2-052 Good 710G.GM01600
RCU2 RCU2-069 Good 710G.GP022
Library UpTime 2 days 03h:55m:20s  |N/A N/A

( send ][ Close |( Help |

For Gen 1 systems, the maximum library can be configured to
accommodate from 100 LTO cartridges to 5,322 LTO cartridges (for a
single-robot library) or 5,376 LTO cartridges (for a dual-robot library).

For Gen 2 systems, the maximum library can be configured to
accommodate from 100 LTO cartridges to 7,146 LTO cartridges (for a
single-robot library) or 7,224 LTO cartridges (for a dual-robot library).

In March of 2013, a High Density Expansion Module (HDEM) was made
available to provide increased storage capabilities. A single HDEM can
hold up to 720 total slots; 540 on two independent carousels and 240
on the front door.

This chapter provides a description of the following features and
components:

Note: The library software features described in this guide apply to
both the Scalar i2000 and the Scalar i6000. However, certain
features are available on Scalar i6000 only.

This chapter includes the following sections:
* Front View on page 5

* Hardware Configuration Options on page 6

* Dual Robotics Configurations and Parking Modules on page 7

* Control Module on page 10
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* Expansion Modules on page 13

* Library Management Module on page 18

* |/0O Management Unit on page 21

* Robot on page 25
* Import/Export Stations on page 25

* Cartridges on page 28
* Cartridge Magazines on page 29

* Tape Drives and Media on page 33

* Mixed Media Support and Rules on page 35

* Support for WORM on page 36
* Operator Panel on page 37

* Power System on page 38

* Library Features on page 39

4 Quantum Scalar i6000 User’s Guide



Chapter 1: Description
Front View

Front View

Figure 3 shows a front view of the library, consisting of a control
module and an expansion module.

Figure 3 Front View of a
Control Module and Expansion
Module

expansion module

2 | /

operator panel

control module — ————— touch screen

I/E station

I
\ access doors

| HI
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Hardware Configuration Options

Hardware Configuration Options

The library is designed for ease of installation, configuration, and field
upgrades. The minimum library configuration consists of one control
module. You can add up to 15 expansion modules as storage and tape
drive requirements change.

Note: Expansion modules in positions nine through sixteen are no
longer storage-only modules and can contain I/E stations or
drives.

For LTO, the maximum library configuration can accommodate
* 1 control module
* 0to 15 expansion modules
* Gen 1 systems: 100 to 5322 cartridges (single robotics)

* Gen 2 systems: 100 to 7146 cartridges (single robotics), or 100 to
7224 (dual robotics). For libraries containing high-density expansion
modules, the maximum capacities are 12,006 LTO cartridges (for a
single-robot library) or 11,760 LTO cartridges (for dual-robot
libraries).

* 1 to 192 tape drives.
An LTO library I/E Station configuration can accommodate:

* 1 to 8 24-slot Import/Export (I/E) stations in the control module and
first 7 expansion modules.

Or

* 1 24-slot I/E in the control module and up to 7 72-slot I/E stations
and first 7 expansion modules.

6 Quantum Scalar i6000 User’s Guide
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Dual Robotics Configurations and Parking Modules

Dual Robotics Configurations and Parking Modules

Quantum Scalar i6000 User’s Guide

A dual robotics library requires Gen 2 robotics hardware. A dual robotics
library requires, at a minimum, a control module, a left parking module,
and a right parking module. See Figure 4.

The left and right parking modules have the same size and appearance
as expansion modules, but they function differently. Each parking
module contains a “parking space” in which the respective left or right
robot resides when not in use. The “parking space” occupies four
magazine columns which cannot be used for storage.

The left parking module is located to the left of the control module in
position zero. It is referred to in the user interface as “module 0.” The
left parking module does not contain tape drives, I/E stations, or power
supplies. The control module supplies its power. If you are upgrading to
dual robotics, you will receive a left parking module to add onto your
existing system. This increases your system size, so you must take this
into account when planning for an upgrade.

The right parking module is the right-most module in the system. As of
firmware version i11, a right parking module can contain drives in any
position in the library and up to one 24-slot I/E station. Right parking
modules may not contain 72-slot I/E stations.

Note: High-density expansion modules (HDEM) cannot be used as
right parking modules.

If you are upgrading a single-robotics library to a dual-robotics library,
the existing right-most expansion module can, in most cases, be
converted into a right parking module. However, if the existing right-
most expansion module contains a 72-slot I/E station, you may need
another module to be added to the right of your system which will
become the right parking module. If space considerations prohibit the
addition of another module, then the right-most module will be
swapped with another module in the library that does not contain a
72-slot I/E station.
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Dual Robotics Configurations and Parking Modules

Figure 4 Dual Robotics Library Side panels, doors, and door posts have been removed for clarity.

Left parking Control Expansion Right parking
module module module module
(Position 0) (Position 1) (Position 2) (Position 3)

Right parking space
(right-most two columns)

Left parking space
(left-most two columns)

8 Quantum Scalar i6000 User’s Guide
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Chapter 1: Description
Control Module

Figure 6 Right Parking Module
Slot Configuration (Dual
Robotics Only)

? = columns
/ unavailable
]

for storage

= Calibration
target

Optional drive
clusters

mr " r A
| | | |
| [ | [
P4 i | Y
| | | | Optional
T | | | 24-slot
I/E
il o B | | station
[ [
L — J

Rack 1 (rear wall) Rack 2 (door)

Control Modul

10

e

All libraries contain a control module. A single-frame library consists of a
control module only. The control module manages library operations via
the library management module and includes an operator panel touch
screen for local operator use. For more information, see:

* Library Management Module on page 18

* Support for WORM on page 36

Quantum Scalar i6000 User’s Guide
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Control Module

The control module also contains all of the other components common
to expansion modules, including:

* Import/Export Stations on page 25

* Tape Drives and Media on page 33

* Cartridges on page 28
* Cartridge Magazines on page 29

* Power System on page 38

The control module always occupies module position 1 in the library. (In
dual-robotics configurations, the left parking module is in position 0.)

Figure 7 Front and Back View
of the Control Module

front view back view

;nnadgazmes /o
cartridge . management
? X unit
slots N
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BN station
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supplies
accessor picker
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Control Module

Figure 8 Front and Back View
of a Series 3 Control Module
(CM3)
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Expansion Modules

Expansion Modu

Quantum Scalar i6000 User’s Guide

les

Expansion modules enable the library to expand by adding space for
tape drives, an I/E station, and storage. Each expansion module from 96
to 780 LTO cartridge slots depending on the number of tape drives
installed and whether an I/E station is installed. See Figure 9 on page 14
for location information.

In Gen 1 configurations, the library’s maximum configuration includes
up to 11 expansion modules for a total of 12 modules. in Gen 2
configurations, up to 16 modules can be added. Expansion modules can
be added only to the right of the control module.

In firmware version i11, all standard expansion modules can
accommodate the following functional units:

* |/O Management Unit on page 21

* Control Management Blade on page 21

* Fibre Channel I/O Blades on page 22

» Ethernet Expansion Blades on page 22

* Robot on page 25

* Import/Export Stations on page 25 (optional)

» Tape Drives and Media on page 33 (drives are optional)

* Cartridge Magazines on page 29

* Support for WORM on page 36

* Power System on page 38 (required only if drives are installed; if an
expansion module contains only cartridges, all power is derived
from the control module).

High-density expansion modules can accommodate the following
functional units:

* Robot on page 25

* Import/Export Stations on page 25 (optional)

* Tape Drives and Media on page 33 (media only)

* Cartridge Magazines on page 29

* Support for WORM on page 36

13
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Expansion Modules

* Power System on page 38

Figure 9 SEM with 24 Slot I/E
Station

n cartridge
I magazines

(optional)

I/E station 24 slot

(optional)

Middle x-axis rail

14

drive side

door side
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Expansion Modules

Figure 10 Series 3 SEM with a

24-slot I/E Station

magazines

24-slot
/ I/E station
DREM drive ‘ (optional in
cluster DREM and
N T SEW

drive side door side
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Expansion Modules

Figure 11 SEM with 72 Slot I/E
Station

drive side

16

magazines

72-slot

I/E station
(optional)

door side
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Expansion Modules

Figure 12 Series 3 SEM with a
72-slot I/E Station
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Library Management Module

Library Management Module

The library management module is located in the control module. It
controls system hardware and enables external devices to perform
configuration and obtain system status. The library management
module contains the following boards:

* Management control blade (MCB) - Manages the library, passing
commands to and from the robotics control unit as well as the
storage area network (SAN) components.

* Robotics control unit (RCU) - Controls the picker and accessor
functionality.

* Library motor drive (LMD) (Gen 1 libraries only) - Distributes power
to the picker along with the X and Y-axis circuits. It also distributes
power to the touch screen.

* Library power control (LPC) (Gen 2 libraries only) - Distributes power
to the robot through the power rails. It also distributes power to the
touch screen.

18 Quantum Scalar i6000 User’s Guide
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Library Management Module

Figure 13 Library Management
Module Boards

Library motor drive (LMD) or
library power control (LPC)

Robotics control unit (RCU)

Management control blade (MCB)
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Library Management Module

Figure 14 Library Management
Module Boards in Series 3 CM
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I/O Management Unit

I/0 Management Unit

The I/0 management unit is an optional component that provides
connectivity and data path management to a SAN fabric and the hosts.
The I/0 management unit houses up to four FC I/O blades, which
provide FC connections for the Fibre Channel drives in the module.

The I/0 management unit also houses up to two Ethernet Expansion
blades, which handle internal Ethernet communication between the
MCB and HP LTO-5 or later drives. (The control module and each of the
expansion modules can contain up to 12 FC drives.) The I/O
management unit performs all tape drive and library host
communication functions in a library that is attached to a SAN.

I/O management units may be installed in the control module and
expansion modules. The I/O management unit supports the following
blades:

¢ Control Management Blade

* Fibre Channel I/0 Blades

e Ethernet Expansion Blades

When FC I/O blades or Ethernet Expansion blades are installed in the
library, the following rules regarding control management blades
(CMBs) apply:

* Any module (including the control module) that contains FC I/O
blades or Ethernet Expansion blades must also contain a CMB.

¢ A CMB must be installed in the control module and all modules that
contain drives. Modules that don’t contain drives, blades or network
chassis will contain drive and network jumpers that maintain
communications between the MCB located in the control module
and the modules that contain drives, FC I/O blades and EEBs.

Control Management The control management blade (CMB) performs unit status monitoring

Blade including power and I/O present conditions, and internal network
switch functions connecting I/O blades with the library management
module.
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Fibre Channel I/0
Blades

Ethernet Expansion
Blades
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There is one Fibre Channel (FC) I/O blade type supported: 7404 that
auto-negotiates up to 4 Gbps. The 7404 FC I/O blade has an embedded
controller that provides connectivity and features that enhance the
performance and reliability of tape operations. It also provides two host
communication ports and four connection ports to drives.)

* Fibre Channel LTO-1, LTO-2, LTO-3, LTO-4, LTO-5, LTO-6 and
LTO-7 drives can be connected to drive-aggregating Fibre
Channel I/O blades or directly attached to a host, so these drives
do not require an external SNC.

* We recommend that you do not connect an LTO-5 or later drive
to an FC 1/O blade. These drives support speeds of 8 Gbps, but
the FC I/O blade only supports 4 Gbps.

The Ethernet Expansion Blade (EEB) provides the option for Ethernet
connectivity to each LTO-5 or later drive (for MCB-to-drive
communication purposes only). The connection is at T100. The EEB
provides a control path to the drive for commands as well as facilitates
taking drive logs and downloading drive firmware. Each EEB has 6
Ethernet ports to allow attachment to 6 LTO-5 or later drives. The EEB
provides Ethernet connectivity to the library's internal Ethernet only and
should not be connected to an external Ethernet source.
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Figure 16 I/O Management
Unit in Series 3 Module
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Robot

Robot

The robot moves cartridges between storage cells, tape drives, and the
I/E station. A picker is used to get or put cartridges in a storage cell or a
tape drive slot. The picker moves along an X and Y axis and can pivot

180°. A barcode scanner on the picker assembly identifies cartridges
located in storage cells.

The library can be configured for either one or two robots. See Dual
Robotics Configurations and Parking Modules on page 7 for more
information.

Import/Export Stations

I/E stations enable you to import and export cartridges without
interrupting normal library operation. There are two types of I/E
stations: 24-slot I/E stations and 72-slot I/E stations.

Each 24-slot I/E station has a capacity of 24 LTO cartridges that are
located in four removable magazines. The 72-slot I/E station consists of
two side-by-side 36-slot I/E stations that can operate independently or
as a single 72-slot I/E station. Each 36-slot I/E station provides I/E
capacity of 36 LTO cartridges in six removable magazines.

The I/E station is installed on the front of the control module or any of
the first seven expansion modules, including high-density expansion
modules. It can be installed in a right parking module if the right
parking module is in position 2 through 8. Expansion modules (and the
right parking module) in positions nine through seventeen are storage-
only modules and do not contain I/E stations or drives. See Figure 3 on
page 5, Figure 9 on page 14, and Figure 11 on page 16 for I/E station
location.

Note: The I/E station cannot be configured as a storage location, but
it can be part of a logical division of library resources known as
partitions. For information about partitions, see Working With
Partitions on page 126.
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I/E Station Options

Extended I/E Option
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Note: The maximum number of I/E element addresses in any partition
is 240. This includes both physical slots and Extended I/E virtual
slots.

An expansion module is designed for customers who have an increased
need to import or export cartridges. An expansion module, including
high-density expansion modules, can have no I/E station, a 24 slot I/E
station, or a 72 slot I/E station. The increased capacity is achieved by
increasing the overall length of the I/E station and doubling its width.

The 24-slot I/E station has a capacity of 24 LTO cartridges that are
located in four removable magazines.

The 72- slot I/E station consists of two side-by-side 36-slot I/E stations
that can be operate as one 72-slot I/E station or can be operated
independently. Each 36-slot I/E station provides I/E capacity of 36 LTO
cartridges in six removable magazines.

The number of I/E slots in a library is usually associated with the number
of I/E slots in an actual physical I/E station, but this physical slot count
could limit how many I/E slots may be available to a host application.

Extended I/E configurations remove such I/E slot count limitations by
increasing the I/E slot count for a partition with storage slots that will be
reported to a host as I/E slots. Thus, extended I/E allows the user to
configure their partitions with I/E slots beyond the number of physical
I/E slots configured in the library. As a result, the host can export more
media than previously allowed.

Keep in mind that as extended I/E slots are used, fewer storage slots are
available. You will need to initiate move/import operations of tape
cartridges into the extended I/E area for host access. Conversely, to
move/export tape cartridges from extended I/E area slots to the emptied
physical I/E Station slots, you need to initiate the move/export operation
from the user interface for physical access to the library.
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Note: By default, the extended I/E feature is disabled and is only
available on Scalar i6000 libraries. Extended I/E can be enabled/
disabled from the 'Physical Library' dialog (Setup > System
Settings > Physical Library). Refer to Setting Up Policies for
the Physical Library on page 178.

Quantum Scalar i6000 User’s Guide

Note: To configure a partition with extended I/E segments, you must
use the Partition Wizard (Setup > Partition > Configure). The
extended I/E feature is only available in expert creation mode or
if you are modifying an existing partition. Refer to Using Expert
Mode on page 139. Extended IE is not supported on library
managed partitions.

Extended I/E must be enabled before using it. When configuring
extended I/E in a partition, ensure you have enough licensed slots
[Capacity On Demand (COD)] to accommodate the new extended I/E
slots, since extended I/E slots use the COD licensed slot count.

When you configure extended I/E slots you must have at least one
physical I/E segment configured in the partition. The maximum number
of physical and extended I/E slots per partition is 240.

The I/E area configured with the extended I/E feature will report the SCSI
element addresses starting with the actual physical I/E slots, followed by
the extended I/E slots. This will allow hosts to always first use the
available slots in the actual physical I/E Station before “spilling” into the
extended I/E area.
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Cartridges

Cartridges are stored in magazines within the library, as shown in
Figure 17.

Figure 17 Example of LTO
Cartridge Insertion into a
Magazine

magazine barcode

LTO magazine

cartridge barcode location
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Each cartridge has an operator-attached, machine-readable barcode
label on it for identification purposes. The library can dynamically
support barcode labels with 1 to 14 characters plus a one-character or
two-character media identifier, depending on drive type. The library
currently supports Code 39 (3 of 9) type barcode labels. For more
information about tape cartridges, see Tape Drives and Media on
page 33. For additional specification information, see Barcode Label
Requirements on page 687. For details about the use of drives and
cartridges, see Mixed Media Support and Rules on page 35.

Note: Media must contain valid barcode labels. The library will not
support tapes without valid barcode labels.

Note: A 14-character barcode label length may not be printable
according to the Code 39 label specifications for the tape
cartridge area to which the label is attached. The effective tape
cartridge barcode label length, including any media ID, may be
limited to a maximum of 12 characters.

Cartridge Magazines

The cartridge magazine is a storage assembly that installs on the drive
side or door side of the control module or expansion module, as shown
in Figure 18. It contains the cartridge slots and provides flexibility when
adding storage cartridges to a module.
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Figure 18 Magazine and Drive
Locations in the Control

Module
I/E
station
upper
drive
cluster

drives or
storage
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drive
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drive side door side
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Figure 19 Magazine and Drive
Location in the Single-Robotics
Series 3 Control Module
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Table 1 Cartridge Capacities in
Library Modules

Type Magazine Capacity Cartridge Capacity
Magazine (LTO) -- 6

Control module (single-robotics)? 36 min/51 max 216 min/306 max
Control module (dual-robotics)? 42 min/64 max 252 min/384 max
Standard Expansion module® 48 min/76 max 288 min/456 max
Drive Ready Expansion Module? 16 min/76 max 96 min/456 max
High-Density Expansion Module® 102 min/130 max 612 min/780 max

Left parking module (dual-robotics)® 38 228

Right parking module (dual-robotics)® 12 min/38 max 72 min/228 max

a. Control module: The minimum is based on having 18 drives and one 24-slot I/E station installed. The maximum

b.

is based on having one drive and one 24-slot I/E station installed.
Drive Ready Expansion module: The minimum is based on having 24 drives and one 72-slot I/E station and 24
drives installed. The maximum is based on having no drives or an I/E station installed.

. Standard and HDEM: The minimum is based on one 72-slot I/E station and 12 drives installed. The maximum is

based on having no drives or an I/E station installed.

. Left parking module: No drives or I/E stations are allowed. The left parking space takes up 4 columns of storage.

There are six empty magazines located in the unusable 4 columns which are used for calibration only. These six
magazines are not counted toward the total capacity.

. Right parking module: The minimum is based on having 12 drives and one 24-slot I/E station installed. The

maximum is based on no drives or I/E station installed. The right parking space takes up 4 columns of storage.

32

Each magazine has a barcode label that the scanner reads for
identification and inventory. An optional, snap-on dust cover is available
for the magazines. Magazines with the dust cover have interlocked
stacking that enables easier storage of the media when they are
removed from the library for external storage.
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Tape Drives and Media

Note: Library firmware versions 630Q (i10) and later do not support
DLT tape drives, media, or magazines. If you upgrade to these
library firmware versions, make arrangements to remove and/
or replace all DLT tape drives, media, and magazines in your
library. If you want to continue to use DLT tape drives and
media, your library firmware must be at version 617Q.GS01001
(i8.4) or earlier.

Tape drives are enclosed in a universal drive sled. You can hot swap and
hot add all supported drives, regardless of type. The library supports the
following types of tape drives:

* [BM LTO-1 or LTO-2 LVD-SCSI

e |BM LTO-1, LTO-2, LTO-3, LTO-4, LTO-5, LTO-6 or LTO-7
FC Multi-mode

* HP LTO-3, LTO-4, LTO-5, LTO-6 FC Multi-mode

Caution: A single partition can have a mixture of drive types and
interface types within the same domain (for example,
LTO-5 and LTO-6 with SCSI or Fibre Channel interfaces). For
more information, see Mixed Media Support and Rules on
page 35 and Understanding Partition Media Policy Settings
on page 129.

The standard control module and expansion modules have upper and
lower drive clusters. Series 3 control modules have one upper and two
lower clusters and expansion modules have two upper and lower
clusters. Each library must have at least one tape drive. Each drive
cluster can house up to six tape drives. Additional drives can be added
to any expansion modules in the configuration, except high-density
expansion modules. This enables you to have a total of 192 drives. In
dual-robot systems, the left parking module cannot contain drives.

Note: When you add drives, you lose storage slots.

As of firmware version i11, drives can be installed in any module in the
library except a left parking module or high-density expansion module.
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LTO Drives

However, it is still recommended that drives be installed in bottom-to-
top order.

Note: The term drive cluster defines a grouping of up to six tape
drives below or above the middle X-axis rail.

Figure 18 on page 30 shows the locations of drives in the control
module. For details about the use of drives and cartridges, see Mixed
Media Support and Rules on page 35.

Fibre Channel LTO-1, LTO-2, LTO-3, LTO-4, LTO-5, LTO-6 and LTO-7 drives
can be connected to drive-aggregating Fibre Channel I/O blades or
directly attached to a host, so these drives do not require an external
SNC. More detailed information about LTO drives follows.

Six generations of LTO drives are supported, but they are not fully

Table 2 LTO Drive and
Cartridge Compatibility

compatible as shown in Table 2. (N/C = Not Compatible)

LTO-3 LTO-4 LTO-5 LTO-6 LTO-7
LTO-3 WORM LTO-4 WORM LTO-5 | \worm LTO-6 WORM LTO-7 WORM
LTO-3 Reads/ Write N/C N/C N/C N/C N/C N/C N/C N/C
Drives Writes Once,
Read
Many
LTO-4 Reads/ Write Reads/ Write N/C N/C N/C N/C N/C N/C
Drives Writes Once, Writes Once,
Read Read
Many Many
LTO-5 Read Read Reads/ Write Reads/ Write N/C N/C N/C N/C
Drives Many Writes Once, Writes Once,
Read Read
Many Many
LTO-6 Read Read Reads/ Write Reads/ Write Reads/ Write Reads/ Write
Drives Many Writes Once, Writes Once, Writes Once, Writes Once,
Read Read Read Read
Many Many Many Many
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LTO-3 LTO-4 LTO-5 LTO-6 LTO-7
LTO-3 worm | 794 | worm LTO-5 | \worm LTO-6 WORM LTO-7 WORM
LTO-7 Read Read Read Read Reads/ Write Reads/ Write Reads/ Write
Drives Many Many Writes Once, Writes Once, Writes Once,
Read Read Read
Many Many Many

All LTO cartridges are the same physical size, which means they use the
same magazines in the library.

LTO drives can be directly attached to hosts, the SAN, or to FC I/O blades
in the /0 management unit. SCSI drives must be directly attached to
hosts or to the SAN.

Mixed Media Support and Rules

The library supports LTO cartridges and drives in the same configuration,
provided that you adhere to the following rules:

Note: Libraries with Gen 2 hardware do not support DLT drives or

media.

Note: Libraries with firmware at version 630Q or later do not support

DLT drives or media.

Quantum Scalar i6000 User’s Guide

When purchasing a library with mixed media, the new orders must
specify the base system technology and the number of magazines,
the number of drives, and the number of I/E station magazines for
each media type required. The base system is considered the
primary media type used in the library.

Multiple generations of LTO media can be mixed at the magazine
level.

The supported multiple media are LTO-1, LTO-2, LTO-3, LTO-3
WORM, LTO-4, LTO-4 WORM, LTO-5, LTO-5 WORM, LTO-6, LTO-6
WORM, LTO-7 and LTO-7 WORM.

Drives can be installed in any frame.
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Support for WORM

The Scalar i6000 library supports WORM (write once, read many)
technology in LTO-3, LTO-4, LTO-5, LTO-6 and LTO-7 tape drives. WORM
requirements include:

Cartridges

Firmware

WORM-supported LTO-3 tape drives
WORM-supported LTO-4 tape drives
WORM-supported LTO-5 tape drives
WORM-supported LTO-6 tape drives
WORM-supported LTO-7 tape drives

WORM allows non-erasable data to be written once and provides extra
data security by prohibiting accidental data erasure. When the library
firmware and WORM-supported LTO-3, LTO-4, LTO-5, or LTO-6 tape
drive code are installed on a library with LTO-3, LTO-4, LTO-5, LTO-6 or
LTO-7 tape drives, the WORM feature is supported whenever the
operator uses WORM cartridges.

36
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Operator Panel

The operator panel is located on the front of the control module and
consists of indicators and a touch screen (see Figure 20). The buttons
are for library control and power, and the indicators provide library
status.

Figure 20 Operator Panel

Status indicator
Power indicator

Robotics Enabled

indicator ___———

/

Robotics Enabled
button

\ Power button

touch screen

The touch screen is the library navigation point and provides access to
the LMC. For more information about the touch screen and the LMC,
see Library Management Console (LMC) on page 440.
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Power System

The library supports single and redundant power configurations. The
single configuration has a single AC line input and single DC power
supply. The redundant configuration has dual AC line input and dual DC
power supplies. You can hot swap a power supply if you have a
redundant power supply. You can hot add a second power supply.

The power system consists of the following:
* Power supply
* Power distribution unit
* AC power cord

A single power switch, located on the front door of the control module,
turns on and off all power for the control module and attached
expansion modules. Each power distribution unit has a second circuit
breaker, located in the rear of the module, that controls the module
power supply output. The power supply has three LEDs that provide
status information. The power system also has four fuses for system
protection.

The control module and all expansion modules or right parking modules
that contain drives must contain a power system. If an expansion
module or right parking module contains only cartridges, its power is
derived from the control module and a power system is not needed.

High-density expansion modules have their own AC power systems that
can supply power to up to six (6) additional HDEMs if redundant power
is installed. The additional HDEMs must be in consecutive positions to
receive power from a single HDEM. Each power distribution unit has a
circuit breaker located at the rear of the module.
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Library Features

This section describes several library features.

Density The library provides a storage density of 720 cartridges (LTO) per square
meter. Each module, also referred to as a frame, has two storage racks:
one on the drive side and another on the door side. A rack consists of up
to 10 horizontal sections and three or four columns of magazines,
depending on the rack configuration. Each magazine, located at the
intersection of a particular section and a particular column, consists of
five or six cartridge slots, depending on the type of media.

Centralized The Library Management Console (LMC) gives you a single point from
Management which to view all library components, including robotics, drives, storage,
I/E stations, and network connectivity. You can use this graphical user
interface both locally from the library’s touch screen and remotely from
a remote client. The LMC communicates with the LMC server that runs
on the library. The LMC uses a simple and intuitive graphical style that is
secure and provides library managers with native partitioning ability.

Proactive Availability The library can alert you about problems before they occur. The library
checks the complete data path at user-defined intervals to make sure
that it is functioning properly before backups begin. The library also
monitors its six major subsystems (drives, power, robotics, cooling,
connectivity, and control). You can configure the library to send
notifications of problems to one or more e-mail accounts, including
Quantum service personnel. For more information about the library’s
monitoring and reporting capabilities, see Maintaining Your Library on

page 513.
Serviceability and The library has extensive serviceability and reliability features. You can
Reliability hot swap drives, power supplies (in redundant power configurations

only), Input/Output (I/O) blades, and fans. Host port failover, an
advanced feature that moves a host’s communication stream from a
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Data Path Conditioning

Host Attachment

40

failed connection to a working connection without disrupting the
backup operation, maintains connectivity whether the failure occurs on
the host, the switch, or the library.

Your backup system and data path are idle most of the time. When
backups begin, the system is used intensively at maximum bandwidth.
The library provides you with notifications and a robust ticket system
that notifies you of any problems it identifies, enabling you to solve
them before backups begin. For more information about the library’s
notification system, ticket system, and other troubleshooting help, see
Troubleshooting Your Library on page 43.

Quantum provides an automatic means of verifying, monitoring, and
protecting data path integrity between hosts and library drives. This
feature is referred to as data path conditioning. Using this feature,
administrators can proactively detect and resolve data path problems
before they affect backups, restore operations, and other data transfer
operations. Data path conditioning makes sure that data transmissions
are optimized and reliable, resulting in improved system availability.

Data path conditioning occurs in two separately managed areas:
e Between host and Fibre Channel (FC) I/O blades
* Between FC I/O blades and library drives

The FC I/O blade manages data path conditioning along the path
between itself and the library drives. Data path monitoring
automatically occurs at regular, configurable intervals. The FC I/O blade
generates a RAS ticket if monitoring tests fail for two intervals. This
indicates either loss of connectivity or drive failure. The FC I/O blades
include the data path conditioning feature. Administrators can use the
LMC to configure data path conditioning.

Requests issued from the host application result in cartridge movement
in the library. The primary requests issued are for mounting and
dismounting cartridges in and out of the tape drives and for importing
and exporting cartridges in and out of the library. The library manages
the physical location. In addition to requesting cartridge movement in
the library, the host application can use the FC command interface to
obtain status information, configuration information, and cartridge
storage information from the library.
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Hosts can be attached to the library in the following ways:

* FCdrives can be directly attached to host systems or to the SAN. In
these configurations, the management control blade (MCB) has one
library control port (FC) connecting to the controlling host
computer.

* FCdrives can be attached to FC I/O blades in the /O management
unit. There are two ports on each FC I/O blade that can be
connected directly to the host or to the SAN.

The library can be managed locally or remotely using the LMC. Locally,
the LMC appears on the touch screen on the front of the library.
Remotely, the LMC is accessed through a client instance of the LMC
software on any computer on the network. For more information about
accessing Logging On From a Web Browser (Remote Client) on

page 434. For more information about the LMC, see Library
Management Console (LMC) on page 440.

The LMC provides additional monitoring of a SAN-attached library over
the network to a management server by using Simple Network
Management Protocol (SNMP). This includes library subsystem health
and status information and early fault notification. For more
information, see the Intelligent Libraries Basic SNMP Reference Guide.

The library also supports the Common Information Model (CIM) server
based on the Storage Management Initiative Specification (SMI-S) on
the MCB. A CIM client can use the CIM server to monitor the SAN-
attached library. For more information, see the Intelligent Libraries SMI-
S Reference Guide.

If you purchased capacity on demand, the library is initially licensed for
a default configuration of 102 LTO storage slots.

Capacity on Demand allows you to license physical slots in 100-slot
blocks. Any number of slots can be licensed between 100 and 12,000.
You do not need to license all the physical slots, but only licensed slots
can be assigned to host managed partitions. It is often desirable to have
more physical slots installed than will be licensed.

Capacity on Demand allows you to purchase capacity for your library as
needed. As your storage needs change, you can add storage in blocks of
100. Scalar i6000 licensing begins at 100 cartridges and can be
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increased to as many as 7,146 LTO cartridges (for a single-robot library)
or 7,224 LTO cartridges (for a dual-robot library).

Expansion modules are sold separately from the slot licensing. This
separation provides the flexibility to order the exact modules needed
(DREM, SEM or HDEM).
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Library

This chapter describes how the library informs you of issues that it
detects within its subsystems. It also provides information about
working with tickets to resolve issues, running verifications tests to
check whether they have been resolved, interpreting LEDs, viewing
command history logs, and accessing Online Help.

This chapter consists of the following sections:

* How Does the Library Report Issues? on page 43

* Working With Tickets on page 48

* Viewing Ticket Details on page 57

* Interpreting LEDs on page 91

* Working With Command History Logs on page 114

* Accessing Online Help on page 120

How Does the Library Report Issues?

The library has advanced problem detection, reporting, and notification
functionality. The library has many processors and sensors that monitor
conditions and operations, such as temperatures, voltages, current,
calibrations, firmware versions, and so forth.
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The library reports issues in several ways, which are described below:
» Status Indicator on page 44

* System Status Button Indicators on page 46

* E-mail Notifications on page 47

Status Indicator The first indication of issues is the status indicator on the indicator
panel, as shown in Figure 21.

Figure 21 Status Indicator .

.

STATUS

Status indicator

'v
* If the Status indicator light is solid green, the library currently has
no tickets in an Open state.

* If the Status indicator light is flashing amber, at least one of the six
subsystems has a ticket in an Open state.

When the library detects an issue, it creates a ticket for it. A ticket
includes the following types of information:

* Details about the issue
* Reports that are associated with the ticket
* A repair page that provides corrective actions

In most cases, tickets indicate operational failures that do not always
point to a single CRU/FRU as having failed or causing an issue. IN such
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cases, customer repair instructions are provided to isolate the issue and
recover from the failure. Only if the library is able to clearly identify a
failing CRU/FRU wiill the repair instruction request service or specific
CRU/FRU replacement.

Note: Tickets can indicate failures or other serious problems, but they
also can indicate warning conditions that you should
investigate. For example, opening the library’s access door or
intentionally disconnecting drive fibre channel connections,
causes the library to create a ticket, but if such operation is
performed intentionally this condition would not indicate
serious problems. However, you should still investigate the
tickets to make sure no issue has been caused inadvertently by
an aisle access operation or SAN configuration.

The library assigns a severity level to each ticket that it creates, and it
notifies users of the ticket. Table 3 describes possible severity levels for

tickets.
Table 3 Severity Levels
Assigned to Tickets
Severity Level Description
1 (Failed) Indicates that a failure or serious condition has occurred within a library

subsystem that requires immediate corrective action. In some cases, a hardware
component is no longer functioning at an acceptable level or has failed. In other
cases an operation may not have completed without a component having actually
failed.

Examples of failure situations include a FRU that is not functioning, a temperature
threshold that may affect operations, or an Ethernet or FC connectivity issue that
requires resolutions to network or SAN fabric connectivity issues before operations
function normally again.

2 (Degraded) Indicates that a degraded condition exists within a library subsystem that impacts
system performance or redundancy. Typical library operations can continue
without immediate corrective action, but an administrator should investigate the
condition and correct the problem soon.

Examples of degraded situations include a redundant power supply that has failed
or a connectivity problem that has caused failover to occur.
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Severity Level Description

3 (Warning) Indicates that a condition exists within a library subsystem that has some or little
effect on system operations. Typical library operations can continue without
immediate corrective action, but you should investigate the condition and correct
the problem when possible.

Examples of warning situations include a FRU that is functioning less reliably, or
drives that cannot unload a tape while other drives are still available to service
other requests, or a temperature threshold that has been reached that does not
affect reliable operations.

The library has three ways of notifying users that it has discovered
issues and has created tickets for them:

* Status indicators on Library Management Console (LMC) system
status buttons

¢ E-mail notifications

¢ SNMP TRAP notifications

System Status Button System status buttons are located in the Overall System Status area at
Indicators the bottom of the LMC display. Each button displays a status indicator
for the library subsystem it represents. For more information about the
buttons, see System Status Buttons on page 455. When the library
creates a ticket, the status indicator button for the affected subsystem
automatically changes from the following icon:

\—21 Good (green)

to one of the following icons:

Warning or Degraded
o (yellow)

Failed (flashing red)
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The meanings of these status indicators correspond to the severity levels
described in Table 3 on page 45. If a system status button indicates
anything other than a Good state, clicking it displays a list of open
tickets for the subsystem. To access tickets by using the system status
buttons, see Working With Tickets on page 48.

The library collects status information on its components and, if the
appropriate e-mail notifications have been set up in the LMC, the library
can send notifications whenever tickets with severity levels 1, 2, or 3 are
created. For information about severity levels, see Table 3 on page 45.
The library assigns a severity level to each ticket it creates. If the ticket's
severity level matches one of an e-mail address’ severity codes (as set up
in e-mail notifications), the library sends a notification to that particular
e-mail address. The library also sends a notification if a ticket's severity
level escalates to a more severe level. The library does not send one
when an ticket’s severity level becomes less severe.

By default, the only e-mail address to which the library sends e-mail
notifications is techsup@quantum.com (Quantum technical support).
When configured for Quantum technical support notification, the
library notifies Quantum technical support only of those severity 1 issues
that suggest a component failure requiring a possible CRU/FRU
replacement. Severity 1 tickets that do not identify a library component
failure, such as customer network connection issues and SAN fabric
connection problems, do not automatically notify Quantum technical
support, but allow customer issue analysis and customer-initiated
support calls. To set up other e-mail addresses to receive any severity 1,
and/or severity 2 and severity 3 ticket notification, see Configuring E-
mail on page 185 and Setting Up E-mail Notifications on page 188.

Note: Even though you can remove the Quantum technical support
e-mail address so that Quantum does not receive severity level
1 notifications, Quantum recommends that you do not remove
it. Also, do not include the Quantum technical support e-mail
address for severity level 2 or 3 notifications.

The subject line of the e-mail notification indicates “Scalar i6000,” the
library’s serial number, and the severity level of the ticket. The body of
the message states that the library sent the message automatically. The
message body also includes the following information, which provides
details about the ticket and library conditions at the time of the event:
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* Ticket summary

* Ticket details, including status information

* Firmware versions, including MCB, RCU, CMB, and drive bricks
* Physical library configuration

* Library states, such as physical library online or offline, partitions
online or offline, or robotics varied on or varied off

* Time stamps of recent activity
* Report summary
* Report details for the ticket

The notification also includes a repair page attachment. This page
provides a problem description and corrective actions you or a customer
service engineer (CSE) can perform. For more information about repair
pages, see Viewing Ticket Repair Pages on page 66.

Note: A notification e-mail contains helpful information about a
ticket and how to resolve it. However, the notification
represents a condition that existed at a certain time in the past.
The notification might not reflect the current situation. The
notification indicates a specific ticket ID, so you should find
and examine that specific ticket in the LMC. The ticket reflects
the real-time status of the issue. For more information about
accessing tickets, see Working With Tickets on page 48.

SNMP TRAP Notification  The library can be configured for SNMP TRAP receiver addresses which
to send RAS subsystem change event notification and other library event
as discussed in the Basic SNMP Reference Guide for the Scalar i2000/
16000 Library.

Working With Tickets

Tickets are your primary troubleshooting tool when you experience
problems with the library. A ticket provides details and reports about
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the issue and library conditions at the time of the event. It also provides
guidance on how to resolve the issue. If you are an administrator or a
service representative, you can access the tickets through the LMC. This
section explains how to display ticket lists, view ticket and report details,
view repair pages, and resolve and close tickets.

To help you quickly troubleshoot an issue by using tickets, read the
following guidelines.

What is the issue and its cause?

You became aware of a library issue because either the library sent an
e-mail notification, an LMC system status button indicated a subsystem
status of Warning, Degraded, or Failed, or a backup/archive software
application indicated a problem. Tickets include details about the issue
and library conditions at the time of the event. They also include
reports, any history tickets that the library has created in the past for the
same FRU, and a repair page that provides a detailed description of the
issue and its possible causes. The repair page also provides corrective
actions that you or a CSE can perform. To use a ticket to determine an
issue and its cause, you can perform the following general steps:

1 Display a list of tickets (see Displaying Ticket Lists on page 52).

2 View the details for the appropriate ticket (see Viewing Ticket
Details on page 57).

3 View the reports that are associated with this ticket (see Viewing
Ticket Details Reports on page 62.

4 View the ticket's repair page (see Viewing Ticket Repair Pages on
page 66).

Where did the issue occur in the library?

The Status Group field on the Details tab of the Ticket Details dialog
box indicates the library subsystem that caused the ticket. For more
information about the Details tab, see Viewing Ticket Details on

page 57 The FRU ID field on the Report tab of the Ticket Details dialog
box indicates the type of FRU that is affected, and the FRU Instance
field indicates the specific FRU by its location in the library. For more
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information about the Report tab, see Viewing Ticket Details Reports on
page 62.

When did the issue first occur?

The Posted field on the Details tab of the Ticket Details dialog box
indicates the date and time on which the library first reported the issue
and created a ticket for it. For more information about the Details tab,
see Viewing Ticket Details on page 57.

Has the issue occurred repeatedly?

The Duplicates field on the Details tab of the Ticket Details dialog box
indicates how many times the library has reported the same issue while
the ticket has been open. In addition, you can determine whether the
same issue has occurred and been resolved in the past. The FRU History
List area on the Details tab lists tickets that have been opened for the
same FRU in the past, but have been resolved and are now in the Closed
or Verified state. By selecting a history ticket and then clicking Show,
you can investigate the ticket history of a particular FRU. For more
information about the Details tab and viewing history tickets, see
Viewing Ticket Details on page 57.

Does the issue involve drives or tapes?

You can determine if the issue involves a particular drive or tape by
viewing tape alerts and generating tape alert reports.

Tape alerts are issued by a drive whenever there is a problem in the drive
that relates to a tape cartridge. The problem can be with the drive or
with the tape cartridge. You can view tape alerts on the Media Integrity
Analysis tab of the Ticket Details dialog box for tickets in the drive
group. For more information on the Media Integrity Analysis tab, see
Viewing Tape Alerts and Generating Media Integrity Analysis Reports on
page 67.

Tape alert reports enable you to cross-reference tape alerts for drives
and tape cartridges over a specified period of time, in order to
determine if the problem belongs to the drive or to a specific tape
cartridge. You generate tape alert reports using the Report Criteria
dialog box. You need an Advanced Reporting license in order to use
view tape alerts reports. For more information on using the Report
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Criteria dialog box, see Viewing Tape Alerts and Generating Media
Integrity Analysis Reports on page 67.

Has the FRU been replaced before?

You can determine whether a specific FRU has been replaced in the past
by examining the FRU SN field on the Details tab of the Ticket Details
dialog box for the open ticket and the history tickets. Because the
history tickets associated with an open ticket are for the same specific
instance of a FRU, and because a FRU instance is identified by its
location in the library, the FRU serial number, which is uniquely assigned
to each FRU, will change if the unit has been replaced in the past. For
more information about the Details tab and viewing history tickets, see
Viewing Ticket Details on page 57.

How do | resolve the issue?

The repair page provides comprehensive, step-by-step procedures for
resolving the issue. Both user and CSE procedures are provided. When
the procedures require a CSE to perform them, contact technical
support. For more information, see Viewing Ticket Repair Pages on
page 66.

How can | know whether the issue is resolved?

Some issues require you to determine whether they are resolved and
others the library will detect automatically.

* In some cases, the library can automatically detect that an issue is
resolved (for example, an open door that is now shut). For these,
the library automatically transitions the ticket to the Verified state.

* In other cases, the library cannot automatically detect that an issue
is resolved (for example, a faulty tape cartridge). You must
determine whether the issue is resolved by running a verification
test or, if an applicable test does not exist, by following the repair
page instructions. If you run a test and the results are all good, the
library automatically transitions the ticket to the Verified state. If
you cannot run a test, you should physically examine the FRU, and
then manually transition the ticket to the Closed state after
determining that the issue is resolved. After you close the ticket, the
library transitions it to the Verified state if it is able to do so. For
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more information, see Running Verification Tests to Determine Issue
Resolution on page 81 and Closing Tickets on page 82.

The library reopens tickets that receive failed, degraded, or warning
reports within 30 minutes of transitioning to the Closed or Verified
state. If a Closed or Verified ticket remains free of failed, degraded, or
warning reports for 30 minutes, the library locks them from
transitioning back to the Open state. A failed, degraded, or warning
report that is received beyond 30 minutes causes the library to open a
new ticket.

What do | do if | cannot resolve the issue?

Contact Quantum technical support. See Getting More Information or
Help on page xiii. Technical support personnel might ask you to send
them an electronic copy of the ticket. For instructions, see Mailing,
Saving, and Printing Ticket Information on page 79.

How do | view the number of tickets that occurred in a
certain time range?

The Tickets Report lets you see how many tickets occurred in a particular
time period. You can choose to group tickets by subsystem, module, or
FRU, and the results can be presented as a rollup summary or as a trend
so you can see if the number of issues is increasing or decreasing over
time. Also, the report results can be presented in different chart
formats, such as bar graphs or pie charts. For more information, see
Generating the Tickets Report on page 83.

The LMC provides three ways to display ticket lists:

* By clicking a system status button that indicates a Warning,
Degraded, or Failed state

This option displays a list of open tickets for the associated
subsystem. See Using System Status Buttons to Display Ticket Lists
on page 53.

* By clicking Tools > Tickets

This option displays the Tickets dialog box from which you can
obtain a list of all tickets or a partial list of tickets according to
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selection criteria. See Using the Tickets Command or the Tickets

Button to Display Ticket Lists on page 55.

* By clicking the Tickets button on the toolbar

This option displays the same Tickets dialog box as the Tools >
Tickets command does. See Using the Tickets Command or the

Tickets Button to Display Ticket Lists on page 55.

From the ticket list, you can select a ticket to view ticket details,
associated reports, and a repair page.

Using System Status Buttons to Display Ticket Lists

To display a list of tickets by using a system status button, the button
must indicate a Warning, Degraded, or Failed state. Clicking a system
status button that indicates a Good state either displays a list of

subsystem tickets that are in Closed or Verified states or informs you
that no tickets exist for the subsystem.

1 Click the system status button that corresponds with the subsystem
for which you want to display a list of open tickets. The Ticket List
dialog box appears with a list of open tickets for the subsystem.

B Ticket List — ﬁ
rSelect Ticket
[C1| Select All
| D | Description State | Severity | Serial # Sub-system

Library System

Rkl firmware(Chassis  |Closed |1-Failed |MNone Control
Management
RCU to robot

[ Ethernet interface Verified |1-Failed |Mone Robotics
(Left Robot)
Chassis

gk Management Closed |1-Failed |AMQO01019-0074 Control
Blade(CMB) circuit
Drive sled at

|4 [1,1,1,411(RCU Verified |3-Warning None Drives
sled CAN interface)
Drive sled at

dls [1.1,11,11(RCU Closed |3-Warning None Drives
sled CAN interface)

[ »

L JL JL Close ]L Help ]
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The following table describes the elements on the Ticket List dialog
box.

Element

Description

In the Select Ticket area:

Check Box

To close multiple tickets, select each ticket you want to close by clicking the
check box.

ID

The library-assigned identifier for the ticket.

Description

A summary description of the ticket. The description identifies the FRU that
caused the ticket and includes reason text that describes the cause of the ticket.

State

The current state of the ticket. Possible states are:

Open — indicates that an issue, whether problem or warning condition, has
occurred in the library that requires attention

Closed — indicates that a user has closed the issue

Verified — indicates that the library has successful operational results or
positive data that verifies that the problem is resolved

Severity

The severity level of the ticket. Possible levels are:
* 1 (Failed)

* 2 (Degraded)

* 3 (Warning)

* 5(Good)

Serial #

The serial number that the manufacturer assigns to the particular FRU.

Sub-system

The subsystem that caused the ticket. Possible subsystems are:
e Connectivity

* Drives

* Control

* Power

* Cooling

* Robotics

Posted Date

The date and time on which the library created the ticket.
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The Details button displays the Ticket Details dialog box. For more
information, see Viewing Ticket Details on page 57.
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2 By default, the ticket list is sorted by ticket ID in ascending order
with the oldest ticket at the top and the newest one at the bottom.
To change the sorting (for example, by state or severity), click the
column heading by which you want the tickets sorted. Repeatedly
clicking a column heading toggles between ascending and
descending order.

Using the Tickets Command or the Tickets Button to Display
Ticket Lists

1 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

2 Click Tools > Tickets or click the Tickets button on the toolbar. The
Tickets dialog box appears.

B Tickets - S
r Select Sub-system:
[C] Drives [C] Connectivity [] Control
v Al
] Robotics [ Power [C] Cooling
r Select State:
[w] A [C] opened [ Closed [C] verified
|| [ Select Severity:
v Al 1 T2 13
( ok J[ cose J[ Hew |

The Tickets dialog box enables you to specify the kinds of tickets
that will appear in the ticket list. For example, you can do the
following:

* To display all tickets in the library, select All for state, severity,
and subsystem.

* To display all open tickets with a severity level 2 status for the
drives and control subsystems, select Opened for state, 2 for
severity, and Drives and Control for subsystem.

* To display all tickets that users have manually closed for the
robotics subsystem, select Closed for state, All for severity, and
Robotics for subsystem.
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* To display all tickets that the library has automatically
determined as having been resolved, select Verified for state,
All for severity, and All for subsystem.

If you select a combination that does not produce a ticket list, a
No Tickets Found error message appears.

By default, this dialog box is set to Opened for state, All for
severity level, and All for subsystem.

Note: Tickets that the library has automatically verified and
closed are in the Verified state. Tickets that users have
manually closed are in the Closed state.

3 Select the appropriate check boxes in the Select State, Select
Severity, and Select Sub-system areas, and then click OK. The
Ticket List dialog box appears.

Management
RCU to robot

[ Ethernet interface
(Left Robot)
Chassis

gk Management Closed
Blade(CMB) circuit
Drive sled at

|4 [1,1,1,411(RCU
sled CAN interface)
Drive sled at

dls [1.1,11,11(RCU Closed
sled CAN interface)

Verified

Verified

sy

sy

[

[

-Failed |Mone

[ Ticket List — |22
rSelect Ticket
[C1| Select All
| D | Description State Severity | Serial # Sub-system
Library System
O firmware(Chassis |Closed |1-Failed |MNone Control

Robotics

-Failed |AMQO001019-0074|Control

-Warning ([Mone Drives

-Warning ([Mone Drives

( J (

JL Close ]L Help ]

For descriptions of elements on the Ticket List dialog box, see Using
System Status Buttons to Display Ticket Lists on page 53.

4 By default, the ticket list is sorted by ticket ID in ascending order
with the oldest ticket at the top and the newest one at the bottom.
To change the sorting (for example, by state or severity), click the

Quantum Scalar i6000 User’s Guide



Viewing Ticket Details

Quantum Scalar i6000 User’s Guide

Chapter 2: Troubleshooting Your Library
Working With Tickets

column heading by which you want the tickets sorted. Repeatedly
clicking a column heading toggles between ascending and
descending order.

Tickets provide detailed information about the ticket itself, the reports
that are associated with it, and a repair page that gives guidance for
resolving the issue. These tickets provide important information about
library conditions from which the issue emerged and helpful
information for resolving it.

To display the detailed information for a particular ticket, perform the
following steps:

1 On the Ticket List dialog box in the Select Ticket area, click the

appropriate ticket row to highlight it.

2 Click Details. The Ticket Details dialog box appears with the Details

tab displayed.

B Ticket Details

ol 2 | 1T > =)

Details | Report rRepair rMedia Integrity Analysis |

r Ticket #5
State: Closed FPosted: Wed Feb 13 23:47:43 GMT 2013
Status Group: Drives Closed: Sun Mar 03 21:32:15 GMT 2013
Severity: 3 Duplicates: 0
FRU SM: Mone Repair Link: 14_05_htm
FRU Status:  Warning Error Code: 14_05_18_00_80806267

FRU Logical SM:  MiA

Drive sled at[1,1,1,1,1,1}{RCU sled CAN interface) communication has failed
27. RCU sled CAN interface at[1,1,1,1,1,1] communication has failed
While initializing a drive, drive management has determined thatthe SLED CAN interface commu

| »

[ [»]

r FRU History Ticket List

ID| Description | State | Severity |

( J( FRuTest || Send J

[ Close ] L Online Support ] L Help ]

= = —— = ==
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The Ticket # area of the Ticket Details dialog box displays detailed
information about the ticket. The FRU History Ticket List area lists
all tickets that were ever opened in the past and that see the same
specific FRU (based on the FRU's location in the library) as the one
reported by this ticket.

Table 4 on page 58 describes the elements on the Details tab.

Table 4 Details tab

Element

Description

In the Ticket # area:

State

The current state of the ticket. Possible states are:

Open — indicates that an issue, whether problem or warning condition, has
occurred in the library that requires attention

Closed — indicates that a user has closed the issue

Verified — indicates that the library has successful operational results or
positive data that verifies that the problem is resolved

Posted

The date and time on which the library created the ticket.

Status Group

The subsystem that caused the ticket. Possible subsystems are:
* Connectivity

* Drives

* Control

* Power

* Media

* Robotics

Closed

If the ticket is closed, the date and time on which it was closed.

Severity

The severity level that is associated with the status group (subsystem).
Possible levels are:

* 1 (Failed)

* 2 (Degraded)
* 3 (Warning)
* 5(Good)
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Element Description

Duplicates The number of times that the library has reopened the ticket. If a ticket is in
the Closed or Verified state and the identical problem occurs again within 30
minutes, the library reopens the ticket and increments the ticket’s duplicate
count. If the library has not reopened the ticket, the value is zero (0).
Tickets that are in the Closed or Verified state for more than 30 minutes
cannot be reopened. In this case, if the identical problem occurs again, the
library creates a new ticket.

FRU SN The serial number of the particular FRU.

Repair Link The name of the repair page that is associated with the ticket.

FRU Status The status of the FRU. Possible statuses are:
* Failed
* Degraded
* Warning
* Good

Error Code A number that is associated with a particular issue that caused the ticket

report. Because more than one issue can cause a report, an error code
provides another level of detail to what the report provides. The error code
maps to a portion of library firmware code, which a trained analyst can
examine to determine the root cause of an issue. If the ticket is in the Closed
or Verified state, this field is set to N/A. This information is for technical
support use only.

FRU Logical SN

The logical serial number that the library assigns to a drive in a specific
location. This is not the serial number of the particular FRU (see FRU SN in
this table). If a drive is replaced by another drive in the same library location,
the logical serial number remains the same. From the host’s perspective, the
replacement drive is the same as the original one. This field appears for all
drive-related tickets only. If the logical serial number addressing feature is
disabled for the library, Disabled appears in this field.

Description area

A summary description of report information that is associated with the
ticket. It includes reason text that describes the cause of the ticket.

In the FRU History Ticket List area:

ID

The library-assigned identifier for the history ticket.
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Element Description

Description A summary description of the history ticket. The description identifies the
FRU that caused the ticket and includes reason text that describes the cause
of the ticket.

All tickets that appear on the Details tab, including the ones in the FRU
History Ticket List area and the Ticket # area, see the same specific FRU.

State The current state of the history ticket. All history tickets are in the Closed or
Verified state.

Severity The historical ticket’s current severity level.

Serial # The serial number of the particular FRU.

Sub-system The subsystem that caused the ticket. Possible subsystems are:
* Connectivity

* Drives

* Control

* Power

* Media

* Robotics

Posted Date The date and time on which the library created the ticket.

From the Ticket Details dialog box, you can perform the following
tasks:

* Display detailed information for a history ticket by using the
Show button, and then redisplay the original ticket details
using the Initial Ticket button (see Viewing History Ticket
Details on page 61)

* Connect to online service and support resources by clicking
Online Support. Online service and support resources include
free, secure access to KnowledgeBase articles and the Online
Service Request tool. (If clicking Online Support does not
connect you to the online service and support website, try
disabling your Web browser’s pop-up blocker.)

* Mail, save, or print ticket information by using the Send button
(see Mailing, Saving, and Printing Ticket Information on
page 79)
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* Determine whether the issue is resolved by using the FRU Test

button. FRU Test is available only if the ticket’'s FRU has an
applicable verification test that you can run. (FRUs that belong
to the Accessor, Picker, Drive, I/E Assembly, or Bar Code Label
categories have applicable verification tests.) When you click
FRU Test, the Verification Tests dialog box appears with the
appropriate verification test already selected and ready to start.
If you run a verification test and the results are all good, the
library automatically transitions the ticket to the Verified state.
For more information, see Working With Verification Tests on
page 616.

Note: If the library does not have a verification test for the
FRU, after you resolve the issue, you must manually
transition the ticket to the Closed state by using the
Close Ticket button. After you close the ticket, the
library transitions it to the Verified state if it is able to
do so. For more information about manually closing a
ticket, see Closing Tickets on page 82.

Display report information (see Viewing Ticket Details Reports
on page 62)

Display the repair page (see Viewing Ticket Repair Pages on
page 66)

To display the detailed information for a particular history ticket,
perform the following steps:

1 On the Ticket List dialog box in the FRU History Ticket List area of
the Details tab, click the appropriate ticket row to highlight it and
click Show.

The history ticket details appear in the Ticket # area. However, the
list of tickets in the FRU History Ticket List remains the same as
what the initial ticket displayed. This list does not change. The
Report and Repair tabs show information that is specific to the
history ticket, but the Close Ticket and FRU Test buttons at the
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bottom of the Ticket Details dialog box are grayed out because the
history ticket is in the Closed or Verified state already.

x|
Details | Report |/Repair rMedia Integrity Analysis |
rTicket #2
State: Werified Fosted: Fritday 31 19:28:58 MDT 2002
Status Group: Drives arified: Frimfay 31 19:30:40 MDT 2002
Severity: 1 Duplicates: 0
FRU SM: 1200019348 Repair Link: 09_01_18_htm
FRU Status:  Failed Error Code: 09_01_18_00_80800207

FRU Logical SM: MiA

Drive sled at [1,1,1,6,1,1] communication has Failed - |
A: Drive sled at [1,1,1,6,1,1] communication has Failed
wihile polling a drive the drive drive comim. communication has Failed (SLED DRIVE COM PROBLE]_ |

|4

4B

| L]

rFRU History Ticket List

D || Description || State || Severity ||
Drive sled at [1,1,1,6,1,1] communication has Failed —
2 Werified |1 - Failed 1205

Drive sled at[1,1,1,6,1,1] communication has Failed
38 Werified |3 -Warhing 111

1

L]

| Initial Ticket | | Show |

[ s |

| Close | | Qnline Support | | Help |

2 To return to the non-history ticket that appeared initially, click Initial

Ticket.
Viewing Ticket Details The library creates a key report for each issue that occurs. As updates to
Reports the issue occur, the library creates subordinate reports that it associates

with the key report. Typically, you should examine the key report
because it represents the earliest time at which the ticket reached its
highest severity level. It often isolates the most significant problem.
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To display all report information that is associated with a ticket, click the

Report tab on the Ticket Details dialog box.

Details rRepon rRepair rMediaIntegrityAnalysis|

'REpDI"tS Tree
@ [C] Reports for Ticket #5
rReport #27
Report ID 27
Fosted ‘Wed Feb 27 23:10:07 GMT 2013
Duplicates 1
Status Group Connectivity
Severity Warning
FRU ID RCU sled CAN interface
FRU Instance at[1,1,1,1,1,1]
FRU Category Interface
Reason communication has failed
Error Code 14_05_18_00_80806267
Modifier 0x0
Repair Link 14_05_htm
Report Description:
(While initializing a drive, drive management has determined thatthe SLED CAN interface communi};
i D]

(oo J _rutest | Send J

W I LTI ==

[ Close J [ Online Support J [ Help J

L = — — = 4

By default, the Report # area displays report details for either the key

report or, if subordinate reports exist, the most recent subordinate

report.

Table 5 on page 64 describes the elements on the Report tab.
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Table 5 Report tab

Element

Description

In the Reports Tree area:

Report tree area

Provides a hierarchy of report information that is associated with the ticket.
Descriptions includes reason text that describes the cause of the report.

Initially, only the highest level of the report tree appears. Clicking this level
(Reports for Ticket #) reveals one or more second-level reports, and clicking a
second-level report reveals one or more third-level reports. Second-level reports
function essentially as containers of third-level reports. A ticket in the Open
state has one or more third-level reports, including one key report. The key
report represents the earliest time at which the ticket reached its highest
severity level. It often isolates the most significant problem. A ticket in the
Closed or Verified state does not have a key report.

In the Report # area:

Report ID The library-assigned identifier for the report.
Posted The date and time on which the library created the report.
Duplicates For open tickets only, the number of times that the library created the same

report. If the identical issue occurs while the ticket remains open, the library
creates an identical report and increments the report’s duplicate count. If the
library has not created duplicate reports, the value is zero (0).

Status Group

The subsystem that caused the ticket. Possible subsystems are:
¢ Connectivity

* Drives

* Control

* Power

* Media

* Robotics
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Element

Description

Severity

The severity level that is associated with the status group (subsystem). Possible
levels are:

* Failed

* Degraded
* Warning
* Good

FRU ID

The identifier for the FRU.

FRU Instance

In libraries with multiple FRUs of the same kind, the specific FRU that caused the
report. This field usually identifies a particular FRU by its location in the library
(for example, [1,1,1,8,1,1] for a drive sled). If the library has only one instance of
the FRU, this field is blank.

FRU Category

The category to which the FRU belongs.

Reason

A brief explanation of why the FRU caused the report. Reasons describe the
causes of issues.

Error Code

A number that is associated with a particular issue that caused the ticket report.
Because more than one issue can cause a report, an error code provides another
level of detail to what the report provides. The error code maps to a portion of
library firmware code, which a trained analyst can examine to determine the
root cause of an issue. This information is for technical support use only.

Modifier

A numerical qualifier, in hexadecimal format, that provides context for an error
condition. A modifier adds another level of detail to what the error code
provides. If a modifier does not exist for the error condition, this field is set to
“0x0". This information is for technical support use only.

Repair Link

The name of the repair page that is associated with the report.

Report Description

A summary description of the report.
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Repair pages provide problem descriptions and corrective actions that
you or a CSE can perform. To display the repair page that is associated
with a ticket, click the Repair tab on the Ticket Details dialog box.

"B Ticket Details “_ ! l__lcj Y o

fDetaiIs rReport rRepair rMedia Integrity Analysis |

Drive Sled Communication Problem
Problem: The library detected a drive sled communication problem.

User and Customer Service Engineer Actions

IF

THEN

Ly ora

.

. Mote the ticket details for the failure
description.

. Close the ticket.

. If a drive sled was removed intentionally,
consider using the proper procedure by
selecting Vary Of from the Tools > Drives
menu selection mode before removing a
drive to avoid this ticket in the future.

. If a drive sled was not pulled or removed:

a. Verify that ALL drive sleds are
completely pushed in and have the

In all cases: thumbscrews securely tightened.
b. Select Tools > Drives to vary off the |
noted drive sled. i
J L J L Content ]
( ) Frutest [ send J
[ Close ] L Online Support ] L Help ]

e =

= 4

The repair page provides the following information:

* The title at the top of the repair page is a brief description of the

issue.

¢ The Problem section describes the issue in more detail.

* The User and Customer Service Engineer Actions section provides
corrective actions that the user or the CSE can perform.

* The Customer Service Engineer Actions section provides
additional corrective actions that the CSE can perform. If you are a
user, do not perform these steps. Contact technical support for

assistance.
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Note: If you are a CSE, see the Scalar i2000/i6000 Maintenance
Guide for detailed maintenance action plans, and removal
and replacement procedures.

* The Technical Support Information section provides a
comprehensive list of FRUs that could be involved.

» Text on the repair pages can include links to specific Online Help
pages, which appear in place of the repair page when you click
them. Navigation buttons near the top of the Repair tab enable you
to access Online Help pages as follows:

* The Back button returns you to the previously viewed page
(either a previously viewed Online Help page or the repair page).

* The Next button returns you to the page that you were viewing
before you clicked the Back button.

* The Content button displays a table of contents for the Online
Help system.

Viewing Tape Alerts and A drive issues a tape alert whenever there is a problem encountered by

Generating Media the drive. The problem can be with the drive, library, or with the tape
Integrity Analysis cartridge. You can view tape alerts on the Media Integrity Analysis tab of
Reports the Ticket Details dialog box. You can also access Media Integrity

Analysis via Reports on the LMC menu. See Viewing Tape Alerts on
page 68 or Generating Media Integrity Analysis Reports on page 70.

Note: The Media Integrity Analysis feature (including viewing tape
alerts) requires an Advanced Reporting license key to use. For
more information, see Enabling Licenses on page 123.

You can use these reports to cross-reference tape alerts for drives and
tape cartridges over a specified period of time, in order to determine if
the problem belongs to the drive or to a specific tape cartridge.
Typically, tape alerts point to a drive problem if a specific drive exhibits
tape alerts against multiple pieces of media. Conversely, tape alerts
point to a media problem if a specific piece of media exhibits tape alerts
against multiple drives. See Generating Media Integrity Analysis Reports
on page 70.
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Viewing Tape Alerts

To view tape alerts:

1 Click the Media Integrity Analysis tab on the Ticket Details dialog

box.

Note: The Media Integrity Analysis tab only appears on the
Ticket Details dialog box for drive subsystem tickets.

The Media Integrity Analysis view appears, displaying one of the
following:

* If the ticket contains a valid drive serial number and the drive is
present in the library, the view displays a list of drive SNs in the
left pane and media IDs in the right pane for which tape alerts

exist for the specified date range.

* If the drive serial number given in the ticket is invalid or if the
drive is not present in the library, the view displays the message,
“Invalid serial number or drive is no longer present.”

rDetal\s rRepnn rRepalr r Media Integrity Analysis |

‘ Last 3 Months w ‘ ‘ Repart |

x|

Drive: 1110143209 :_ Media ID: not available
Media ID H Count || Last Oceurr... ‘ Drive SN || Count
11005331 3 10/02/05 20:39
L101179L1 3 09/15/0510:27 |
| ciossTexet || rrumest || Send |

‘ Close | |

Online Support | |

Help
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2 To change the date range, click the down arrow next to the date box
and select the range you want.

x
Media Integrity Analysis |

|LastSDDa\;s v||| Report.. |

Drive: 1110143209 Historical Media ID: nat available
- Current Manth -
Mediz ID Count Drive SN || Count || Last Oceur...
0053311 3 Last Manth
|
0717601 3 Last 3 Manths

Last 6 Months

Last12 Manths

The Media Integrity Analysis tab displays the tape alert
information available for the selected range.

4
[Lastzmonins > || Report.. |
Drive: 1110143209 4 Media ID: not available
Media 1D Count Last Occurr_ | Drivesh || count | Lastoccur

J00376L1 5 107/0517:19 001385060 |2 0/06/04 1443
0053301 3 10/02/05 20:39

o1 7aLt 3 09/15/05 10:27

0033711 2 07728/05 2223

0126211 2 07/09/05 15:46

0002401 3 04/18/05 10:65

000226L1 B 04/09/05 06:05

006831 2 04/08/05 03:20

JonaraLl 2 03729/05 06:46

0052601 5 03/12/05 1413

0117801 2 03/02/05 13:46

00159001 8 02024/05 01:24

10018501 1 02016/05 21.04

o127l 2 02/02/05 15:48

00000312 3 01/09/05 18:40

000046L1 5 12007/04 12:43

0023311 2 11/21/04 04:42

0023211 3 10/06/04 17.07

JonazaL 2 09/06/04 13:08

0127411 3 09/06/04 10:23

0111801 1 09/02/04 05:22

0122301 1 05/24/04 16:16

000077L1 3 05017/04 05:40

J00365L1 3 02/06/04 1549

1004 7A14 EETETTT 42 |

| cioseTicket || FRuTest || Send |
| Clnse | Online Support | Help |

3 To sort the lists, click the column heading you want to sort.
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4 To generate a report, click Report. The Report Criteria dialog box
appears.

Go to Generating Media Integrity Analysis Reports on page 70.

Generating Media Integrity Analysis Reports

Note: The Media Integrity Analysis feature requires an Advanced

Reporting license key to use. For more information, see
Enabling Licenses on page 123.

This function allows you to generate reports using the criteria described
in Table 7 on page 85.

To generate Media Integrity Analysis reports:

1 Do one of the following:

* On the Media Integrity Analysis tab of the Ticket Details
dialog box, click Report.

Ticket Details

x|
(Deta\ls rRepUn rRepair r Media Integrity Analysis |

|La513MUmh5 v|| Report. |

Drive: 1110143204 : Media |D: not available

hedia 1D || Count || Last Occurr.. | ‘| Crive SN || Count H Last Occur..
J00533L1 3 10002005 20:39 | ¢
J01178L1 3 :

0915051027

* On the menu bar, click Tools > Reports > Media > Integrity
Analysis. The Report Criteria dialog box appears.
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. Report Criteria él
rTemplates
ER— Select a templata-—---- = v| ‘ B |

rSpecify Report Criteria:

Range: |Last30 Days '|
Grouping:|AII '|
[v] Media 1D

[+ Drive Physical SN
[¥ Tape Alert

[ Exclude Exported Media

Type: |R’Dllup v|
Sort By: |A|phabeticany v |
Chart |Bar v|
| Wign | | Cancel | | Expaort | | Help |

2 To view a report, select the report criteria described in Table 6 and

click View.
Table 6 Report Criteria
Element Description
Range Specifies the range of time to cover in the report. Choices include:
* Historical

e Current Month

¢ Last Month

* Last 3 Months

¢ Last 6 Months

e Last 12 Months

* Last 30 Days (default)
* Last 7 Days
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Element Description

Grouping Determines which drive or tape cartridge to base the report. Choices include:
e All (default)

* Selected Drive by Physical SN—displays the Choose Drive dialog box

* Selected Media by Media ID—displays the Specify Media dialog box

Media ID, Selected in any combination to determine which values are included in the
Drive Physical SN, report. (All=default)
Tape Alert

check boxes

Type Type of report. Choices include:

* Rollup — displays the values based on which of the above check boxes,
Media ID, Drive Physical SN, and/or Tape Alert, that you have selected
(default)

* Trend — shows the occurrence of tape alerts over time

Sort By How the report is sorted. Choices include:
¢ Alphabetically (default)
* Count

¢ Last Occurrence

Chart Determines the type of chart. Choices include:
* Area

* Bar

* Bar3D

* Line

* Stacked Area

 Stacked Bar

* Stacked Bar 3D

* Pie

* Pie 3D (default)
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The Report Viewer dialog box appears. The content and
appearance of the report varies depending on the selected criteria.

.Report Viewer ﬂ

[] Media Intearity Analysis - Last 30 Days Rollup ¢ |

Media Integrity Analysis - Last 30 Days Rollup (All)

unknown/ 12100223317
20=1
00025813/ 0002443/
1210003815/ & 1 1210022331/4=1

000252137
1210003564 33
000252137
1210003564/ 55 = 1

M 00024413/ 1210022331/3 M 00024403 1210022331/ 4 M 00025213/ 1210003564/ 33
00025213/ 1210003564 55 00025213/ 1210003615/ 4 M 0O00258L3/ 1210003615/ 54
unknowns 1210022331/ 20

— - = =

Media ID Dirive 5K Tape Alert Count Last Occurrence
00024413 1710022331 3 1 102072006 18:11 MDT
0002443 121002233 4 1 10/20/2006 18:41 MDT
0002523 1210003564 33 1 103172006 1 6:48 MST
00025203 1210003564 &5 1 103172006 1 6:48 MST
000255L3 1210003614 4 1 10/27/2006 09:42 MDT
0002563 1210003615 7] 1 10/26/2006 1 5:26 MDT
unknown 1210022331 0 1 10/20/2006 1 8:11 MDT

| menu || prevew || cimse || hew |

3 Click Preview. The report appears in the Media Integrity Analysis
Print Preview window.
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Tape Alerts - Last 30 Days Rollup {All) - Print Preview 1[

9 e E

Next Zoom In|| {|'| Boom Ou

Tpe Alats Tipe Alats- Last 30 Diys Rolhyp (ALL)

Tape Alerts - Last 30 Days Rallap (AlL)

Tape Alerts = Last 30 Days Rollup (All)

0157211 - T - :J::' BL1 FOO 1362070
J2=a o =3

L0 ATEL 103 IRT A
5=I

107167 7 Foo SEmIann
a-a

JZ1 18I Tz 13 3a0e I
P

W OTAFLFONSRTATES T MAOTE COAR 100 AT SR BN WFOTIRAAT MR AL PSRRI T8
20 1ZTLLFOII3E5070) 25 M J0HTOLL 38 15157305 [0 0 12740 10 1 0075254 33

[4]

3

4 To navigate through the report, click the Next or Back icons on the
toolbar. The next or previous page appears.

Tape Alerts - Last 30 Days Rollup {All) - Print Preview x|

k| Bl (K2

Zoom In}||f | Zoom Ou

Trpe Alats Trpe Alats- Last 30 Days Bolkyp (AL)
Meikia B Tuive S0 Tape Alext Cow Last fcnuzence
00031811 FOOL3ES070 g 2 09/18/2005 01:01 MDT
053311 6311161873 43 3 10/12/2005 2030 MD T
TO1064L1 FOOL3ES06D 12 E] 00/18/7005 15:50 MD'T
T111EL1 FOOL3ES06D 63 1 09/12/7005 12:37 MD'T
T01167L1 FOOL3ES06D 55 3 10/13/2005 1530 MD T
117911 6311161873 3 3 09/13/2003 10:27 MD T
T1IT4LL 1110075054 3 3 09/20/2005 11:33 MD'T
Tatal 17

5 To increase or decrease the magnification of the report, click the
Zoom In or Zoom Out buttons.

6 In the report viewer, you can perform the following tasks:
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* To print the report, click the Print icon on the toolbar. Refer to
Printing Media Integrity Analysis Reports on page 75.

* To save the report as an Adobe Portable Document Format (PDF)
file, click the Adobe PDF icon on the toolbar. Refer to. Creating
Report PDFs on page 75.

* To export the report, refer to Exporting a Report to an E-mail or
a Text File on page 88.

* To save the report template, refer to Saving a Report Template
on page 88.

Printing Media Integrity Analysis Reports

To print a tape alert report:

1 In the Media Integrity Analysis Reports Print Preview window,
click the Print button. The local system’s print dialog box appears.

2 Follow the prompts.

Note: The Print function is not available on the touch screen.

Creating Report PDFs

To create a PDF of a report:

1 In the Media Integrity Analysis Print Preview window, click the
PDF button. The Saving Report into a PDF-File dialog box appears.
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Saving Report into a PDF-File ... X|

Filename| || Select File |
Tite | |

Authar  [ismith |

Encoding| ldentity-H (PDF-Unicode encoding) - |

Security Settings and Encryption

® Mo Security r Encrypt with 40 hit keys 0 Encryptwith 128 it keys
User Password Confirm
Owyner Password Confirm
Allow Printing
| Canfirm || Cancel |

2 Click Select File. The Save dialog box appears.

[ save x|
Save |n: |Ij Mty Documents v| @ @ @ @E

[ _Common [ Sounds
3 _Download [ test.paf
[ Adobe

3 BarTender

3 Corel User Files

3 Documents

[ Images

File Mame: |test.pdf |

Files of Type: | FDF Documents b |

| Save || Cancel |

3 In the Save dialog box, browse to the location where you want to
save the file, type the filename, and click Save.

4 In the Saving Report into a PDF-File dialog box, enter the settings
you want and click Confirm. The PDF file is saved in the specified
location.

Note: The PDF function is not available on the touch screen.
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Exporting Media Integrity Analysis Reports

You can export the report data as a comma-delimited text (.CSV) file
that you can open in Microsoft Excel. This function allows you to:

¢ E-mail the file as an attachment

¢ Save the file to a folder

To export report data:

In the Report Criteria dialog box, select the range and grouping
you want to export and click Export. The Export Raw Data dialog
box appears.

Note: The only criteria that the export function uses are range
and grouping.

Export Raw Data x|

rSelect

® Email | | hd |

Comment: | |

) Save

| Ok || Cancel || Help

To e-mail the data:
1 Select Email.

2 Type the e-mail address or click the down arrow and select the e-
mail address from the drop-down list.

If you want, type a comment.

4 Click OK.

To save the data to a folder:
1 Select Save.

2 Type the file name in the text box.
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3 Click Browse. The Open dialog box appears.

[ open x|
Laak In: |Ij My Documents v| @ @ @ @E

= _Common 3 Sounds
3 _Download

] Adobe

7 BarTender

[ corel User Files

1 Documents

= Images

File Mame: || |

Files of Type: | Comma Delimited Files (*.csw) - |

| Qpen || Cancel |

4 In the Open dialog box, browse to the location where you want to
save the file, type the file name, and click Open.

5 Click OK.

Note: The Save function is not available on the touch screen.

Saving a Report Template

If you frequently generate the Media Integrity Analysis Report with the
same set of report criteria, save the criteria as a template. Loading the
template recalls the saved report criteria and lets you quickly generate a
report based on the saved criteria.

1 On the menu bar, click Tools > Reports > Media Integrity
Analysis. The Report Criteria dialog box appears.

2 Under Specify Report Criteria, click criteria options in the lists to
customize the content and appearance of the Media Integrity
Analysis Report.

Table 6 on page 71 summarizes the available report criteria options.
Under Templates, click Save.

4 Type a name for the template, and then click OK. The template
appears in the list under Templates.
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To load the saved report criteria at a later time, click the template in
the list, and then click View to generate the report.

5 To close the Report Criteria dialog box, click Cancel.

The Send button on the Ticket Details dialog box enables you to send
detailed ticket information, including all report details, to e-mail
addresses. If you are accessing the LMC from a remote client, Send also
enables you to save the information to a file or print it.

Note: You can mail, save, or print ticket information from a remote
client. However, you cannot save or print the information from
the library’s touch screen.

Ticket information that a user sends by using the Send button is
essentially the same as the information that the library automatically
provides in e-mail notifications (see E-mail Notifications on page 47).
The only differences are that the subject line states “Library RAS
Information” and the body of the message does not have a “REASON
FOR AUTOMATED E-MAIL" section, but it has a “REPAIR AND
TROUBLESHOOTING INSTRUCTIONS ATTACHED" section.

The message body also includes the following information, which
provides details about the ticket and library conditions at the time of
the event:

* Ticket summary

* Ticket details, including status information

* Firmware versions, including MCB, RCU, CMB, and drive bricks
* Physical library configuration

* Library states, such as physical library online or offline, partitions
online or offline, or robotics varied on or varied off

* Time stamps of recent activity
* Report summary
* Report details for the ticket
The RAS repair page attachment is in HTML format.
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Note: Before you perform the following procedure, you must make

sure that e-mail is appropriately configured in the LMC so that
the library can send ticket details to the recipient. See
Configuring E-mail on page 185.

To mail, save, or print information for a particular ticket, perform the
following steps:

1 Make sure that the Ticket Details dialog box displays information
for the ticket that you want to send. See Displaying Ticket Lists on
page 52 and Viewing Ticket Details on page 57.

2 Click Send. The Ticket Information dialog box appears.

Ticket Information x|

rSelect

) Email

Comment:
@ Save

) Print

| [~

[itrmpiticketaz | Browse...

| Qk || Cancel || Help |

3 Perform one of the following tasks:
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* To indicate that you want to send the information as an e-mail

message to a recipient, select Email, and then either type an e-
mail address in the Email text box or select an existing address
from the drop-down list. You can type a comment in the
Comment text box to send with the information.

* To indicate that you want to save the information, select Save,

and then either type in the Save text box a path and a file name
to which you want the information saved or click Browse to
specify a location and a file name.

Note: The Save option is available to remote client users only.
It appears grayed out on the touch screen.

* To indicate that you want to send the information to a printer,

select Print.
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Note: The Print option is available to remote client users only.
It appears grayed out on the touch screen.

4 To send, click OK.

A ticket is always generated against a particular FRU when the library
detects an issue. Therefore, the library provides FRU tests that you can
run to determine whether the conditions that caused the ticket have
been resolved. Running the FRU tests is an important part of ensuring
that the system is working properly.

The library can detect issues under the following contexts:
* When the library polls at regular intervals, or

* When a host or user commands the library to perform an operation
(such as occurs with GUI commands, host inventory, and host move
media)

FRU tests are designed to help resolve issues under the second context.

During FRU testing, the library creates operational scenarios to evaluate
the functionality of a FRU. FRU tests attempt to evaluate as many
aspects of the FRU as possible, but they might not fully recreate the
conditions that caused the original ticket. The library cannot recreate all
conditions and, therefore, the library does not provide tests for some
FRUs.

The instructions on the ticket’s repair page direct you to run a FRU test if
an applicable one exists. If you run the test and the results are all good,
the library automatically transitions the ticket to the Verified state.

Note: If you cannot run a test, make sure that you complete the
repair page instructions and, if needed, physically examine the
FRU. After you determine that the issue is resolved, manually
transition the ticket to the Closed state. See Closing Tickets on
page 82. After you close the ticket, the library transitions the
ticket to the Verified state if it is able to do so.

You can access the tests in two ways:

* On the main LMC display, click Tools > Verification Tests. The
Verification Tests dialog box appears. From this dialog box, you can
choose from a variety of verification tests, including the FRU tests.
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* On the Ticket Details dialog box, click FRU Test.

Note: The FRU Test button is available only if the ticket’s FRU has
an applicable verification test that you can run.

The Verification Tests dialog box appears with the appropriate test
already selected and ready to start.

For details about the verification tests and how to run them, see
Working With Verification Tests on page 616.

Closing Tickets Manually close a ticket if all of the following conditions are true:

* You have completed the repair page instructions to resolve the issue
(for example, replaced a FRU).

* You have physically examined the FRU to make sure that the issue is
resolved.

* The FRU Test button on the Ticket Details dialog box is not
available. This means that an applicable verification test does not
exist.

Note: If the FRU Test button is available for a ticket, you should
use it to access and run the verification test. You should not
manually close it. The verification test determines whether
the issue is resolved, and the library automatically
transitions the ticket to the Verified state if the test passes
without problems. See Running Verification Tests to
Determine Issue Resolution on page 81.

* The issue has been resolved, but the ticket remains in an Open state
(for example, when defective media has been replaced in the
library).

You should manually transition a ticket to the Closed state after
performing the resolution steps and making sure the issue is resolved.

Closing Individual Tickets

To transition a ticket to the Closed state, perform the following steps:
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1 Make sure that the Ticket Details dialog box displays information

for the open ticket that you want to close. See Displaying Ticket Lists

on page 52 and Viewing Ticket Details on page 57.

2 Click Close Ticket. The ticket's state changes to Closed. If the library
is able to do so, it automatically transitions the closed ticket to the

Verified state.

Note: If the identical issue occurs again within 30 minutes after
the ticket transitions to the Closed or Verified state, the
library reopens the ticket and increments the ticket's
duplicate count.

Tickets that are in the Closed or Verified state for more
than 30 minutes cannot be reopened. In this case, if the
identical problem occurs again, the library creates a new
ticket.

Closing Multiple Tickets

You can use this method when you have many tickets relating to the
same issue, for example, when you have many drives in a library or
many tape alerts.

To transition multiple tickets to the Closed state, do the following:

1 On the Ticket List dialog box, select each ticket you want to close by

clicking the check box.

See Displaying Ticket Lists on page 52 and Viewing Ticket Details on

page 57.
2 Click Close Tickets.

3 In the Attention message box, click Yes to confirm that you want to

close multiple tickets. The tickets’ state changes to Closed. If the

library is able to do so, it automatically transitions the closed tickets

to the Verified state.

The Tickets Report lets you see how many tickets occurred in a particular
time period. You can choose to group tickets by subsystem, module, or
FRU, and the results can be presented as a rollup summary or as a trend
so you can see if the number of issues is increasing or decreasing over
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time. Also, the report results can be presented in different chart
formats, such as bar graphs or pie charts.

After generating a report, you can print it or save it as a PDF file. In
addition, you can save a set of report criteria as a template for reports
you frequently generate.

Specifying Tickets Report Criteria
To generate the Tickets Report, first specify the report criteria, and then
view the report.

1 Log on as an administrator.

2 On the menu bar, click Tools > Reports > Tickets. The Report
Criteria dialog box appears.

Report Criteria ﬁ
rTemplates

[[+—zetect s tempiate—> * || gave.. |

rSpecify Report Criteria:

Range: | Last30 Days -]
Grouping:| Supsystem -
Attribute: | 41 |
Type: | Rollup -]
Chat | Stacked Bar |

| view || cancel || Eqot. || Help |

3 Under Specify Report Criteria, click criteria options in the lists to
customize the content and appearance of the Tickets Report.

Table 7 summarizes the available report criteria options.
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Table 7 Tickets Report Criteria

Options

Criteria Description

Range Specifies the range of time to cover in the report. Choices include:
* Historical
* Current Month
e Last Month
* Last 3 Months
* Last 6 Months
* Last 12 Months
* Last 30 Days (default)
e Last 7 Days

Grouping Determines how tickets are grouped in the report. Choices include:
¢ Subsystem (default)—tickets are grouped according to subsystem
* FRU Category—tickets are grouped according to FRU category
* FRU Id—tickets are grouped according to FRU ID
* Serial Number—tickets are grouped according to module serial number
* Selected Drive by Physical SN—tickets are grouped according to drive serial

number (displays the Choose Drive dialog box)

Attribute Determines how tickets are identified in the report. Choices include:

* All (default)—tickets are separated according to attribute (Failed,
Degraded, Warning, or Other)

* Total—tickets are not separated according to attribute

Type Specifies the type of report. Choices include:

Rollup (default)—displays the values based on the selected grouping

* Trend—shows the occurrence of tickets over time (grouping criteria is not

used)
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Criteria (Continued)

Description

Chart Determines the type of chart. Choices include:
* Area
* Bar
e Bar 3D
e Line
¢ Stacked Area
¢ Stacked Bar (default)
¢ Stacked Bar 3D
* Pie
¢ Pie 3D
4 Click View. The Report Viewer dialog box appears. The content and
appearance of the report varies depending on the selected criteria.
Report Viewer g‘
[x] Tickets - Last 30 Days Rollup (Al Subsystem) |
Tickets - Last 30 Days Rollup (All Subsystem)
32
30
28
26
24
22
20
E 18
S 1.8
14
12
10
8
-]
4
8 —
) - 0
Connectivit Control Cooling Drives Power Robaotics
¥
Subsystem
[WFailed MDegiaded Mwaming  Other |
e e
Connectivity 0 1] 1] 0 1]
Cantrol 1 0 1 2 4
Cooling a 1] 1] a 1]
|[Crives i} 1] 10 " 27
V|Power 0 [ [ 0 [
i‘nunutins 20 n n 12 32
I Menu | ‘ Preview ‘ | Close | ‘ Help ‘
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5 When you are finished viewing the Tickets Report, click Close.

6 To close the Report Criteria dialog box, click Cancel.

Printing or Exporting a Report to PDF

After generating the Tickets Report, you can print it or export it to a PDF
file.

1 On the Report Viewer dialog box, click Preview. The Print Preview
dialog box appears.

kets - Last 30 Days Rollup (All Subsystem) - Print Preview
=l a|l[=]|[@
@ Print Back Zoom In|| || |Eoom Qu Q

Aggregted Tickets Report Tickets - Last 30 Duys Rolkip { AL Subsystem )

Tickets - Last 30 Days Rollup (ANl Stbsystem)

Tickets - Last 30 Days Rollup (All Subsystem)

32
30
28
26
24
22
20
12
16
14
12

Count

(SR -}

Connectiv Control Cooling Drives Power Robotics

ity

Subsystem

[® Failed MW Degraded M Waming  Other|

2 Do one or more of the following:
* To navigate through the pages of the report, click Back or Next.

* To increase or decrease the magnification of the report, click
Zoom In or Zoom Out.

* To print the report, click Print. Specify print options, and then
click OK.
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* To save the report as a PDF file, click PDF. Specify a file path and
file name, and then click Confirm.

3 When you are finished working with the Print Preview dialog box,
click Close.

Note: You cannot print reports or save them to a PDF file using the
touch screen.

Exporting a Report to an E-mail or a Text File

Instead of viewing the report as a chart, you can e-mail the report data
to an e-mail address. Or export the report data to a comma delimited
text file (*.csv) for use in other programs.

1 On the menu bar, click Tools > Reports > Tickets. The Report
Criteria dialog box appears.

2 Under Specify Report Criteria, click criteria options in the lists to
customize the content and appearance of the Tickets Report.

Table 7 on page 85 summarizes the available report criteria options.
3 Click Export. The Export Raw Data dialog box appears.
4 Do one of the following:

* To send the report data to an e-mail address, click Email. Type or
select the e-mail address, type an optional comment in the
Comment box, and then click OK.

* To save the report data to a comma delimited text file, click
Save. Specify a file path and file name, and then click OK.

5 To close the Report Criteria dialog box, click Cancel.

Saving a Report Template

If you frequently generate the Tickets Report with the same set of report
criteria, save the criteria as a template. Loading the template recalls the
saved report criteria and lets you quickly generate a report based on the
saved criteria.

1 On the menu bar, click Tools > Reports > Tickets. The Report
Criteria dialog box appears.
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2 Under Specify Report Criteria, click criteria options in the lists to
customize the content and appearance of the Tickets Report.

Table 7 on page 85 summarizes the available report criteria options.
3 Under Templates, click Save.

4 Type a name for the template, and then click OK. The template
appears in the list under Templates.

5 To load the saved report criteria at a later time, click the template in
the list, and then click View to generate the report.

6 To close the Report Criteria dialog box, click Cancel.

Suppressing Tickets and By default, the library provides notifications whenever a problem occurs.
Ticket Notifications Notifications include:

* For Severity 1 issues, an e-mail is sent to Quantum Technical Support
(techsup@quantum.com). This is set up by default in the Setup >
Notifications > System Setup dialog box, Rules tab. See Setting
Up E-mail Notifications on page 188 for more information.

* An e-mail is sent to individuals that you have set up in the Setup >
Notifications > System Setup dialog box, Rules tab. See Setting_
Up E-mail Notifications on page 188 for more information.

* A ticket is generated (see Viewing Ticket Details on page 57 for
more information).

You can suppress these notifications and ticket generation as follows:
1 Select Setup > Notifications > Tickets Filter.

2 The Suppress Tickets Filter dialog box appears. The displayed table
lists all tickets that have ever been issued for your library, plus all
tickets pertaining to Tape Alerts (indicated by the Tape Alert number
in the TA# column). Tape Alert tickets are listed even if they were
not issued for the library.

Note: The list does not update dynamically. You can click the
Refresh button to update the list
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Figure 22 Suppress Tickets

Filter

90

p ™
B Suppress Tickets Filtery S S S Ga— M

— - - —

3 Filter the displayed list by selecting an option from the Category

For each ticket you want to suppress, select a suppressicn option from the Suppression Option drop-down list. You can:
e-mail ificati to T i Support; all e-mail or prevent the ticket from being
generated.

r Table Filter

Category: | All -

r Suppress Legend
1 Mone [0 Tech Support E-mail B8 E-mail [ Ticket

Suppression Option Ticket Description TA# Cateq

Data cartridge has issued a Tape Alert
Tech Support E-mail  + 1 Drives

Data cartridge has issued a Tape Alert
Maone - 3 Drives

X Data cartridge has issued a Tape Alert

Ticket - 4 Drives
Data cartridge has issued a Tape Alert

Maone - 5 Drives
Data cartridge has issued a Tape Alert

MNone - g Drives
Data cartridge has issued a Tape Alert

MNone - 7 Drives
Data cartridge has issued a Tape Alert

Maone - 8 Drives
Data cartridge has issued a Tape Alert

Maone - 9 Drives

[ OK J[ Cancel J[ Help J[ Refresh J

drop-down list in the Table Filter section. Options include All

(default) or any of the six system status categories (Connectivity,

Control, Media, Drives, Power, and Robotics).

4 For each ticket that you want to suppress, choose a suppression
option from the drop-down list in the Suppression Option column.

Options include:

* Tech Support E-mail — No e-mail notification will be sent to

Technical Support for this ticket.

* E-mail — No e-mail notification will be sent to Technical
Support or to the individuals configured in the Setup >
Notifications > System Setup, Rules tab for this ticket.
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* Ticket — No RAS ticket will be generated. Additionally, no e-
mail notification will be sent to Technical Support or to the
individuals configured in the Setup > Notifications > System
setup, Rules tab.

5 Once you have chosen a suppression option, click somewhere else in
the table and the row containing the ticket you suppressed turns a
color corresponding to the suppression option (colors are identified
in the legend at the top of the table).

6 Click OK.

Interpreting LEDs

LEDs can help you assess the state of a library component. The primary
library LEDs can be grouped as follows:

* Interpreting Blade Status LEDs on page 91

* Interpreting Drive Status LEDs on page 94

* Interpreting Fibre Port Link LEDs on page 98(for Fibre drives and
Fibre Channel I/O blades)

* Interpreting Ethernet Expansion Blade LEDs on page 101

* Interpreting MCB Port LEDs on page 102

* Interpreting LBX Terminator LEDs on page 104

* Interpreting Power Supply LEDs on page 109

* Interpreting Gen 2 Robot Status LEDs on page 111

Interpreting Blade Each of the following library blades has a set of green, amber, and blue
Status LEDs LEDs that indicate blade processor status, health status, and power
control status:

* Management control blade (MCB)
* Control management blade (CMB)
* Fibre Channel (FC) I/O blade

Quantum Scalar i6000 User’s Guide 91



Chapter 2: Troubleshooting Your Library
Interpreting LEDs

* Ethernet Expansion blade
* Robotics control unit (RCU)
* Library motor drive (LMD)
* Library power control (LPC)

Figure 23 shows the locations and colors of the status LEDs on the five
blades that can be in the library.

Figure 23 Locations and Colors
of Blade Status LEDs

blade LEDs

management control blade - left = blue
. . - middle = amber,
robotics control unit - right = green

library motor drive

oo § f;;. — Ethernet Expansion Blade

- left = green
- middle = amber,
- right = blue

FC 1/0O Blade
Control Management Blade

Blade status LEDs provide troubleshooting information that you can use
in conjunction with tickets that the library creates. However, the LEDs
might not directly correspond to tickets. The LEDs can indicate a
firmware or hardware problem so severe that the library cannot create
or display a ticket. For example, if the MCB firmware becomes
inoperable, the amber LED flashes at 1 Hz, but the library might not be
able to display any related tickets.
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For a description of each LED color and what its state might mean, see
Table 8 on page 93. For a description of how the blade status LEDs
appear under normal conditions, see Table 9 on page 94.

Table 8 Explanations of Blade
Status LED States

LED Color Represents Possible States and Explanations

Green Processor status * Solid off — blade’s main processor is not operating (or
blade is booting)

* Solid on — blade’s main processor is not operating
(however, this does not apply to the LMD; solid on
indicates that the LMD’s main processor is operating
normally)

* Blinks one time every second (1 Hz) — blade’s main
processor is operating normally

* Blinks 10 times every second (10 Hz) — identify mode

¢ Solid on for three seconds, then blinks twice at 1 Hz, and
then repeats — blade firmware is downloading

Amber Health status * Solid off — blade’s power and control subsystem is
operating normally

* Solid on — blade’s power and control subsystem has failed

Solid on also can mean that the blade’s power and control
subsystem firmware is autoleveling. In conjunction with
the blue amber LED blinking one time every 10 seconds,
this is a normal condition.

Autoleveling takes about three minutes for each blade,
and blades within an I/O management unit autolevel in
series. It can take as long as three minutes for the power
and control subsystem to download. Never remove a blade
when the amber LED is solid on unless it has been on
continuously for at least 10 minutes.

Blue Power control status * Solid off — blade is not receiving power

* Solid on — blade is powered down; ready to be replaced
(swap mode)

* Blinks one time every 10 seconds (flash) — blade is
powered on; operating normally
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Table 9 Blade Status LED
States - Normal Conditions

LED Color State and Explanation

Green Blinks one time every second (1 Hz) — blade’s main processor is operating normally
(however, this does not apply to the LMD; solid on indicates that the LMD’s main
process is operating normally)

Note: If there are issues during an update using an embedded flash, the green LED is
solid for two seconds, and then off for one second.

Amber Solid off — no errors are detected; blade’s power and control subsystem is operating
normally
Blue Blinks one time every 10 seconds (flash) — blade is powered on; operating normally

Actions Based on LED States

When the RAS system is operating properly, service actions should be
based on tickets first and foremost. However, some situations occur
when the amber LED indicates problems that are not detected by the
ticket system. You should always act on any amber LED that is solidly on,
which indicates that the blade’s power and control subsystem has
failed. In this case, replace the blade.

When you replace a blade FRU or escalate a problem based on LED
states, perform the following steps:

1 Observe and report the timing pattern of the blue, amber, and
green LED group. Spend at least 30 seconds observing the LEDs and
record the results in the service request (SR) and on any equipment
failure report form that you return with the part. Proper reporting
of all LED states is critical for determining the root cause of the
failure.

2 Capture a system snapshot and send it to technical support for

analysis.
Interpreting Drive The library reports all drive issues that can affect customer operations.
Status LEDs In addition to examining library reports, you should observe drive sled

link LED and status LED activity.
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Note: The blinking codes described in Table 10 on page 97 are the
same for Fibre Channel and SCSI drives in the UDS-2 drive sleds.

Figure 24 shows the locations of the status LEDs and the Fibre Channel
link LED on the rear of a UDS-2 drive sled.

Figure 24 Rear View of Fibre
Channel Drive Sled (UDS-2)

status LEDs:
- top = blue
- middle = amber

fibre port - bottom = green

FC link LED

Figure 25 shows the locations of the status LEDs and the Fibre Channel
link LED on the rear of a UDS-3 drive sled.
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Figure 25 Rear View of Fibre
Channel Drive Sled (UDS-3 LTO-
4 and LTO-5 Drives)

© 00 38 LTO-4
©:I:||:©I status LEDs:
% %I fibre port i :gi%glglgeamber
C_J L] o ‘ O - bottom = green
C_ JC__JC 1 \:I ©
e[ 1_1& O o
Link LED's
FC Part 1 (on the left)
FC Part 2 {on the right)
o 00 §
Y - ~
: }l l: : fibre ports
LTO-5 | ] | |
(- —© / E O
C I ] ®
e e ] [ =
| 1 2 -
I
EEB port

Table 10 on page 97 describes how to interpret the drive sled status LED
activity that you might see on the rear of a UDS-2 or UDS-3 drive sled.
For a description of how the blade status LEDs appear under normal
conditions, see Table 11 on page 97. For information about interpreting
the drive link LED, see Drive Sled Fibre Channel Link LED on page 98.
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LED Color

Represents

Possible States and Explanations

Green

Processor status

Solid off — drive sled’s main processor is not operating (or
blade is booting)

Solid on — drive sled’s main processor is not operating
Blinks one time every second (1 Hz) — drive sled’s main
processor is operating normally

Blinks 10 times every second (10 Hz) — identify mode
Solid on for three seconds, then blinks twice at 1 Hz, and

then repeats — drive sled or drive brick firmware is
downloading

Blinks three times in three seconds (1 Hz), then pauses
(solid off), and then repeats — drive brick is activating
(varying on)

Amber

Health status

Solid off — drive sled’s controller (drive DC to DC converter
[DDC]) is operating normally

Solid on — drive sled’s DDC has failed

Blue

Power control status

Solid off — drive sled is not receiving power

Solid on — drive brick is powered down; ready to be
replaced (swap mode) or varied on

Blinks one time every 10 seconds (flash) — drive brick is
powered on; operating normally

Table 11 Drive Sled Status LED
States - Normal Conditions

LED Color State and Explanation

Green Blinks one time every second (1 Hz) — drive sled’s main processor is operating
normally. The green LEDs for all drive sleds that are operating normally blink together.

Amber Solid off — no errors are detected; drive sled’s controller is operating normally.

Blue Blinks one time every 10 seconds (flash) — drive sled is powered on; operating

normally.
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Interpreting Fibre Port

Link LEDs

Table 12 Explanation of Fibre
Drive Sled Link LED States

A fibre port link LED shows the state of the Fibre Channel link and
whether the link is ready to transmit commands.

Drive Sled Fibre Channel Link LED

The Fibre Channel link LED for a drive sled is located on the rear of the
drive sled. Figure 24 on page 95 shows the location of the Fibre Channel
link LED on the rear of the UDS-2 drive sled, and Figure 25 on page 96
shows the location of the Fibre Channel link LED on the rear of the UDS-
3 drive sled.

Table 12 describes how to interpret the Fibre Channel link LED activity
that you might see on the rear of the UDS-2 drive sled. Table 13 on
page 99 on page 135 describes the Fibre Channel link LED activity on
the rear of the UDS-3 drive sled.

(UDS-2)
LED Color | Represents State and Explanation
Green LIP and ¢ Solid on — loop initialization protocol (LIP) has occurred.
activity * Blinks at irregular intervals — host command/data activity is
occurring.
Amber Online and * Solid on — the library has enabled the drive data bus; it can detect
light light through a fiber optic cable.
detected
No color * Solid off — the drive brick is varied off or the drive cannot detect
light through a fiber optic cable (equivalent to no fibre cable plugged
in). If the drive brick is varied off, the blue status LED will be solid on.
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(UDS-3)
LED Color | Represents State and Explanation
Green LIP and * Solid on — loop initialization protocol (LIP) has occurred.
activity * Blinks at irregular intervals — host command/data activity is
occurring.
Amber Online and * Solid on — the library has enabled the drive data bus; it can detect
light light through a fiber optic cable.
detected * Blinks at regular intervals — the library has enabled the drive data
bus, but light is not detected through the fiber optic cable.
No color * Solid off — the library has not enabled the drive data bus or the drive

brick is varied off. If the drive brick is varied off, the blue status LED
will be solid on.

Note: A UDS-2 drive with no fiber optic cable plugged in is healthy if
the link LED is solid off. A UDS-3 drive with no fiber optic cable
plugged in is healthy if the LED is amber and blinking at regular
intervals, indicating that the library has enabled the drive data
bus, but no light is detected.

FC I/O Blade Fibre Port Link LED

The link LED for an FC I/O blade fibre port is located next to the port. On
the 1/0 blade faceplate, black lines indicate how each link LED belongs

to a port. Figure 26 shows the locations of the I/O blade Fibre port link
LEDs.
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Figure 26 Locations - Colors of
I/O Blade Fibre Port Link LEDs

I/O blade link LEDs
- left = green (belongs
to port below)
- right = green (belongs
to port above)

Table 14 on page 100 describes how to interpret the link LED activity
that you might see. There is one supported model of FC I/O blade: 7404.
LED behavior varies based on which model is installed in the library.

Table 14 FC /O Blade Link LED

States
FC I/O Blade
Model Possible Green LED States and Explanations
7404 * Solid on — the FC I/O blade has established a link but is not currently
4 gigabit/sec transporting data.
* Blinks — the link is active and is currently transporting data.
* Solid off — the FC I/O blade has not established a link OR the link is active and is
currently transporting a large amount of data.
Note: For the 7404 FC I/O blade, fibre port LEDs are off while the
blade is booting up.
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Interpreting Ethernet The status LEDs for an Ethernet Expansion blade are located at the top
Expansion Blade LEDs of the EEB above ETH 6. Figure 27 shows the locations of the EEB status
LEDs.

Figure 27 Location of Ethernet

Expansion Blade Status LEDs | B
EEB status LEDs/ ﬁ/

——=

T

Ethernet —

Port status LEDs E@

-

Table 15 Ethernet Expansion
Blade LED States

Blue Green Amber Description
Off Off Off No power
1 Hz Off Off Powered Down - Ready for removal
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Blue Green Amber Description

Off Off On Booting

Flash 1 Hz Off Normal

Flash 10 Hz Off Normal - Identify

Table 16 Ethernet Expansion

Blade Ethernet Port LED States

LED Color

Possible States and Explanations

Green

* Solid on — the link is up; data can be sent or received through the Ethernet port
* Solid off — the link is not up; data cannot be sent or received through the Ethernet

port

Amber

* Flashes at irregular intervals — data activity is occurring through the Ethernet port
* Solid off — no data activity is occurring through the Ethernet port

Interpreting MCB Port

LEDs

102

The MCB has LEDs for the Ethernet, Fibre Channel, and SCSI ports.

MCB Ethernet Port LEDs

The LEDs on the MCB Ethernet port indicate status and activity.
Figure 28 shows the locations and colors of the MCB Ethernet port LEDs.
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Figure 28 Locations - Colors of
MCB Ethernet Port LEDs

MCB Ethernet
port LEDs

- top = green
- bottom = amber

Table 17 describes how to interpret the Ethernet port LED activity that
you might see.

Table 17 Explanations of MCB
Ethernet Port LED States

LED Color Possible States and Explanations
Green * Solid on — the link is up; data can be sent or received through the Ethernet port
* Solid off — the link is not up; data cannot be sent or received through the Ethernet
port
Amber .

Flashes at irregular intervals — data activity is occurring through the Ethernet port
Solid off — no data activity is occurring through the Ethernet port
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Figure 29 Locations - Colors
MCB FC/ SCSI Port LEDs

Interpreting LBX
Terminator LEDs

104

MCB Fibre Channel and SCSI Port LEDs

The LEDs for the MCB Fibre Channel and SCSI ports are for future use.

Ignore LED behaviors that might appear. Figure 29 shows the locations
and colors of the LEDs.

{U} MCB port LEDs

- left = green (belongs to

q SCSiI port below)

| - right = green (belongs

: to FC port above)

The LBX terminator has three versions. Version 01 has four LEDs and
Versions 03 and 2.0 have six LEDs. For more information, see the Scal/ar
2000/i6000 Maintenance Guide.

LBX Terminator Version 01 LEDs

The LBX terminator has four green LEDs that indicate the presence of
modules in the library. Figure 30 on page 105 shows the locations of the
LEDs. Table 18 on page 105 describes how to interpret LED activity on
the LBX terminator.

The terminator must be located in the LBX of the last expansion module.
The LED status should reflect the physical installed module count of the
system.
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Terminator LEDs (Version 01)

Table 18 Explanations of LBX
Terminator LED States (Version

01)
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o ]

OO0

000000000
000000000

LED On/Off Combinations

1 2 3 4 Explanation
Ooff Off Off Off Robotics are disabled, the access door is open, or the LBX
terminator is misaligned.
On Off Off Off The library has one control module and no expansion modules.
On On Off Off The library has one control module and one expansion module.
On On On Off The library has one control module and two expansion modules.
On On On On The library has one control module and three expansion modules.
On Off On On The library has one control module and four expansion modules.
On On Off On The library has one control module and five expansion modules.
On Off On Off The library has one control module and six expansion modules.
On Off Off On The library has one control module and seven expansion modules.
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LBX Terminator Version 03 LEDs

The LBX terminator has six green LEDs that indicate the presence of
modules in the library. Figure 31 shows the locations of the LEDs.

Table 19 on page 106 describes how to interpret LED activity on the LBX
terminator.

Figure 31 Locations of LBX
Terminator LEDs (Version 03)

ORI

R4 LOICTICTIETICTY

Table 19 Explanations of LBX
Terminator LED States (Version
03)

LED On/Off Combinations

1 2 3 4 5 6 Explanation

Off | Off | Off | Off | Off | Off | Robotics are disabled, the access door is open, or the LBX
terminator is misaligned.

On | Off | Off | Off | Off | Off | The library has one control module and no expansion modules.

On | Off | Off | On | Off | Off | The library has one control module and one expansion module.

On | Off | Off | On | On | Off | The library has one control module and two expansion modules.

On | Off | Off | On | On | On | The library has one control module and three expansion modules.

On | Off | Off | Off | On | On | The library has one control module and four expansion modules.
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LED On/Off Combinations

1 2 3 4 5 6 Explanation

On | Off | Off | On | Off | On | The library has one control module and five expansion modules.

On | Off | Off | Off | On | Off | The library has one control module and six expansion modules.

On | Off | Off | Off | Off | On | The library has one control module and seven expansion modules.

On | On | Off | Off | Off | Off | The library has one control module and eight expansion modules.

On | On | Off | On | Off | Off | The library has one control module and nine expansion modules.

On | On | Off | On | On | Off | The library has one control module and ten expansion modules.

On | On | Off | On | On | On | The library has one control module and eleven expansion
modules.

On | On | Off | Off | On | On | The library has one control module and twelve expansion
modules.

On | On | Off | On | Off | On | The library has one control module and thirteen expansion
modules.

On | On | Off | Off | On | Off | The library has one control module and fourteen expansion
modules.

On | On | Off | Off | Off | On | The library has one control module and fifteen expansion

modules.

LBX Terminator Version 2 LEDs

The LBX terminator has six blue LEDs that indicate the presence of
modules in the library. Figure 32 shows the locations of the LEDs.

Table 20 on page 108 describes how to interpret LED activity on the LBX
terminator.
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Figure 32 Locations of LBX
Terminator LEDs (Version 2)

Table 20 Explanation of LBX
Terminator LED States

(Version 2)

Blue SMT LEDs
All Positions

LED On/Off Combinations

1 2 3 4 5 6 Explanation
Off | Off | Off | Off | Off | Off | Robotics are disabled, the access door is open, or the LBX
terminator is misaligned.
On | Off | Off | Off | Off | Off | The library has one control module and no expansion modules.
On | Off | Off | On | Off | Off | The library has one control module and one expansion module.
On | Off | Off | On | On | Off | The library has one control module and two expansion modules.
On | Off | Off | On | On | On | The library has one control module and three expansion modules.
On | Off | Off | Off | On | On | The library has one control module and four expansion modules.
On | Off | Off | On | Off | On | The library has one control module and five expansion modules.
On | Off | Off | Off | On | Off | The library has one control module and six expansion modules.
On | Off | Off | Off | Off | On | The library has one control module and seven expansion modules.
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LED On/Off Combinations

1 2 3 4 5 6 Explanation

On | On | Off | Off | Off | Off | The library has one control module and eight expansion modules.

On | On | Off | On | Off | Off | The library has one control module and nine expansion modules.

On | On | Off | On | On | Off | The library has one control module and ten expansion modules.

On | On | Off | On | On | On | The library has one control module and eleven expansion
modules.

On | On | Off | Off | On | On | The library has one control module and twelve expansion
modules.

On | On | Off | On | Off | On | The library has one control module and thirteen expansion
modules.

On | On | Off | Off | On | Off | The library has one control module and fourteen expansion
modules.

On | On | Off | Off | Off | On | The library has one control module and fifteen expansion

modules.

Interpreting Power
Supply LEDs

Power supply problems are reported in tickets. To physically identify a
power supply, note the power supply number and module number in
the ticket details. Modules can have up to two power supplies each. The
top supply is #1 and the bottom supply is #2.

Figure 33 shows the locations and colors of the AC power supply LEDs.
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Figure 33 Locations and Colors
of Power Supply LEDs

power supply LEDs
- top (AC OK) = green

- middle (DC OK) = green
- bottom (FAULT) = bluy

Table 21 Explanation of Power

Supply LED States

Table 21 describes how to interpret LED activity that you might see.

LED Color Represents | Possible States and Explanations
Green AC OK * Solid on — power supply’s AC input is above minimum requirements
(top LED) to operate
* Solid off — power supply’s AC input is below minimum

requirements to operate
Green DC OK * Solid on — power supply’s output voltage is within specifications
(middle LED) * Solid off — power supply’s output voltage is outside of

specifications
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LED Color Represents | Possible States and Explanations
Blue Fault * Solid on — indicates any of the following conditions:
I(_IEI)ECI)Dt)tom * Power supply output is outside of specifications

e Current limit has been exceeded
e Temperature limit has been exceeded

* Fan failed while AC input is present and above minimum operating
voltage

e ACinput is below minimum operating voltage

* PDU is on, but the Power button on the library’s indicator panel is
off

¢ Solid off — no faults are detected

Interpreting Gen 2
Robot Status LEDs

The Gen 2 robot has six status LEDs on the front plate of the picker on
the robot itself (see Figure 34). These LEDs are described in Table 22.

If there are no problems with the robot, the LEDs should display as
follows:

* If this is a left-side robot, the Left Position LED should be ON
* If this is a right-side robot, the Right Position LED should be ON

* The Sensors Engaged, Robot Power, and Robot Rail Engaged LEDs
should all be ON

* The Sensors Disengaged LED should be OFF

If any of the LEDs are incorrectly illuminated, Quantum Support will
need to troubleshoot, adjust, and possibly replace components to make
sure all LEDs are correctly illuminated. Table 22 describes what the LEDs
mean and how to troubleshoot them.
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Figure 34 Robot Status LEDs
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Table 22 Robot Status LEDs
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LED

When ON, indicates the following

Right Position

Indicates this is a right-side robot.

Sensors Engaged

The Lock/Unlock handle is in the fully Locked
position, and the home/parking sensors are
positioned correctly for robot operations. It is
safe to use the robot for library operations.

Robot Power

Robot control power is ON.

Power Rail Engaged

Connection to power rail is OK

Left Position

Indicates this is a left-side robot.

Sensors Disengaged

The robot’s X-axis home/parking sensors are
disengaged. The robot locking lever is fully
unlocked. It is safe to remove the robot from
the library.

Quantum Scalar i6000 User’s Guide



Interpreting HDEM
Tower Enable Button
Blinking Pattern

Figure 35 HDEM Operator
Panel with Tower Enable
Button

Table 23 HDEM Status LEDs
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The high-density expansion module (HDEM) operator panel contains a
button that allows users to vary on and off the tower (see Figure 35 on
page 113). The tower enable button has two colors: Amber (varied off)
and green (varied on). Table 23 on page 113 describes what the blinking
pattern mean and how to troubleshoot them.

Indicater
Light

Enable/Disable
Button

Lighting Pattern

Description

OFF, solid Tower is not functioning properly or
powered off completely
GREEN, solid Tower is fully active, varied on and online

BLINKING GREEN
(1 sec on, 1 sec off)

Tower is initializing/activating to an online
or offline, varied on state
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Lighting Pattern

Description

AMBER, solid

Tower is varied off, online or offline. Vary off
status trumps online/offline status display.

Note: It does not matter if the tower is
offline or offline if it is varied off or
being varied off.

BLINKING GREEN
(3 sec ON, 1 sec OFF

Tower is varied on and Ul takes the tower
offline

BLINKING AMBER
(10 HZ frequency)

Tower door is opened while tower is still
varied on, or is currently in performing a
vary-on or vary-off operation before
completing the state transition, regardless
of being logically online or offline, hereby
interrupting tower motor control.

BLINKING (3 secs
AMBER, 1 sec GREEN)

Aisle door opened while tower is varied on,
regardless of being logically online or
offline, hereby interrupting tower motor
control.

Note: If the tower was varied off before
the aisle power was interrupted, the
tower continues to display the vary
off blink pattern.

10 Hz blinking pattern

Tower identification initiated

Working With Command History Logs
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The Command History Log dialog box enables you to view command
and response activity that has occurred with externally addressable
library devices, including the LMC, controller LUNs, partitions, and
drives. This information can help you isolate the source of an issue, such
as a library device or host application.
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Note: The number of selected drives affects the performance of the
Command History Log.To ensure proper operations, limit drive
log requests to twenty-five.

Viewing Command 1 Log on as an administrator.

History Logs 2 You can perform this procedure while viewing either the physical

library or a partition. From the View menu, click the name of the
physical library or the appropriate partition.

3 Click Tools > Command History Log. The Command History Log
dialog box appears.

The first example dialog box that follows represents the physical
view, and the second one represents a partition view. These
examples show expanded levels for “Controller LUNs", “Partitions”,
and “Tape Drives”. Initially, these areas are not expanded. Click the
highest-level items to show next-level items.

i Command History Log il

rLog Filter

[ Lh -

@ Controller LUNS

[ mce

10 Blade-1,1,1,1, 4

[J10 Blade-1,1,1,1, 6
G Parttitions

[ 5M203100175_LL0_Lagical Library 01
§ Tape Drives

[ 5M1110063753

] SM1110050883

I sM1110051870

[ 5M1110050845 1

[ 5M1110050639

[ ordd4nnenssd

Cancel | | Help
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'Command History Log 1[

rLog Filter

[Z] 5M203100175_LLO_Logical Likirary 01
@ Tape Drives
] 5MES11156035

| Cancel | | Help |

If logical serial number addressing is enabled on the Physical
Library dialog box (Setup > System Settings > Physical Library),
tape drives are listed according to their logical serial numbers. If
logical serial number addressing is disabled, the drives are listed
according to their physical serial numbers.

Also notice that command history logs for the LMC and the
controller LUNs are available only from the physical view.

Note: The library is a multi-LUN device. To meet SCSI standards, a
LUN O is allocated as a controller LUN on each blade,
including the MCB and the I/O blades. The command
history log for a controller LUN includes commands
intended for the blade, not a specific logical unit connected
to the blade.

4 To access the command history logs (for LMC, controller LUNSs,
partitions, or tape drives), select one or more device check boxes,
and then click OK. A list of log files appears in the Command
History Log dialog box.
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Towview a log, select a log name and click "Opean®.
To retrieve logls), click"Send".
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amcCommandHistory log
mechCommandHistorylog
1000003CommandHistory.log
1000006CommandHistory.log

100001 DCommandHistory.log

| Open | | Send | | Cancel | | Help |

From this log-list view of the Command History Log dialog box,

you can perform the following tasks:

* Display the contents of a log by clicking the Open button

(proceed to the next step)

* Mail or save a log by clicking the Send button (see Mailing and
Saving Logs on page 118)

5 Click a log file to highlight it, and then click Open. The contents of

the log file appear.

amcCommandHistory.log

2004-10-22 16:21:33,638 INFO serice@dn-rmarshall

2004-10-22 15:21:12,285 INFO servicei@dn-rmarshall -
2004-10-22 16:21:12,292 IMFO service@dn-rmarshall -
2004-10-22 15:21:18,955 INFO senice@dn-rmarshall -
2004-10-22 14:21:18,963 INFO serice@dn-rmarshall -
2004-10-22 15:21:27,750 INFO servicei@dn-rmarshall -
2004-10-22 15:21:27,758 IMFO servicei@dn-rmarshall -
- Physical - Tickets, closing ticket Started - ticket: 16
2004-10-22 15:21:33,648 INFO senice@dn-rmarshall -
2004-10-2214:21:42141 INFO service@dn-rmarshall -
2004-10-22 15:21:42,287 INFO service@dn-rmarshall -
2004-10-22 16:03:42,655 IMFO serice@DVT21 - Physical - Change Mode, Shutdown Started
2004-10-22 16:03:50,446 IMFO serice@DVT21 - Physical - Change Mode, Shutdown QO
2004-10-25 07:47:05,043 INFO service@DVT21 - Physical - Tickets, closing ticket Started - ticket: 29
2004-10-25 07:47:05,085 INFO serice@DVT21 - Physical - Tickets, closing ticket OK

2004-10-25 08:48:10,323 INFO service@DVT21 - Physical - Tickets, closing ticket Started - ticket: 23
2004-10-25 08:48:10,329 IMFO service@DVT21 - Physical - Tickets, closing ticket OK

2004-10-25 08:48:09,023 IMFO service@DVT21 - Physical - Tickets, closing ticket Started - ticket: 21
2004-10-25 08:45:09,034 IMFO service@DVT21 - Physical - Tickets, closing ticket Ok

Fhysical - Tickets, closing ticket Started - ticket: 12
Fhysical - Tickets, closing ticket Qi
Physical - Tickets, closing ticket Started - ticket: 13
Physical - Tickets, closing ticket OK
FPhysical - Tickets, closing ticket Started - ticket: 15
Physical - Tickets, closing ticket 0K

Fhysical - Tickets, closing ticket 0K
Physical - Tickets, closing ticket Started - ticket: 14
Fhysical - Tickets, closing ticket QK

IDIE3

[«

117



Chapter 2: Troubleshooting Your Library
Working With Command History Logs

Mailing and Saving
Logs

118

The Send button on the log-list view of the Command History Log
dialog box enables you to send logs to e-mail addresses. If you are
accessing the LMC from a remote client, Send also enables you to save
the information to a file.

Note: You can mail or save logs from a remote client. However, you
cannot save logs from the library’s touch screen.

Note: Before you perform the following procedure, you must make
sure that e-mail is appropriately configured in the LMC so that
the library can send logs to the recipient. For more information
about configuring e-mail, see Configuring E-mail on page 185.

- = = ~
B Email, Save or Print Table Ié]

1 From the log-list view of the Command History Log dialog box,
click a log file to highlight it, and then click Send. The Email, Save
or Print Table dialog box appears.

Comment:

@ |Save | [ Browse...

[ OK ]L Cancel ]L Help ]

2 Perform one of the following tasks:

* To indicate that you want to send the log as an e-mail message
to a recipient, select Email, and then either type an e-mail
address in the Email text box or select an existing address from
the drop-down list. You can type a comment in the Comment
text box to send with the log.

* To indicate that you want to save the log, select Save, and then
either type in the Save text box a path and a file name to which
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you want the information saved or click Browse to specify a
location and a file name.

Note: The Save option is available to remote client users only.
It appears grayed out on the touch screen.

3 To send, click OK.
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Accessing Online Help

For further help, you can access the library’s Online Help system.
* To access the entire Online Help system, click Help > Content.

* To access context-sensitive help, click the Help button on any dialog
box.
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You can use either the local or remote versions of the Library
Management Console (LMC) to modify your library’s configuration. The
Setup menu includes most of the configuration commands.

This chapter consists of the following sections:

Running the Setup Wizard on page 122

Enabling Licenses on page 123

Working With Partitions on page 126

* Understanding Partition Media Policy Settings on page 129

* Creating Partitions on page 132

* Modifying Partitions on page 145

* Deleting Partitions on page 153

Configuring Control Paths on page 154

Setting Up the Network Configuration on page 160

Managing Connectivity on page 171

Setting Up Policies for the Physical Library on page 178

Specifying the Date and Time on page 183

Configuring E-mail on page 185

Setting Up E-mail Notifications on page 188
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Setting Up Media Security Notifications on page 194

Configuring Devices on page 196

Configuring Drive Cleaning on page 225

Registering SNMP Traps on page 231

Configuring Library Security on page 233

Using LDAP on page 239

Configuring Screen Saver Preferences on page 246

Working With Data Path Conditioning on page 248

About the Configuration Record on page 250

Setting Aisle Lights on page 251

Configuring a Webcam For Your Library on page 252

Working with Towers on page 253

For a brief overview of the LMC, see Library Management Console (LMC)
on page 440.

If you are configuring your library for the first time, see the Scalar i6000
Installation Guide for information about performing an initial library
configuration.

Note: Only one administrator can be logged on and performing

library configuration at any one time. If another administrator
attempts to log on, a message appears, warning that only one
administrator at a time is permitted on the library. If a service
user logs on while an administrator or regular users are logged
on already, the library automatically logs off those users.

Running the Setup Wizard

122

Use the Setup Wizard command to initially configure important
settings on a library as part of the normal installation procedure. Before
you can manage your library from a remote LMC client, you must
initially configure the library from its touch screen by either running the
Setup Wizard command or using individual configuration commands
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from the Setup menu. For detailed information about initially
configuring the library, see the Scalar /6000 Installation Guide.

Caution: Use the Setup Wizard only once to initially configure the
library.

Before you run the Setup Wizard, do the following:

* Note the name and IP address of your network Domain Name Server
(DNS) or the IP address, subnet mask, and default gateway for your
network segment.

* Verify that your network is attached to the library network
connection.

* Delete the default partition. Refer to Deleting Partitions on
page 153 for more information.

To access the setup wizard, log on as an administrator from the library’s
touch screen, make sure that you are viewing the physical library, and
then click Setup > Setup Wizard.

|
Enabling Licenses

In addition to the standard features, the following licensable features
are available:

For more information about this
License/Feature feature, see...
Active Vault Chapter 4, Active Vault.
Advanced Reporting Chapter 5, Advanced Reporting
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For more information about this
License/Feature feature, see...

Automated Media Pool (AMP) / | The Partition license allows you to
Partition license create from 2 to 16 partitions, and
gives you access to the Automated
Media Pool features. See

Chapter 6, Automated Media Pool.

Capacity on Demand (COD) Chapter 7, Capacity on Demand

Encryption Key Management Chapter 8, Encryption Key
Management.

Extended Data Lifecycle Chapter 9, Extended Data Lifecycle

Management (EDLM) Management.

Partition Utilization Chapter 12, Partition Utilization
Reporting

Storage Networking (SNW) Chapter 10, Path Failover

The following situations require you to enable license keys:

* During initial installation and configuration of the library. For more
information about enabling licenses for the first time, see the Scalar
16000 Installation Guide

* During a feature upgrade

* When you need to activate additional storage slots in your current
COD configuration

If you cannot locate the license keys shipped with the library, you can
obtain them by contacting technical support or, if you are an end user,
by contacting your inside sales representative.

Note: Authorized service personnel are involved in the first two
situations. However, any administrator can activate additional
storage slots.

1 Log on as an administrator.

2 If you are not already working from the physical library, select it
from the View menu.
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3 From the menu bar, click Setup > Licenses. The Licenses dialog box
appears.

« Licenses El

The following features are available farthe library.
Enterthe license key to enable the features.
Mote: The license key is not case sensitive.

Name | Status | Expiration | Quantity |
Active Vault Enabled |Permanent |1 License
Advanced Reporting Enabled |Permanent |1 License
Capacity On Demand Enabled |Permanent [65000 Slots
Encryption Key Management Enabled |Permanent |96 Drives
Extended Data Lifecycle Management |[Enabled |Permanent |1 License
Partition Enabled |Permanent |16 Partitions
Partition Utilization Enabled |Permanent |1 License
Storage Networking Enabled |Permanent |96 Drives

Enter License Key:l

[ ok ] [ ceancel | [ Hep |

This dialog box lists the licensed features for your library, including
their status, expiration date, and quantity. The following guidelines
apply to the Quantity column:

* Capacity on Demand displays the number of licensed slots.

* Encryption Key Management and Storage Networking
display the number of licensed drives.

* Partition quantity displays the number of licensed partitions.

* Extended Data Lifecycle Management and Advanced
Reporting quantity is always set to 1.

* For features that are not licensed by quantity but instead apply
to the entire library, such as the drive monitoring feature, the
Quantity is always set to 1.

4 In the Enter License Key text box, type the appropriate license key.
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Note: License keys are not case-sensitive, so if you are using the
library’s touch screen, enter the library key from the
lowercase keyboard, which gives you access to the dash (-)
character.

If you cannot locate the license keys shipped with the
library, you can obtain them by contacting technical
support (see Contacts on page xiii) or, if you are an end
user, by contacting your inside sales representative.

5 Click OK.

6 If you have upgraded the library’s storage capacity, the extra
storage slots you just added are not assigned to a partition. You can
either create a new partition to include them or manually modify an
existing partition to include them by using expert partitioning
mode.

Caution: Consult your service representative and see the
Scalar i6000 Planning Guide before you reconfigure
your partitions.

For more information, see Working With Partitions on page 126.

Working With Partitions

126

A partition is an abstraction of a single underlying physical library that
presents the appearance of multiple, separate libraries for purposes of
file management, access by multiple users, or dedication to one or more
host applications. For example, you can choose to run one software
application in one partition, and a different software application in a
second partition.

There are two types of partitions in the Scalar i6000 library:

* Standard partitions — Standard partitions are visible to hosts and
are used for normal backup operations. You can create standard
partitions via the setup wizard or manually using simple or expert
mode.
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Library managed partitions — Library managed partitions (LMPs)
are similar to other partitions, except they are not visible to backup
applications or hosts. The library manages the LMP, rather than the
backup application. The library uses the LMP to facilitate the
following value-added features, each of which requires its own
license:

* Active Vault on page 257
* Automated Media Pool on page 271

* Extended Data Lifecycle Management on page 325

You can create library managed partitions via the setup wizard or
manually using expert mode.

Each partition contains the following components of the physical
library:

Accessor — the robotic assembly that moves media within the
library. The accessor includes the picker and reach assemblies.

I/E station magazine — a magazine, consisting of slots for
cartridges, that enables media to be moved into or removed from
the physical library.

Note: Partitions do not require I/E station slots, but if you do not
assign any, you will need to bulk load/unload cartridges in
the partition, which requires taking the entire library
offline. I/E stations allow you to import and export
cartridges to and from a partition without taking the
library offline.

Storage magazine — a static column location within a section of the
physical library rack that holds removable media. For more about
location coordinates, see Understanding Location Coordinates on
page 457.

Drive — the read/write device for removable media.

Note: Partitions can be created that have zero (0) drives
allocated.

Note: Active Vault and Automated Media Pool (AMP) library
managed partitions do not contain drives.
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For more information about the library’s physical components, see the
Scalar i2000/i6000 Maintenance Guide. For help with planning before
you configure your system, see the Scalar i6000 Planning Guide.

A standard partition consists, at a minimum, of one storage magazine
and one drive. Neither the storage magazine nor the drive can be shared
with another partition.

Note: Active Vault and AMP partitions do not contain drives; they
must contain at least one storage magazine.

One 24-slot I/E station can be used by up to four partitions. One 72-slot
I/E station can be used by up to twelve partitions. The maximum
number of I/E station slots per partition is 240. The maximum number of
partitions is determined by the lesser of the number of drives available
in the physical library (assuming there are at least as many storage slots)
or 16.

Note: The library is licensed for either one partition or the maximum
number of partitions, which is 16. For more information about
partition licensing, see Enabling Licenses on page 123.

Gen 1 libraries support multiple drive and media domains. However,
drive and media domains cannot be mixed within a partition. Each Gen
1 partition can contain only one drive and media domain. Within that
domain, a partition can contain multiple drive interface types (FC and
SCSI) as well as multiple media types (for example, LTO-3, LTO-4, LTO-5,
and LTO-6).

Gen 2 libraries only support LTO drives and media. A single partition can
contain multiple drive interface types (FC and SCSI) as well as multiple
media types (for example, LTO-3, LTO-4, LTO-5, and LTO-6).

Configuration controls, such as FC Host and SNW (Storage Networking)
Host Access provide the means to permit host access to particular
partitions and tape drives. Multiple hosts can share a single partition, or
a partition can be restricted to one exclusive host. Host applications
control access to elements within the shared partition. Each application
can have a partition assigned to it. Each application uses its partition as
if it were a dedicated physical library.

Note: For information about creating library-managed encryption on
partitions, see Chapter 8, Encryption Key Management.
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A partition’s Media Type Checking, Media Checking Policy, and
Return Media Identifier settings help determine how the library
handles differing media types within the same library. You can configure
media policy settings when you manually create or modify a partition.

The key concepts regarding partition media policies are the media
domain, media type, media ID checking, and media identifier.

Media Domain

Gen 2 libraries only support the LTO media domain.

Media Type

The media type is a particular generation of tape technology. Several
media types can exist within one media domain. For example, within the
LTO media domain is the LTO-1 media type, the LTO-2 media type, and
so forth. A media type has an identifier, chosen by the tape
manufacturer or consortium, that enables users and libraries to
distinguish between them. The LTO consortium uses L1, L2, L3, L4, L5,
L6 and L7 to identify the LTO-1, LTO-2, LTO-3, LTO-4, LTO-5, LTO-6 and
LTO-7 media types in a volume serial number.

A single partition can contain a mixture of media types and interface
types within the same domain (for example, LTO-1 and LTO-2 with SCSI
or Fibre Channel interfaces).

To create or modify a partition with mixed media types, you must use
Expert mode (select Expert mode on the Partitions Wizard dialog box).
You cannot create or modify partitions with mixed media while in
Automatic mode or Simple mode.

Media ID Checking

Media ID checking policy restricts the movement of tape cartridges
based on the media ID on the barcode label. This policy also helps you
monitor the management of tapes and drives by the host applications.
When you create or modify a partition, you can enable or disable the
Media Type Checking option. If you choose to enable media type
checking, you also can use the Media Checking Policy option to select
from two modes of operation: Required or Not Required. With either
mode, the library checks whether a cartridge has a valid media ID on the
barcode label.
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Table 24 Sampling of Media
Type Identifiers
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In Required mode, if the library does not find a valid media ID on a
cartridge, the library does not allow it to be moved into or within the
library. If the library finds a valid media ID, the library allows it to be
moved from an I/E station into a partition that contains magazines
matching the media domain of the cartridge, but the library does not
allow the cartridge to be moved from storage to an incompatible drive
type (for example, an LTO-2 cartridge will not be allowed to move to an
LTO-1 drive).

In Not Required mode, if the library does not find a valid media ID on a
cartridge, the library allows it to be moved into or within the library as
long as the I/E station magazine, storage magazine, or drive matches
the media domain of the cartridge. If the library finds a valid media ID,
the library does not allow the cartridge to be moved from storage to a
drive that does not have a compatible type (for example, an LTO-2
cartridge will not be allowed to move to an LTO-1 drive).

Return Media Identifier

For the media policy settings, the library makes assumptions about a
media identifier and its position in a media barcode label. To be
considered a media identifier, the identifier characters must be correct
for the media domain and media type. Also, the identifier, which for
some media types can consist of more than one character, must be
complete and in the correct location. The correct characters in the
wrong position are not viewed as a media type identifier. In a physical
library or partition containing mixed media, the media identifier is not
required for all cartridges.

Table 24 explains the media type identifiers and assumptions.

Media Domain Media Type Identifier

LTO LTO-1 “L1" as the last characters in
the barcode

LTO LTO-2 "L2" as the last characters in
the barcode

LTO LTO-3 “L3" as the last two
characters in the barcode
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Media Domain Media Type Identifier

LTO LTO-3 WORM “LT" as the last two
characters in the barcode

LTO LTO-4 "L4" as the last two
characters in the barcode

LTO LTO-4 WORM "LU" as the last two
characters in the barcode

LTO LTO-5 “L5" as the last two
characters in the barcode

LTO LTO-5 WORM "LV" as the last two
characters in the barcode

LTO LTO-6 “L6" as the last two
characters in the barcode

LTO LTO-6 WORM "LW" as the last two
characters in the barcode

LTO LTO-7 "L7" as the last two
characters in the barcode

LTO LTO-7 WORM "LX" as the last two
characters in the barcode

With a valid media type identifier present and the Media Type
Checking setting enabled, which is the case by default, a host is
prevented from executing invalid media moves across differing media
types. For example, a host can be prevented from moving LTO-2 media
to an LTO-1 drive. If an invalid move is attempted, the library returns an
error to the host.

Regardless of whether or not partition media policies are enabled or
disabled, the library always prevents host move-media commands that
cross different media domains.

With the Return Media Identifier setting, you can control if and where
a media type identifier appears in the volume serial number that is
returned to the host.

Table 25 shows an example of how the return media identifier is
reported to the host, depending on the setting you choose: Disabled,

Quantum Scalar i6000 User’s Guide 131



Chapter 3: Configuring Your Library

Working With Partitions

Table 25 Return Media
Identifier Behavior Example

Creating Partitions
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Prefix, Suffix, and Pass Through. The bold, underlined portion is the
media identifier.

. Volume Serial Number Returned to
Setting .
Host
Disabled ABC123
Prefix L1ABC123
Suffix ABC123L1
Pass Through ABC123L1

*Based on actual LTO-1 barcode: ABC123L1

For more information about configuring the Media Type Checking and
Return Media Identifier settings, see Creating Partitions Manually on
page 134.

You can create library partitions in three ways:

» Creating Partitions Automatically on page 133

* Creating Partitions Manually on page 134, using one of the
following modes:

* Using Simple Mode on page 134

* Using Expert Mode on page 139

The method you should choose depends on the circumstance and the
level of control you want in allocating resources to the partition. When
creating partitions Automatically, the library assigns available system
resources to create the number of partitions you specify. Automatic
mode is not available if a partition already exists. Creating partitions
Manually enables you to pick specific drives, storage magazines, and
magazines within an I/E station to assign to a partition.

Note: Make sure that you have adequately planned for the number of
partitions that you want to configure.
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Creating Partitions Automatically

You can use the library’s Automatic mode to create partitions within
limits based on licensing restrictions and available resources. Automatic
mode is available on/y if no partitions currently exist.

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Partitions > Configure. The Partitions dialog box
appears.

p
B Partitions p— lér

The table below contains a list of all partitions currently configured within the library. Please choose one of
the following actions:

@ Create - Creates s new partition
@ Modify - Modifies an existing partition (select partition)
@ Delete - Deletes an existing partition (select partition)

Name Drive Type Status
Test1 LTO4: FC Online
Test2 N/A Online
Test3 N/A Online

[ Create ][ J[ ][ Close ]l Help ]

— >

4 Click Create. The Partitions — Step 1: Choose Creation Mode
dialog box appears.

5 Select Automatic, and then click Next. The Partitions — Step 2:
Automatic Creation dialog box appears.
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6 In the Partitions column, type the number of partitions you want to
create for each media/drive type.

The maximum number of partitions that you can create is
determined by the number of partitions you are licensed to create
and the number of drives available. See Enabling Licenses on
page 123.

7 Click Finish. The Partitions dialog box appears again.
8 Click Close.

Creating Partitions Manually

If one or more partitions already exist in the library, you must manually
create a new partition to allocate drives, storage slots, and I/E station
magazines. You have two options to allocate system resources when
manually creating a new partition:

¢ Using Simple Mode

e Using Expert Mode

In Simple mode, you can specify the quantity of each element you want
assigned to the partition. In Expert mode, you can indicate which
specific drives, storage magazines, I/E station magazines, or if enabled,
extended I/E station magazines to assign to the partition. You can also
configure library managed partitions in Expert mode.

Using Simple Mode

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Partitions > Configure. The Partitions dialog box
appears, listing partitions that are currently configured within the
library.

Note: If you want to cancel the partition creation process, click
Close. The Close button becomes unavailable after you
click Create later in this procedure.

4 Click Create. The Partitions - Step 1: Choose Creation Mode
dialog box appears.
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5 Select Simple, and then click Next. The Partitions - Step 2: Choose
Partition Properties dialog box appears.

=)

-
B Partitions - Step 2: Choose Partition Properties

—
Create Partition
Start the wizard by entering the name of the partition.
Name: | |
Drive Domain: | LTOS: FC |
Vendor ID: | QUANTUM |
ProductID: | Scalar 6000 |
[ < Back J[ Next = ][ ][ Cancel J[ Help ]

— J

6 Configure the following settings:

* In the Name text box, type a name that describes the new
partition.

* In the Drive Domain list, select the type of drive to be used in
the partition.

* From the Vendor ID list, select the vendor.

The Vendor ID information is used in the SCSI Inquiry
command. The choices are QUANTUM and ADIC. The default is
QUANTUM. Some backup applications may only support or be
configured for ADIC libraries, so if you configure a logical library
using the vendor ID of QUANTUM, the backup application
would not work with the library.
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* From the Product ID drop-down list, click the appropriate
product type.

The Product ID setting controls the product ID string that is
returned in a standard SCSI INQUIRY response. The library can
report that it is a Scalar i500,Scalar i2000, or Scalar i6000. This
feature can enable the library to be used with host applications
that do not yet include the Scalar i6000 in a list of recognized
devices. In addition, the various Microsoft Windows operating
systems maintain a list of recognized devices. If the Scalar i6000
is not in an operating system’s list of recognized devices, the
library will appear as an “unknown” device in device lists. You
might prevent the library from being listed as “unknown” by
setting Product ID to a library other than Scalar i6000. This
setting does not cause any library operational changes other
than the SCSI INQUIRY response.

7 To continue, click Next. The Partitions - Step 3: Choose Policy
Settings dialog box appears.

)

[ Partitions - Step 3: Choose Policy Settings

Partition: Test 4

Media Checking:

) No Restrictions: move any media to any location

(® Enforce Restrictions: iftype is known, allow move if type is unknown
() Full Restrictions: move only if media type is known

Barcode reporting:

Return Media Identifier: Pass Through ¥

Returns: Matches Physical Barcode
Drive Cleaning:
[v] Enable
NOTE: ‘Periodic Interval:’ only applies to HP LTOS drives and greater.

Periodic Interval: ||100 Hours v

[ < Back J[ Next = J[ JL Cancel J[ Help ]

= J

8 Configure the following media policy settings:
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* For Media Checking Policy, select one of three options:
* No Restrictions - Allow any media to be moved anywhere

* Enforce Restrictions - If the media type is known, the
barcode contains a media identifier that will enforce
restrictions. For example, LTO-6 supports reading LTO-6,
LTO-5 and LTO-4 media and writing to LTO-6 and LTO-5
drives. This setting is the default setting.

* Full Restrictions - The media type identified must be known
before we can import or move a media to a drive.

* From the Barcode reporting area, select an option from the
Return Media Identifier drop-down list. Options include
Suffix, Pass Through, Prefix, or Disabled. Depending on which
setting you choose, you can control the use of the media type
identifier in the volume serial number that is returned to the
host.

Caution: After a media volume serial number has been
reported to a host, changing the Return Media
Identifier setting could cause the host to not
recognize media within the library.

For more information about how media policies work, see
Understanding Partition Media Policy Settings on page 129.

Configure the Drive Cleaning policy, by selecting either Enable or
Disable. This setting is enabled by default.

Enabling drive cleaning allows the library to initiate drive cleaning
each time a drive requests a cleaning operation. For drive cleaning
to function, you must first configure drive cleaning for the library.
For more information about configuring drive cleaning, refer
Configuring Drive Cleaning on page 225.

Note: Drive cleaning should be enabled for partitions only if the
host application does not support the coordination of drive
cleaning. If drive cleaning functionality is enabled on the
host application, do notenable automatic drive cleaning
for any partitions in the library.
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16
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If you are enabling Drive Cleaning, select the number of motion
hours you want the drives in the partition to be cleaned. Values
include:

* None

* 100 hours (default)
* 200 hours

* 400 hours

* 800 hours

* 1000 hours

Note: Drive cleaning settings only apply to HP LTO-5 or higher
drives.

To continue, click Next. The Partitions - Step 4: Choose Resource
Quantities dialog box appears.

Type the number of elements to include in the partition by
specifying:

* Number of drives

Note: Partitions can be created that have zero (0) drives
allocated.

* Number of storage slots
* Number of I/E slots

The quantity available for each type of resource indicates resources
not yet assigned to existing partitions.

To continue, click Next. The Partitions - Summary Information
dialog box appears.

Verify that the parameters you set are correct.

To create the partition, click Create. The Partitions - Completed
dialog box appears.

Note: After you click Create, the Cancel button becomes
unavailable.

Review the information to make sure it is correct.
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17 If you want to view the drive information after creating the

partition, click Next.

18 Click Finish. The Partitions dialog box appears again with the

partition you just created listed.

19 Click Close.

Using Expert Mode

1
2

Log on as an administrator.

Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

Click Setup > Partitions > Configure. The Partitions dialog box
displays a list of partitions currently configured within the library.

Note: If you want to cancel the partition creation process, click
Close. The Close button becomes unavailable after you
click Create later in this procedure.

Click Create. The Partitions - Step 1: Choose Creation Mode
dialog box appears.

Select Expert, and then click Next. The Partitions - Step 2: Choose
Partition Properties dialog box appears.

¥ Partitions - Step 2: Choose Partition Properties " Ié]

— -

Create Partition

Start the wizard by entering the name of the partition.

Mame: | |
Vendor ID: | QUANTUM |
ProductID: | Scalar 5000 |

Partition Type: |Standard v|

[ = Back ]L Mext = ]L JL Cancel ]L Help ]
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6 In the Name text box, type a name to describe the new partition.

7 From the Partition Type drop-down list, select the type of partition
you want to create.

* The default is Standard. If you are creating a standard partition,
accept the default and go to Step 8.

* The other choices are for creating library managed partitions
(LMPs). You can only select a library managed partition if it is
already licensed. The choices are:

* Library Managed (EDLM) — For more information, see
Extended Data Lifecycle Management on page 325)

* Library Managed (AMP) — For more information, see
Automated Media Pool on page 271

* Library Managed (VAULT) — For more information, see
Active Vault on page 257

When you select a library managed partition, the Vendor ID, and
Product ID fields become disabled. If you are creating a library
managed partition, make your selection and continue to Step 9.

8 If you are not creating a library managed partition, do the
following:

a From the Vendor ID drop down list, select the vendor.

The Vendor ID information is used in the SCSI Inquiry
command. The choices are QUANTUM and ADIC. The default is
QUANTUM. Some backup applications may only support or be
configured for ADIC libraries, so if you configure a logical library
using the vendor ID of QUANTUM, the backup application
would not work with the library.

b From the Product ID drop-down list, click the appropriate
product type.

The Product ID setting controls the product ID string that is
returned in a standard SCSI INQUIRY response. The library can
report that it is a Scalar 24, Scalar 100, Scalar i500, Scalar 1000,
Scalar i2000, Scalar i6000, or Scalar 10K. This feature can enable
the library to be used with host applications that do not yet
include the Scalar i6000 in a list of recognized devices.

In addition, the various Microsoft Windows operating systems
maintain a list of recognized devices. If the Scalar i6000 is not in
an operating system'’s list of recognized devices, the library will
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appear as an “unknown” device in device lists. You might
prevent the library from being listed as “unknown” by setting
Product ID to a library other than Scalar i6000. This setting
does not cause any library operational changes other than the
SCSI INQUIRY response.

9 To continue, click Next. The Partitions - Step 3: Choose Policy
Settings dialog box appears.

Note: If you are configuring an LMP, all choices on this screen are
pre-selected and you cannot change them. To continue, go

to Step 12.

10 Configure the following settings:
* For Media Checking Policy, select one of three options:
* No Restrictions - Allow any media to be moved anywhere

* Enforce Restrictions - If the media type is known, the
barcode contains a media identifier that will enforce
restrictions. For example, LTO-6 supports reading LTO-6,
LTO-5 and LTO-4 media and writing to LTO-6 and LTO-5
drives. This setting is the default setting.

* Full Restrictions - The media type identified must be known
before we can import or move a media to a drive.

* From the Return Media Identifier drop-down list, click either
Suffix, Pass Through, Prefix, or Disabled. Depending on which
setting you choose, you can control the use of the media type
identifier in the volume serial number that is returned to the
host.

Caution: After a media volume serial number has been
reported to a host, changing the Return Media
Identifier setting could cause the host to not
recognize media within the library.

For more information about how media policies work, see
Understanding Partition Media Policy Settings on page 129.

* For Drive Cleaning, click either Enable or Disable.

Enabling drive cleaning allows the library to initiate drive
cleaning whenever a drive in the partition recommends or
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requires cleaning. For drive cleaning to function, you must first
configure drive cleaning for the library. For more information
about configuring drive cleaning, refer Configuring Drive

Cleaning on page 225.

Note: Drive cleaning should be enabled for partitions only if
the host application does not support the coordination
of drive cleaning. If drive cleaning functionality is
enabled on the host application, do notenable
automatic drive cleaning for any partitions in the
library.

11 If you are enabling Drive Cleaning for a partition containing HP
LTO-5 and higher drives, select the number of motion hours after
which the drive will recommend cleaning. Values include:

* 100 hours (default)
* 200 hours

* 400 hours

* 800 hours

* 1000 hours

12 To continue, click Next. The Partitions - Step 4: Select Drives dialog
box appears.

Note: If you are creating a library managed Automated Media
Pool (AMP) or Active Vault partition, this screen is skipped
because drives are not allowed in these partitions. Go to

Step 16.

Note: If you are creating an EDLM partition, only EDLM-capable
drives are shown.

13 In the left column, select the location of one or more drives.

Make sure that you select the appropriate module because the
library can have drives in the control module and any of the eleven
expansion modules.

Note: With the release of version i12, you can create partitions
that have zero (0) drives allocated.
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To assign a drive to the partition, select the appropriate check box.
You can identify a drive by its serial number and location
coordinates. For more information, see Understanding Location
Coordinates on page 457.

To continue, click Next. The Partitions - Step 5: Select Storage
Slots dialog box appears.

Storage slots are assigned by magazine. In the left column, select
the location of one or more storage magazines.

To assign a storage magazine, select the appropriate check box. You
can identify a magazine by its location coordinates. The number of
slots available is determined by the drive media type.

If this is a standard partition and you are using Automated Media
Pool (AMP), you can add logical element extensions to the partition
for possible later use. Type the number of magazines by which you
would like to extend the standard partition in the Magazine
Extensions field. For more information, see Create Magazine
Extensions in Standard Partitions on page 274.

- Partitions - Step 4: Select Storage Slots: LTO

Partition - Standard2

Chechk the slots to include in this partition.
Note: deleting segments containing media will leave the media inaccessible unless the

ts are re gned to partition.
r Select Location: — - Select Storage Slots:
nisle 1 | Number of Slots | Location
@ Module 1 |~
v | 7,1,1.1,2,1 i
Rack 2 B
[ 1,1,1,1,3,1
[ 1,1,1,1, 4.1
A
s 1,1,1,2,2,1 /=
D%tnll

Selected Slots: & Magazine Extensions: m
[ < Back ][ Mext = ][ J[ Cancel ][ Help ]

19 To continue, click Next. The Partitions - Step 6: Select I/E Slots
dialog box appears.

Available Slots: 186

20 Select the location of one or more I/E station magazines.
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a To assign an I/E station magazine, select the appropriate check
box. You can identify an I/E station magazine by its location
coordinates.

b Make sure that you select the appropriate module because the
library can have I/E stations in the control module and
expansion modules.

Note: The maximum number of I/E element addresses in any
partition is 240. This includes both physical slots and
Extended I/E virtual slots.

21 To continue, click Next.

Note: Depending on whether Extended I/E is enabled, Step 6:
Select Extended I/E Slots may appear. If Extended I/E is
enabled, go to Step 22. If Extended I/E is not enabled, go
to Step 24.

To enable Extended I/E, go to Setup > System Settings >
Physical Library, and select the feature. For more
information about Extended I/E, see I/E Station Options on
page 26.

22 In the Partitions - Step 6: Select Extended I/E Slots dialog box, do
the following:

a In the left column, select the location of one or more Extended
I/E station magazines.

b To assign an Extended I/E station magazine, select the
appropriate check box. You can identify an I/E station magazine
by its location coordinates.

Note: The maximum number of I/E element addresses in any
partition is 240. This includes both physical slots and
Extended IE virtual slots.

23 To continue, click Next. The Partitions - Summary Information
dialog box appears.

24 In the Partitions - Summary Information dialog box, verify that the
parameters you set are correct.
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To create the partition, click Create. The Partitions - Completed
dialog box appears.

Note: After you click Create, the Cancel button becomes
unavailable.

25 Review the information to make sure it is correct.

26 If you want to view the drive information after creating the
partition, click Next.

27 Click Finish. The Partitions dialog box appears again with the
partition you just created listed.

28 Click Close.

You can use the Modify process to change the allocation of drives and
storage magazines in existing partitions without having to delete the
entire partition and then recreate it. You also can use Modify to change
partition properties, partition settings and I/E elements.

Caution: Modifying partitions improperly, particularly when deleting
partition elements, can disrupt host applications.

Before you modify any partitions, understand the configuration changes
you plan to make and the potentially disruptive effects that those
changes could have on the host application(s). Be careful whenever you
add or delete partition elements that include drives, storage magazines,
and I/E station magazines.

For best results, follow these guidelines when adding or deleting
partition elements:

* Shut down the host application
* Update the inventory in the library
* Reconfigure the library in the application

* Update the inventory in the application
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Note: This procedure includes instructions for downloading new drive

firmware images. You can modify partitions from either the
library’s touch screen or a remote client. However, if you want
to download drive firmware images, you must do so from a
remote client.

To modify an existing partition, perform the following steps:

1
2

Log on as an administrator.

Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

Click Setup > Partitions > Configure. The Partitions dialog box
appears.

Note: If you want to cancel the partition modification process,
click Close. The Close button becomes unavailable after
you click Modify later in this procedure.

Select the partition you want to change, and then click Modify. The
Partitions - Step 1: Choose Partition Properties dialog box
appears.

Note: For Library Managed Partitions, you cannot modify these
properties; all options are disabled.

On this dialog box, you can modify the partition Name, Vendor ID,
and Product ID.

To continue, click Next. The Partitions - Step 2: Choose Policy
Settings dialog box appears.

Note: For Library Managed Partitions, you cannot modify these
properties; all options are disabled.

On this dialog box, you can modify the following settings:

* For Media Type Checking, select either Enable or Disable. This
setting is enabled by default.

* From the Media Checking Policy drop-down list, click either
Required or Not Required.
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* From the Return Media Identifier drop-down list, click either
Suffix, Pass Through, Prefix, or Disabled. Depending on which
setting you choose, you can control the use of the media type
identifier in the volume serial number that is returned to the
host. When you have made your modifications, including
adding or deleting elements, your proposed changes to the
partition are highlighted in the New Value column of the table
that appears on the Partitions - Summary Information dialog
box.

Caution: After a media volume serial number has been
reported to a host, changing the Return Media
Identifier setting could cause the host to not
recognize media within the library.

For more information about how media policies work, see
Understanding Partition Media Policy Settings on page 129.

* For Drive Cleaning, click either Enable or Disable. This setting is
enabled by default.

Enabling drive cleaning allows the library to initiate drive cleaning
each time a drive requests a cleaning operation. For drive cleaning
to function, you must first configure drive cleaning for the library.
For more information about configuring drive cleaning, refer
Configuring Drive Cleaning on page 225.

Note: Drive cleaning should be enabled for partitions only if the
host application does not support the coordination of drive
cleaning. If drive cleaning functionality is enabled on the
host application, do not enable automatic drive cleaning
for any partitions in the library.

8 To continue, click Next. The Partitions - Step 3: Select Drives dialog
box appears.

Note: If you are creating an Automated Media Pool (AMP) library
managed partition or an Active Vault library managed
partition, this screen is skipped because drives are not
allowed in these partitions. Go to Step 16.

9 Select the location of one or more drives.
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Make sure that you select the appropriate module because the
library can have drives in the control module and in any of the
expansion modules.

10 You can add a drive to the partition by selecting the appropriate
drive check box. You can delete a drive from the partition by
clearing the drive's check box. You can identify a drive by its serial
number and location coordinates.

11 To continue, click Next. The Partitions - Step 4: Select Storage
Slots dialog box appears.

12 Select the rack you want to modify.

13 You can add a storage magazine by selecting the appropriate check
box. You can delete a storage magazine by clearing its check box.
You can identify a storage magazine by its location coordinates.

14 |If this is a standard partition and Automated Media Pool (AMP) is
configured on the library, you can add virtual storage to the
partition for possible use later by adding magazine extensions. Type
the number of magazines to add in the Magazine Extensions field.
For more information, see Create Magazine Extensions in Standard
Partitions on page 274.

- Partitions - Step 4: Select Storage Slots: LTO

Partition - Standard2
Chechk the slots to include in this partition.
Note: deleting segments containing media will leave the media inaccessible unless the
ts are re igned to ther partition.
r Select Location: - Select Storage Slots:
lisle 1 ] Number of Slots | Location
@ Module 1 |~
¥ s 1,1,1,1,2,1 o
Rack 2 B
(] [ 1,1,1,1,3,1
(] ] 1, 1,1, 1,41
A
i 1,1,1,2,2,1 /=
[_] Spfect All
Available Slots: 186 Selected Slots: & Magazine Extensions: (100 ‘
[ < Back ][ Mext = ][ J[ Cancel ][ Help ]
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15 To continue, click Next. The Partitions - Step 5: Select I/E Slots
dialog box appears.

16 Select the location of one or more I/E station magazines.

* Make sure that you select the appropriate module because the
library can have I/E stations in the control module and in
expansion modules.

* You can add an I/E station magazine by selecting the
appropriate check box. You can delete an I/E station magazine
by clearing its check box. You can identify an I/E station
magazine by its location coordinates.

Caution: If you delete magazines that contain media, the media
will be inaccessible unless you reassign the magazines
to another partition.

Note: The maximum number of I/E element addresses in any
partition is 240. This includes both physical slots and
Extended I/E virtual slots.

17 To continue, click Next. If Extended I/E is configured, the Extended
I/E Slots dialog box appears.
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® &)

Partition - Logical Library 02

Check the Extendad IVE slots to include in this parition.

r Select Location: - - Select Extended I/E Slots:
isle 1 | Murnker of Slots | Location
9 Module 1
[l [ 1.1,1,1, 2.1
Rack 2
[l [ 1,1,1,1, 3.1
[l [ 1.1,1,1, 4.1
[l [ 1,1,1,2,21
-|
[ Select Al
Available Extended IE Slots: 96 Selected Extended VE Slots: 0
| = Back | | Mext = | | Cancel | | Help |

Otherwise, the Partitions - Step 6: Configure Drive Firmware
Autoleveling dialog box appears.

Note: The Partitions - Step 6: Configure Drive Firmware
Autoleveling dialog box appears only if the drives are
connected via an FC I/O blades or an Ethernet Expansion
blade. If this dialog box does not appear, the Partitions -
Summary Information dialog box appears instead. See

Step 19 on page 151.

The Partitions - Step 6: Configure Drive Firmware Autoleveling
dialog box enables you to set up drives to participate in autoleveling
operations. Drives are autoleveled whenever they are reset, such as
when the library is power cycled or rebooted.

18 To enable autoleveling for the partition, perform the following
steps:

a From the Drive Type drop-down list, click the type of drives that
you want to list in the table. Listed drive types use the following
format:

<vendor>_<product>_<interface>
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Drives of the specified type within the partition appear in the
table.

Note: All drives of the specified type within the partition are
listed, regardless of whether they are attached to an FC
I/O blade or Ethernet Expansion blade.

If you need to download a new drive firmware image to use
with drives that you want to participate in auto leveling
operations, perform the procedure under Updating Drive
Firmware on page 586, and then proceed with the next substep.
Otherwise, proceed directly to the next substep.

After you download a new image, the new drive firmware
version is automatically added to the Firmware Version drop-
down list.

b In the left-most column of the table in the Selected Drives will
be Autoleveled area, select one or more check boxes that
correspond to drives that you want to update with the same
drive firmware version, and then click the version in the
Firmware Version drop-down list.

Note: Only drives that are attached to an FC I/O blade or an
Ethernet Expansion blade can participate in drive
firmware autoleveling operations.

To continue, click Next. The Partitions - Summary Information
dialog box appears.

Verify that the parameters you set are correct.

If the summary information is correct, click Modify. The Partitions -
Completed dialog box appears.

Note: After you click Modify, the Cancel button becomes
unavailable.

Review the information to make sure it is correct.

If you want to view the drive information after modifying the
partition, click Next.

Click Finish. The Partitions dialog box appears again.

Click Close.
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Downloading Drive Firmware for Autoleveling

Note: Before you begin the following procedure, make sure that you
have obtained the new drive firmware image from Quantum
technical support and placed it in an accessible location on
your laptop.

1 On the Partitions - Step 6: Configure Drive Firmware
Autoleveling dialog box, click Manage Images. The Manage Drive
Firmware Images dialog box appears.

Manage Drive Firmware Images

X

rTape Drive Firmware Images

Filename |

Size (ovtes) | InUse |

e3aYd_FCfmr
F8D0_FC frr

1035680
1033024

[v]
[

»

8.03 Megahytes Free

| Diownload || Delete || Close || Help |

The library sets aside space for drive firmware. You can load multiple
firmware images. The library screen indicates how much space is
free. Quantum recommends you use the latest firmware available
(as specified in the Release Notes). A check mark in the In Use
column indicates one of the following conditions:

* An autoleveling policy exists that uses this drive firmware
image.

* A pending autoleveling policy exists that uses this drive
firmware image.

* A pending firmware update exists that uses this drive firmware
image.

Under these conditions, you cannot delete the drive firmware
image. If the check box for a drive firmware image is clear, you can

Quantum Scalar i6000 User’s Guide



Chapter 3: Configuring Your Library
Working With Partitions

delete the image by clicking it to highlight it, and then clicking
Delete.

2 To download a new drive firmware image, click Download. The
Select firmware image file to download dialog box appears.

|
Laook In: |Ij Dirive Firrmware - | @ @ @ @E

[ 38v4_FC.fmr

File Name:  |3AY4_FC.frr |

Files of Type: | Drive Firmware Files (*.drv, *.fmr, *.img, *.E, *.ra) v|

| Qpen || Cancel |

3 Navigate to the location of the drive firmware image file (with either
a.drv, .fmr, .img, .E, or .ro extension) you want to download, and
then click the image file to highlight it.

4 Click Open.

The download process copies the drive firmware image from the
remote file system to the MCB. When the download process
completes, the Partitions - Step 6: Configure Drive Firmware
Autoleveling dialog box appears again.

Deleting Partitions Caution: For the host application to have access to the written data
on the partition that you want to delete, you must recreate
a partition that includes the same media type, interface, I/E
station magazines, and a host at the same SCSI ID and LUN.

To delete a partition, perform the following steps:

1 Log on as an administrator.
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2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Partitions > Configure. The Partitions dialog box
appears.

4 Click the partition you want to delete.

Note: You can delete only one partition at a time.

5 Click Delete.

Note: If the physical library is not offline, you receive a message
that asks you whether you want to take the library offline
and delete the partition. Click Yes. If the partition is already
offline, you receive a message that asks you whether you
want to delete the partition. Click Yes.

6 The library deletes the selected partition. Repeat the process to
delete another partition, or click Close.

Configuring Control Paths

154

You must define a control path for each library partition. The control
path is used to connect a partition to a host application. The i6000 does
not automatically assign a control path when you create a partition.
Each partition control path can occur through one of several different
physical connection points depending on the hardware configuration of
your library.

The procedure for setting up and defining the control path for a
partition depends on which physical connection point you choose to
use. Table 26 describes how to set up different types of control paths.

Note: Only IBM and HP LTO-5 or later drives can be configured for
control path bridging (using a drive as the control path for a
partition), and in order to do so, they must be connected to an
Ethernet Expansion blade.
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Note: Both IBM and HP LTO-5 or later drives with SNW licenses can be
configured for control path failover.

Note: A partition can be LUN mapped through any FC I/O blade, but
you must manually configure LUN mapping to present the
partition to specific hosts.

Caution: When configuring a control path using an FC I/O blade
connection, the partition LUN can be presented multiple
times through any FC I/O blade and even the MCB at the
same time. In a direct attached control path configuration,
you can choose the drive to present the partition and it
remains dedicated to the drive until you change it to
another drive.

Note: 10 blades connected to drives configured with a control path
may report certain library ready conditions differently than
drives without a control path configured.
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Table 26 Control Path Matrix

LTO-5 or LTO-5 or later
later EEB EEB
GUI Menu Procedure MCB Direct | FC I/O Blade | Direct Connection w/
Path References Connection Connection Connection? | SNW LicenseP
Setup > Creating Partitions | Step 1 Step 1 Step 1 Step 1
Partitions > | on page 132
Configure
Setup > Configure Step 2
Blades > FC I/0O Blade
Connectivity | port Configuration
on page 171
FC Host Port
Failover on
page 175
Enabling a Target
Port on page 177
Configuring
Datapath
Conditioning on
page 248
Setup > Port Configuration | Step 2
Blades on page 171
Connectivity
Setup > FC Host LUN Step 3 Step 3
Blades > Mapping on
Access page 207
Channel Zoning on
page 206
Using the LUN
Mapping Wizard
on page 213
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LTO-5 or LTO-5 or later
later EEB EEB

GUI Menu Procedure MCB Direct FC I/O Blade | Direct Connection w/

Path References Connection Connection Connection? | SNW LicenseP

Setup > Use the Storage Step 2 Step 2

Drives > Networking Wizard

Access > on page 356

SNW Wizard

~OR~ ~0OR~

Setup > Configuring

Partitions > | control Paths on

Control Path | h54e 154

Setup > License Drives for Step 3

Drives > Path Failover on

Access > page 357

SNW Wizard

Setup > Configure Control Step 4

Drives > Path on page 359 (HP drives only)

Access >

SNW Wizard

a.0nly IBM and H

Drives for Path Failover on page 357.

[TO-5 or later drives support control path bridging.
b.Only HP LTO-5 or later Storage Networking licensed drives can be configured for control path failover. See License

Configuring an IBM or
HP LTO-5 or later Drive
as the Control Path

You can configure IBM and HP LTO-5 or later FC drives as the control
path for a partition. The drive must not be connected to an FC I/O blade,
but it must be connected to an Ethernet Expansion blade.

Note: The control path drive and control path failover settings are
configured on the same screen. You do not need an SNW
license to configure a drive for control path. However, you do
need an SNW license to configure control path failover (see
Configure Control Path on page 359).

The instructions that follow only describe how to configure a drive as
the control path for a partition. If you would like to configure both the
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control path and control path failover, see Configure Control Path on
page 359 instead.

1 Log on as an administrator.
2 Access the appropriate screen in one of two ways:

* Select Setup > Partitions > Control Path from the main
console.

* Select Setup > Drives > Access > SNW Wizard. Click Next.
From the Select Storage Networking Option screen, select
Control Path and click Next.

The Storage Networking Partitions dialog box appears,
displaying all partitions that contain drives eligible to for control
path bridging (HP LTO-5 or later drives connected to an Ethernet
Expansion blade).

- Storage Networking Partitions

Selectthe parition whose Contral Path (CP) settings vou want to configure.
MName || Status || #Drives
SNW Partition Offline 2
Cancel | ‘ Help

3 Click to highlight the row containing the partition whose control
path settings you want to configure.

4 Click OK. The Control Path dialog box appears.
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g - T — —— P
¥ Storage Networking Configuration Wizard - - @

Control Path Configuration

Select the Control Path drive(s) you wish to use for host communication with the library medium changer. To
configure Basic, Advanced or Multi Control Path the drives must have an SNW license, be connected to an
EEB, be in Point 2 Point topology and be LTOS generstion or greater. The Advanced features require s
specific driver to be installed on the host machine.

-Control Path (CP) Type Selection

Control Path Type: |rContro| Path (HP/IBM) Vj
r Select CP/CPF drives
CP | CPF | Serial Number Mode Location WWN
v (] |FO013C003D Online (Active) |1,1,1,11,1,1 500308c0:013c003d
(] (] |FO013C0043 Online 111,42 1.1 500308c0:013c0043

[ < Back ][ Finish J[ Cancel J[ Help J

e ———= — J

Se—

5 From the CP Drive drop-down list select the drive you want to
configure as the control path. The primary CP drive you selected is
highlighted in yellow.

6 IN the CPF Mode area, select the radio button for the type of control
path failover you want to configure.

Note: If you want to configure control path failover, you must
have a SNW license with sufficient licensed drive counts to
configure a CPF drive. For more information, see Configure
Control Path on page 359.

Click OK. An Operation in Progress dialog box appears.

8 The control path drive is configured.
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Setting Up the Network Configuration

If your library has an MCB2 installed, you can configure two (2) network
settings for your library. When looking at the Setup > Network Settings
menu, you'll notice two (2) interface options. Depending on what you
have enabled, you’ll see IPv4 or IPv6 listed.

The intended use of these settings is twofold:
* Interface 1 is for configuring a gateway to go outside the network.

* Interface 2 is for accessing devices on it's own network, encryption
keys and for security. You cannot configure a gateway and cannot
access any devices outside the network. You can access the library
from a browser, however.

Make sure that your library is attached to a network before you use the
Network Configuration command.

Caution: When configuring both interface settings, the IPs must be
on separate subnets. If you configure the second interface
with the same IP, you will not be able to save the
configuration settings.

Caution: You must fully understand all network issues before you
change the network configuration for an already
configured library. It is recommended that you consult with
your network administrator before changing your network
configuration.

Note: To set up an iPv6 network connection, make sure that the IPv6
option is enabled on the Physical Library dialog, as described
in Setting Up Policies for the Physical Library on page 178.

Note: For all site-to-site customer firewall network settings, see
Appendix B, Network Port Settings.

1 Log on as an administrator.
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2 If you are not already working from the physical library, select the
physical library from the View menu.

3 Do one of the following, depending on whether IPv6 is enabled or
disabled and the protocol of the network connection you want to
configure:

* IPv4 Configuration — Proceed to Setting up IPv4 Network
Configuration on page 161.

* IPv6 Configuration — Proceed to Setting up IPv6 Network
Configuration on page 165.

Note: The IPv6 Configuration sub-menu only appears if you
have enabled IPv6 for the physical library, as described
in Setting Up Policies for the Physical Library on
page 178.

* DNS Configuration — Proceed to Configuring DNS on

page 168.
Setting up IPv4 After completing the steps listed in Setting Up the Network
Network Configuration Configuration on page 160, select Setup > Network

Configuration > Interface (#) > IPv4 Configuration. The IPv4
Network Configuration - Interface # dialog box appears.
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Figure 37 Network
Configuration - Interface 1

- .
B Network Configuration - Interface 1 ﬁ

If DHCP is enabled, enter only the Library Name. If DHCP is disabled, enter
the sppropriate addresses in standard |P format.

Take caution when changing network parameters from remote client. If the
IP address changes, the application may lose connection until you restart
the application.

- Host Settings
DHCP: O {® Disable

Library Name: hubble |

IP Address: 10.20.163.105

Subnet Mask: 255.255.248.0 |

Default Gateway: |10.20.160.1
- Port Settings

Auto Negotiate ® Enable ) Disable

Speed ® 1000 O 100 O 10

-Current Port Settings

Port Speed: 1000 Duplex: full
Auto Negotiate: on Link: Yes
[ OK ][ Cancel ][ Cycle ][ Help ]
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Figure 38 Network
Configuration - Interface 2

o b
B Network Configuration - Interface 2 @

If DHCP is enabled, enter only the Library Name. If DHCP is disabled, enter
the sppropriate addresses in standard |P format.

Take caution when changing network parameters from remote client. If the
IP address changes, the application may lose connection until you restart
the application.

- Host Settings

e —

DHCP: () [Enablel @ Disable

Library Name: |library |

IP Address:

Subnet Mask: |

- Port Settings

Auto Negotiate ® Enable ) Disable

Speed {1000 O 100 @ 10

-Current Port Settings

Port Speed: 10 Duplex: half
Auto Negotiate: on Link: No
[ OK ][ Cancel ][ Cycle ][ Help ]

4 Use the following table to assist you in completing the elements on
the IPv4 Network Configuration dialog box.
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Element Description

In the Host Settings area:

DHCP If Dynamic Host Configuration Protocol (DHCP) is
enabled on your network, do one of the following:

* Select Enable to have DHCP automatically
configure the library network settings. Enable
makes the IP Address, Subnet Mask, and
Default Gateway text boxes unavailable.

* Select Disable to make the IP Address, Subnet
Mask, and Default Gateway text boxes
available for you to manually set the library
network settings.

Library Name The network name that you want to assign to the
library.
IP Address The IP address of the library. This text box is

available only if DHCP is disabled.

Subnet Mask The subnet mask. This text box is available only if
DHCP is disabled.

Default The IP address of the default gateway for your
Gateway portion of the Ethernet network. This text box is
available only if DHCP is disabled only for Interface
1.

In the Port Settings area:

Auto Negotiate | ¢ Select Enable to have the library automatically
negotiate port speeds. Enable makes the Speed
options unavailable.

* Select Disable to make the Speed options
available for you to manually set the port speed.

Speed The port speed (10, 100 or 1000 Mbps). Speed
options are available only if Auto Negotiate is
disabled.

The current port settings are listed in the Current Port Settings
section. For more information, see Viewing the Current Network

Port Settings on page 169.
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Figure 39 Network
Configuration - Interface 1
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The Cycle button enables you to cycle the external Ethernet
interface without rebooting the library.

Make the appropriate network configuration changes, and then
click OK. A message appears that informs you that network
connectivity will be lost temporarily, and asks whether you want to
proceed.

Click Yes.

After completing the steps listed in Setting Up the Network
Configuration on page 160, select Setup > Network
Configuration > Interface (#) > IPv6 Configuration. The IPv6
Network Configuration - Interface # dialog box appears.

-
B Network Configuration - Interface 1

k

(StaticlP_| DHCP [ Hostname | Settings

() Enable @ Disable
Address: |C
Prefix: |-

Gateway:

[ ][ Cancel ][ Help ]
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Figure 40 Network
Configuration - Interface 2
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on

-
B Network Configuration - Interface 2

(StaticlP_| DHCP | Hostname | Settings

{®) Disable

) Enable

Address: [0:0:0:0:0:0:0:C
Prefix: S
[ ] [ Cancel ] [ ]

7 Use the Static IP tab to disable or to enable and specify a static IP
address. Valid static IP addresses include link local, site local, and
global unchaste.

Help

"

The IP address for Interface 2 must be on a different
subnet than Interface 1.

Caution:

8 Click DHCP to display the DHCP tab.

Metwork Configuration

Statefull Autoconfiguration: DHCPvE may be used to obtain an IP address and other
configuration parameters. Select enakle to turn this feature on or disable to turn it off

1 Enable @ Disable

9 As prompted, use the DHCP tab to enable or disable the Dynamic
Host Configuration Protocol (DHCP) auto configuration function.

| | Cancel | | Help

10 Click Hostname to display the Hostname tab.
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Network Configuration

[ Hostname |

Select a Library name that can be used to connect to the librany rermotely.

Library Mame: |dvt14

| QK || Cancel || Help |

11 Use the Hostname tab to specify a library name that can be used

for remote connections to the library.

12 Click Settings to display the Settings tab.

Network Configuration

[ Bettings

Current IPvG Settings

Static Address:
Drizabled

DHCP:
Drizabled

Hostname:
ERER

Configured Addresses:

R R R N R
B W A B
EESEESEE S SRS S
R R R N R R

| QK | | Cancel | | Help |

13 Use the Settings tab to view the current IPv6 configuration settings.

14 After you make the appropriate network configuration changes,
click OK. A prompt appears informing you that network connectivity
will be temporarily lost and asks whether you want to proceed.

15 Click Yes.
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Configuring DNS If DHCP is disabled, you can specify primary, secondary, and tertiary
Domain Name System (DNS servers). DNS servers provide IP address
resolution of fully qualified domain names. DNS settings are optional.

Caution: You must fully understand all network issues before you
change the network configuration for an already
configured library. It is recommended that you consult with
your network administrator before changing your network
configuration.

To configure DNS servers:
1 Log on as an administrator.

2 If you are not already working from the physical library, select the
physical library from the View menu.

3 Click Setup > Network Configuration > DNS Configuration. The
DNS Configuration dialog box appears.

« DNS Configuration g|

Select the primany, secondany and teriary Domain Hame Service (DHS) servers that will be usad to
resolwe fully qualified domain names to IP addreszes. The secondany and terian addresses are
aptional but wou must enter 3 primany address.

Primary: |127.0.0.1 |

Secondary: [10.20.169.9 |

Tertiary: |10.20.160.61 |

( J [ cancel J[ el |

4 Enter a primary DNS server IP address. Optionally, enter secondary
and tertiary addresses.

5 Click OK.
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To view the current settings on the library’s network Ethernet port,
select Setup > Network Configuration > IPv4 Configuration. The
Current Port Settings section of the dialog displays the following
information:

* Port Speed — Current speed
* Auto Negotiate — On or off
* Duplex — Half or full

* Link — Indicates whether the Ethernet link is up (yes or no)

Changing the Internal
IP Network Address

Note: The Change Internal IP dialog box is accessible only from the
library’s touch screen.

Quantum Scalar i6000 User’s Guide

The default internal network subnet setting for the library is 192.19.X.X.
Attaching the library to a 192.19.X.X external network can cause library
and network problems. The Change Internal IP dialog box enables you
to change the library’s internal IP addressing so that conflicts do not
occur.

Keep in mind the following considerations:

* You only need to change the default internal IP setting if your
external network is 192.19.X.X.

* Do not set up internal IP addressing to conflict with existing external
IP addressing. If you set up the same IP subnet for both the internal
and external IP networks (for example, 192.19.X.X), the library will
become unusable.

* If you change the internal IP addressing, and then later a user uses
the Network Configuration dialog box (Setup > Network
Configuration) to assign to the library a static IP address that
conflicts with the internal network, the assignment request will fail
and the library will issue a ticket.

* If you change the internal IP addressing, and if Dynamic Host
Configuration Protocol (DHCP) is enabled and DHCP assigns to the
library an IP address that conflicts with the internal network,
address conflicts could occur between internal library devices and
external customer devices and the library will issue a ticket.
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1 From the local operator panel only, select Setup > Network
Configuration > Internal IP. The Change Internal IP dialog box
appears.

By default, the internal IP subnet address that is automatically
selected on the Change Internal IP dialog box is not the one to
which your internal network is currently set. For example, the
current internal network IP setting is 192.19.x.x,. The drop-down
menu has multiple subnet options from 192.19.x.x to 10.90.x.x.

2 To accept the automatic internal IP setting, click OK. The following
warning message appears.

g.?.g ¥arning! ﬂ

warning!

Caution: Setting the internal IP network to be on the same
subnet that the external IP network is on causes library
failure and results in the management interface (the
MCB) becoming unusable. For example, if you set
10.10.X.X as the internal IP network and your external
IP network is also 10.10.X.X, a conflict occurs. If you
are unsure about whether the change is appropriate,
select No.

3 If you are sure that you want to make the change, select Yes.

4 After the library processes the request successfully, a message
appears that asks you whether you want to shut down the library.
You must shut down and restart the library in order for the changes
to take effect.

170 Quantum Scalar i6000 User’s Guide



Chapter 3: Configuring Your Library
Managing Connectivity

Managing Connectivity

Port Configuration

Quantum Scalar i6000 User’s Guide

The Connectivity command on the Setup menu enables you to access
three connectivity-related commands for the library: Port
Configuration, Datapath Conditioning, and FC Host Port Failover.

For information about configuring data path conditioning monitoring
levels and intervals, see Configuring Datapath Conditioning on
page 248.

Use the Port Configuration command to view and configure
connectivity parameters for FC ports. Port Configuration gives you
access to the FC ports on the I/O blades.

Note: You can only view EEB port connection status and configure or
view /O blade port connections status.

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Blades > Connectivity > Port Configuration. The
Connectivity dialog box appears.
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.
B Connectivity

-

Select a component:

® 10 Blade - 1, 1,

port: 1, link:
port: 2, link:
port: 3, link:
port: 4, link:
port: 5, link:
port: 6, link:

1,1,3

Fibre Channel -1
Fibre Channel - 2
Fibre Channel -3
Fibre Channel -4
Fibre Channel -5
Fibre Channel -6
@ EthernetBlade-1,1,1,1,8

down, speed: 10, duplex: half
down, speed: 10, duplex: half
down, speed: 10, duplex: half
up, speed: 100, duplex: full

down, speed: 10, duplex: half
down, speed: 10, duplex: half

ety ) ( Powsroyas )

Help ]

4 Click the highest-level items to show next-level items.

5 Click a port to highlight it, and then click Configure. For an FC port
on an /O blade, the Fibre Channel Parameters dialog box appears.
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r Loop 1D:

[¥] Soft

r Speed:

[v] Auto

r Frame Size:

2512 21024 w2043

rPort Mode:
® Target
3 Initiatar ) Private

2 Target and Initiator ® Public

r Connection Options:

2 Loop
) Pointto Point

® Loop Preferred

| Cancel | | Help

You can configure all settings for an I/O blade connection. The
figure above shows an FC port configured for target mode and a

loop preferred connection.

a In the Loop ID area of the Fibre Channel Parameters dialog
box, repeatedly selecting Soft acts as a toggle, checking and
clearing the box. If the box is not checked, you can click a hard
loop ID (within the range from 0 to 125) from the drop-down
list. Some operating systems require hard ID settings. Consult
your service representative before making changes to this

setting.

configure the speed manually, u

Select Auto to automatically set the interface speed. To

ncheck the Auto check box and

use a setting from the drop-down list.

FC Frame Size is specified by each receiving node and need not

match any other node. The frame size is typically set to 2048.

(You can use another frame size
software application.)

if it is required by a particular
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Table 27 FC /O Blade Port

d FC ports support Private and Public Fibre Channel attachments.

The default port mode setting for FC ports 1 and 2 is Target
Public, and the default port mode setting for FC ports 3
through 6 is Initiator Public. With Public, the loop is scanned
for Fabric devices and allows the Fabric to have access to all
available target devices that are attached to it. With Private, the
local loop is scanned for devices except for Fabric devices. In
Target mode, the port is set to receive connections from
another FC initiator, such as a host or FC switch. In Initiator
mode, the port scans for storage devices. In Target and
Initiator mode, the port operates in both modes
simultaneously.

The default connection mode for both target and initiator ports
is Loop Preferred. For target ports, other options include Loop
and Point to Point. For initiator ports, other options include
Loop and Loop Preferred. If you change a target port that is
set to Point to Point to initiator mode, the port connection type
automatically changes to Loop Preferred. Consult your service
representative before making changes to this setting.

For reference purposes, the following table shows the default FC I/O
blade port settings as initially set up at installation.

Settings
Port Loop ID | Speed | Frame Size | Port Mode | Connection Option | Private/Public
FC-1 Soft Auto 2048 Target Loop preferred Public
FC-2 Soft Auto 2048 Target Loop preferred Public
FC-3 Soft Auto 2048 Initiator Loop preferred Public
FC-4 Soft Auto 2048 Initiator Loop preferred Public
FC-5 Soft Auto 2048 Initiator Loop preferred Public
FC-6 Soft Auto 2048 Initiator Loop preferred Public
6 After you finish selecting the port configuration settings, click OK. A
message appears that asks whether you want to make the change.
7 Click Yes.
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FC Host Port Failover Configure the optional FC Host Port Failover (HPF) feature so that an
alternate “standby” target port on an I/O blade can assume the identity
and LUN mapping configuration of the primary “active” target port if
the primary port fails. HPF enables the library to continue operations
without requiring you to reconfigure the host or the SAN.

To enable HPF, you must make sure that two ports on the FC I/O blade
are in target mode and point-to-point connection. Use ports 1 and 2,
which are ports that are traditionally configured to be host targets.

FC 1/O blade ports are numbered from bottom to top as the blade sits in
the I/O management unit.

Both ports must be attached to the same SAN fabric to provide host
access. The active primary port is used for host communications, while
the passive standby port is kept idle. The way that you configure the
recovery settings determines how the failed port behaves after it is
restored from a failed state.

The library generates a ticket when port failover occurs. Examine the
ticket and the repair page associated with the ticket to determine the
reason for the failover.

To configure HPF, perform the following steps:
1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Confirm that there are two ports on the I/O blade in target mode
and point-to-point connection. For more information, see Port

Configuration on page 171.
4 Click Setup > Blades > Connectivity > FC Host Port Failover. The
FC Host Port Failover dialog box appears, showing all the FC I/0

blades found in the library. Each blade is identified by name and by
location.
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FC Host Port Failover

Select an 10 Blade:

Mame [ Location

FCIOBME404

1,1,1,1, 4
FCI0BIT404 1,1,1,1,6

176

5 Click a blade to highlight it, and then click Configure. The FC Host

Port Failover dialog box appears

FC Host Port Failover - FCIOB-1,1,1,1,
Configuration | Physical Ports |

x|

r Feature Enable

Current.  |Disabled [C] Enable FC Host Port Failover

r Recovery Setting

Error count recovery mode:
Link down error recovery mode;

Link down delay time:

r Primary Port

Current Primany: |0 Select Primary:

Current Active:  |NOMNE

Set

| Close || Help |

6 In the Feature Enable area, select Enable FC Host Port Failover,
and then click Set to make the Configuration tab available.
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On the Configuration tab, settings are unavailable if the current
state of the tab is set to Disabled.

Be aware that there might be incompatibilities with channel zoning
configuration on the I/O blade if you enable host port failover.

7 Accept the recovery setting default values unless an authorized
representative advises you otherwise.

8 Before you set recovery settings, understand the following elements
in the Recovery Setting area:

* Error count recovery mode sets the recovery scenario for all
ports when port failure is caused by excessive errors on the port.
The only setting option is Require Intervention.

* Link down error recovery mode sets the recovery scenario for
all ports when port failure is caused by the port going offline for
more time than the threshold specified in the Link down delay
time text box. The only setting option is Require Intervention.

* Link down delay time sets the timeout threshold before link
down status applies. The default value is zero (0) seconds. There
is no maximum value. Require Intervention means that a user
must manually use the Physical Ports tab to bring a failed port
that has recovered back online.

9 Configure the Primary Port. Only ports that are in target mode and
point-to-point connection can participate in host port failover. The
primary port becomes active by default and the alternate port will
go on passive standby until a failover occurs. Use the Select
Primary drop-down list to select from the target ports that are
online and available. You must select a primary port. Current Active
indicates the currently active port.

10 Click Set. If your configuration has errors, a warning message
appears.

Enabling a Target Port

Use the Physical Ports tab to manually enable an online target port that
was disabled because of a previous connection error. If the Intervention
column displays “true,” you must manually bring the recovered port
back online using Enable. If the port state is “disabled,” the port's
connection is repaired and it is ready to be re-enabled. If the
Configuration tab itself is disabled, the table on the Physical Ports tab
will be empty.
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Note: If the target port state is offline, the port's connection has not
been repaired. The error condition that caused the port to fail
still exists.

On the FC Host Port Failover dialog box, click the Physical Ports
tab. The dialog box shows you each target port on the I/O blade, the
port’s state, and the type of failure that has occurred, if applicable.

FC Host Port Failover - ADIC FCIOB-1,1,1,1,4 il
Configuration Physical Ports
FortMumber | State | Failure Type [ intervention
Unknown Unknown false
2 Unknown Unknown false
\ ciose | \ Help |

11 Click the port you want to enable.
12 Click Enable.

Note: Enable is available only if the port is disabled.

13 To return to the main FC Host Port Failover dialog box, click Close.

Setting Up Policies for the Physical Library

The Physical Library dialog box enables you to configure various
operating modes:
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Policy Settings

Automatic Inventory Enabled: automatically inventories all library content whenever the
library powers up or when a main library access door closed and
robotics are enabled (except for Ul initiated Aisle Access or Robot
Replacement operations). In this mode, individual I/E stations are
always scanned upon I/E station door closure detection, and
individual tower modules will automatically be scanned if varied on
after a tower door closure, independent of the tower having a
scanner installed or not.

Disabled (default): requires the user to initiate inventory scan
operations whenever the tape cartridge inventory is manually
manipulated in drives, linear storage magazines, and tower
modules without scanners while the library is powered off or a
library access door is opened and closed. In this mode, only I/E
stations and tower modules with scanners are automatically
scanned upon library power-up, and also scanned when an I/E
station door is closed or a tower module with an installed scanner
is varied on after a tower door closed.

Note: Tower modules with configured but inoperable scanners
will be scanned by a robot. Tower modules without
scanners will not be inventoried.

Automatic Drive Unload Enabled (default): will automatically initiate unload operations to
a drive if a SCSI move request is received and the drive is not
already unloaded.

Disabled: Drives need to be unloaded by allocated host
applications. SCSI move requests from drives that are not already
unloaded will fail.

Logical SN Addressing Enabled (default): Drive are configured to report a library unique,
drive position unique drive serial number. This methodology allows
drive replacements without affecting host configured drive serial
number re-configurations as the repeated drive serial number will
not change if a drive is replaced.

Disabled: Installed drives report their physical serial number to
attached hosts. Drive replacement operations will cause the
replacement drive to report its assigned physical serial number and
host applications may have to re-configure drive support if the
drive serial number changes.
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Policy

Settings

IPv6

Enabled: will support the configuration of IPv6, as well as IPv4,
network settings.

Disabled (default): will not support the configuration of IPv6
network settings and only allow IPv4 network configuration.

Extended I/E

Enabled: will support the configuration of storage slots as I/E slots,
extending the number of available I/E slots for host configurations
that require non-I/E elements not physically provided in I/E stations.

Disabled (default): will not allows I/E slot extensions to be
configured.

EKM Path Diagnostics

Enabled (default): EKM server connectivity and functionality are
performed in regular intervals to alert of connectivity or
operational issues.

Disabled: EKM path connectivity and functionality tests are not
performed.

Send Usage Statistics

Enabled (default): If e-mail notification settings are configured,
library usage and performance data will be sent to Quantum for
statistical review purposes. These emails contain configuration and
status information only, and do not contain any customer data
stored on the system.

Disabled: Usage statistics are not sent regardless of e-mail
notification settings.

180

Log on as an administrator.

Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

Click Setup > System Settings > Physical Library. The Physical
Library dialog box appears.
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o

(EEE=0 i B L

o

rAutomatic Inventory

) Enable| {® Disable
rAutomatic Drive Unload

{® Enable ) Disable
rLogical SN Addressing

® Enable ) Disable
riPve

® Enable () Disable
rExtended IE

{_) Enable (@ Disable

rEKM Path Diagnostics

EKM Heartbeat Interval: |10

(0-60 minutes, 0 to disable.)

rSend Usage Statistics

®) Enable

() Disable

[ J (

cancel | Hep |

4 Select Enable in the Automatic Inventory area to schedule

automatic inventories of library contents when the library powers
up or when the library door is opened and closed.

Note: Automatic Inventory is disabled by default.

5 Select Enable in the Automatic Drive Unload area to cause the

library to issue unload commands when host applications issue
move media commands to the library. If you set this to Disable,

181



Chapter 3: Configuring Your Library

Setting Up Policies for the Physical Library

182

proper library operation requires host applications to issue unload
commands to the drives. Automatic Drive Unload is enabled by

default.

Note:

The Logical SN Addressing area is available only to CSEs.
You cannot enable or disable logical serial number
addressing for drives. If a CSE enables this feature, the
library assigns logical serial numbers to all drives in the
library. Specifically, the library assigns a logical serial
number to a drive in a specific location. This is not the serial
number of the particular drive. If a drive is replaced by
another drive in the same library location, the logical serial
number remains the same. From the host’s perspective, the
replacement drive is the same as the original one.

6 Select Enable in the IPv6 area to enable the Network
Configuration dialog that you can use to configure the settings for
an IPv6 network connection.

Note:

IPv6 is disabled by default.

Note:

Enabling IPv6 adds a sub-menu to the Network
Configuration command on the Setup menu that you use
to display the IPv4 or IPv6 Network Configuration dialog.

7 Select Enable in the Extended I/E area to enable the Extended I/E

feature.

Note:

Extended I/E is disabled by default.

Note:

Extended I/E allows the user the capability to increase the
number of I/E slots presented to the host. For more
information, refer to I/E Station Options on page 26

Select Enable in the EKM Path Diagnostics area to enable

Encryption Key Management background diagnostics.

The diagnostics test determines whether the EKM servers are
connected and operating properly. The test runs in the background
at regular intervals and generates a RAS ticket if key server
connectivity issues are found. For more information about the tests
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included in the diagnostics, see Using EKM Path Diagnostics on
page 309.

Default configurations are as follows:
* Q-EKM — Not available.

* SKM — Enabled by default. You can disable it for SKM but it is
not recommended unless directed by a service technician. The
background diagnostic should always be enabled so the library
can monitor SKM server status and report issues as soon as they
arise.

* KMIP key managers - Enabled; cannot be disabled.
9 When finished, click OK.

Specifying the Date and Time

You can use the Date and Time command to set or reset the system
time. If you want to synchronize the library over a network, you can use
the Network Time Protocol (NTP) setting. The default date and time is
Greenwich Mean Time (GMT).

To set the date and time or to use NTP:
1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Date and Time. The Date and Time dialog box
appears.
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+ Date and Time @

- NTP Setting:

NTP: ) Enable/ ® Disable
Primary Server:
Secondary Server;

Tertiary Server:

r Date:

|December v|.u’|‘|0 v|:r 201 S

r Time:

[8 w]:[21 »|:[23 =|[PM ~|

r Time Zone:

(GMT+00:00) GMT (GMT) -

[ oK ] [ Cancel ] [ Help J

4 In the NTP section
* If you choose to enable NTP, click Enable.
The Date and Time sections of the dialog box are grayed out.

* Type valid IP addresses for the Primary Server and optionally
the Secondary Server and Tertiary Server.

* If the DNS Server has not been configured in the LMC, type
valid numeric IP addresses that are accessible from the
library (example 111.11.11.111). Go to step 7.

* |If the DNS Server has been configured through the LMC
(Setup > Network Configuration > DNS Configuration),
type the valid alpha/numeric IP Addresses that are accessible
from the library. Go to step 7.

* If NTP is enabled and you no longer want to use this setting,
click Disable.
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If you choose to disable NTP, you must manually set the date
and time. Go to the next step.

Use the Date drop-down lists to select the month, date, and year.

6 Use the Time drop-down lists to select the hour, minute, and
whether the time is A.M. or P.M.

7 Use the Time Zone drop-down list to select the appropriate time
zone.

The default time zone is GMT. The time zone that you select appears
only on your library information panel. Regardless of your selection,
the system operates on the GMT zone.

8 Click OK.

Configuring E-mail

The library uses the e-mail settings on the Email Configuration dialog
box whenever library e-mail services are used, such as when you use the
Send command to e-mail snapshots or logs and when the library
automatically sends e-mail notifications of library problems.

- Email Configuration

[¥| Enahle Email Configuration:

SMTP Server: |xx.xxx ey

Authentication: () Passward ® MNone

Sender Address: |xxxx,@quantum.c0m |

F-“t Current Configuration

Recipient| [ Testemail |

| QK || cancel || Help |

Use the procedures in the following subsections for:
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Setting Up or Changing the E-Mail Configuration on page 186

Testing the Current E-Mail Configuration on page 187

Note: Any undeliverable emails will be sent to the email address listed

in the Contact Information tab of the System Setup
Notifications dialog. See Setting Up E-mail Notifications on
page 188. If the email addresses in the Contact tab of the
Notifications dialog and the Email Notifications dialog are the
same, the email will ‘bounce’ (ie, undeliverable) and fail to be
delivered.

Setting Up or Changing To set up or change the e-mail configuration:

the E-Mail

1
Configuration

2

186

Log on as an administrator.

Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

Click Setup > Email Configuration. The Email Configuration
dialog box appears.

In the SMTP Server text box, type the iPv4 or iPv6 address of the
SMTP server (for example, 192.16.96.201).

Caution: You must identify the SMTP server by its server address.

If your SMTP server requires authentication of accounts and
passwords, select Password in the Authentication field. If it does
not, select None.

In the Account text box, type the name of a valid account on the
SMTP server (for example, Jay.User).

Note: The Account text box is not available if None is selected in
the Authentication field.

In the Password text box, type the password for the account that
you specified in the Account field.

Note: The Password text box is not available if None is selected
in the Authentication field.
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In the Sender Address text box, type an e-mail address for the
library (for example scalari6O00@mycompany.com).

The library uses this address in the From field of e-mail messages
that it sends out, indicating the originator of the message. For
example, if you type scalari6000, the library appends the domain
information (for example, @mycompany.com). If you type
scalari6000@mycompany.com, the library does not append any
additional information.

To test the e-mail configuration, type an e-mail address in the
Recipient box of the Test Current Configuration area and click Test
email.

Confirm that the library displays a message indicating that the test
completed successfully and sends a test message to the specified e-
mail address.

The subject of the test message should be Test email from Scalar
i6000 and the message text should include the library name,
version, and serial number, along with the date and time that the
message was sent.

To finish, click OK.

Testing the Current To test the current e-mail configuration:

E-Mail Configuration
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2

Log on as an administrator.

Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

Click Setup > Email Configuration. The Email Configuration
dialog box appears.

Type an e-mail address in the Recipient box of the Test Current
Configuration area and click Test email.

Confirm that the library displays a message indicating that the test
completed successfully and sends a test message to the specified e-
mail address.

The subject of the test message should be Test email from Scalar
i6000 and the message text should include the library name,
version, and serial number, along with the date and time that the
message was sent.
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6 Click OK to close the Email Configuration dialog box.

Setting Up E-mail Notifications

Table 28 Severity Levels
Assigned to Issues

You can set up notifications in the LMC so that the library automatically
sends an e-mail message to specified e-mail addresses whenever an
issue of a particular severity level occurs. The information in the e-mail
notification provides details about the issue and the library conditions at
the time of the error.

Note: Before you set up notifications, you must configure e-mail in
the LMC so that the library can send notifications to the
recipients. See Configuring E-mail on page 185.

Table 28 describes the severity levels for which the library can send
notifications if e-mail addresses are set up appropriately to receive
them.

Severity Level Description

1 (Failed) Indicates that a failure has occurred or a different serious condition exists within a

library subsystem that requires immediate corrective action. In most cases, a
hardware component is no longer functioning at an acceptable level or has failed.
Typical library operations are either impossible or highly unreliable.

Examples of failure situations include a FRU that is not functioning, a temperature
threshold that has been reached that causes unreliable operations, or a partition
that the library has automatically taken offline.

2 (Degraded) Indicates that a degraded condition exists within a library subsystem that impacts

system performance or redundancy. Typical library operations can continue
without immediate corrective action, but an administrator should investigate the
condition and correct the problem soon.

Examples of degraded situations include a redundant power supply that has failed
or a connectivity problem that has caused host port failover to occur.

188
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Severity Level

Description

3 (Warning)

Indicates that a condition exists within a library subsystem that has little effect on
system operations. Typical library operations can continue without immediate
corrective action, but you should investigate the condition and correct the
problem when possible. Warnings also can provide helpful information, such as
indicating that a door is open.

Examples of warning situations include a FRU that is functioning less reliably or a
temperature threshold that has been reached that does not affect reliable
operations.

The body text in the e-mail notification provides details about the issue
and library conditions at the time of the event. The e-mail notification
also includes an attachment, referred to as a repair page, that provide a
problem description and corrective actions you or a customer service
engineer (CSE) can perform. For more information about e-mail
notifications, see E-mail Notifications on page 47.

Note: If the email addresses in the Contact tab of the Notifications
dialog and the Email Notifications dialog are the same, the
email will ‘bounce’ (ie, undeliverable) and fail to be delivered.

To set up e-mail recipients for notifications, perform the following steps:
1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Notifications > System Setup. The System Setup
Notification dialog box appears with the Contact Information tab
displayed.
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B System Setup Notifications - p—

Contact Information | Rules rHeartbeat

Enter the information of the person to contact regarding this library.

Contact Name:

Company Mame:

| E-mail Address:

| |
| |
Phone Number. | |
| |
| |

System Description:

( ok ] [ ciose | [ Hep ]

4 Enter the contact information you want included in an e-mail
notification if an error occurs in the library.

=

5 Click OK. A message is displayed asking you to perform a Save
Configuration operation.

6 Click Yes. The Save and Restore Library Configuration dialog box
appears.

7 Click Save and then save the file to a desired location. The
configuration is saved.

8 Click Close.
Set up the rules.

a Click Setup > Notification > System Setup. The System
Setup Notification dialog box appears with the Contact
Information tab displayed.

The Notification dialog box displays the Rules tab.

This dialog box shows all notification recipients that are set up
currently in the LMC. By default, the only e-mail address to
which the library sends e-mail notifications (severity level 1
[Failed] issues only) is techsup@quantum.com (Quantum
technical support), as shown in this Notification dialog box
example.
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Severity Code

Send Email To

Severity 1
Severity 2
Severity 3

techsup@ quantum.com

(Cceae J(

[ ok | [ Close | [ Hep ]

Quantum Scalar i6000 User’s Guide

Note: Even though you can remove the Quantum technical

support e-mail address so that Quantum does not receive

severity level 1 notifications, Quantum recommends that
you do not remove it. Also, do not include the Quantum
technical support e-mail address for severity level 2 or 3
notifications.

Note: The remaining steps in this procedure guide you through

setting up new e-mail notification recipients. To delete an
existing e-mail address, click the e-mail address in the Send

Email To column, and then click Delete.

10 To set up a new e-mail notification recipient, click Create. The New
Email Notification dialog box appears.
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B New Email Notification | 23 |

Email Address:

Severity 1
Severity 2
Severity 3

Choose Severity:

[ : J [ Cancel ] [ Help ]

" 4

11 In the Email Address text box, type the e-mail address to which you
want to send notifications.

Note: Do not enter more than one address in the Email Address
text box. Continue to Step 7 and Step 8 for this address,
and then repeat Step 5 through Step 8 for each additional
address.

12 In the Choose Severity box, click the severity level you want to
assign to this e-mail address.

Note: If you are using the remote client LMC, you can assign
more than one severity level. While pressing the Ctrl key,
click the severity levels you want to assign. The touch
screen on the library enables you to select only one severity
level.
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13 To accept this notification setup, click OK. The System Setup

Notification dialog box reappears.

14 Setup the heartbeat.

.

B System Setup Notifications

a Click Setup > Notification > System Setup. The System
Setup Notification dialog box appears with the Contact
Information tab displayed.

The Notification dialog box displays the Heartbeat tab.

This tab allows users to assign an email address to notify
someone of the status of the library at regular intervals. Users
can designate the interval in minutes.

(=3 )

——

( ContactInformation | Rules | Heartbeat

You can configure sutomatic library heartbeat notification via e-mail to receive library heartbeat
updates in regular intervals. Multiple e-mail recipient entries must be separated by s semicolon (;).
NOTE: A valid interval can be set between 1 to 720 minutes. An entry of 0 disables the heartbeat.

E-mail Recipients: |

Interval (Minutes): lj

[ ok ][ Closei] [ Hep |

_ J

1

5 After you finish setting up all notifications, click OK.

193



Chapter 3: Configuring Your Library
Setting Up Media Security Notifications

Setting Up Media Security Notifications

Note: You need an Advanced Reporting License installed on the
library in order to use media security notifications. See Enabling
Licenses on page 123.

You can configure the library to automatically notify you via a RAS ticket
when media is moved in or out of the library, either intentionally or
unintentionally. First, you must choose under which circumstances you
wish to be notified, and then you must enable automatic inventory on
the library.

1 Log on as administrator.

2 Click Setup > Notifications > Media Security. The Media Security
Notifications dialog box appears.

: Media Security Notifications @

rEnable/Disable Security Options

[¥ Unexpected Remoaval Detection After Power-up and Reboot Only
[¥ Unexpected Removal Detection During Library Operation
[[] Expected Removal Detection From VE Slots During Library Operation

[¥l Unexpected Removal Detection From VE Slots During Library Operation

oK | cancel Help

3 Check the box to the left of your media security notification choices.
You can select as many as you want:

* Unexpected Removal Detection After Power-up and Reboot
Only — Media were physically removed from the library when it
was powered down.

* Unexpected Removal Detection During Library Operation —
While library is powered up someone opens the door of the
library and removes media.

* Expected Removal Detection From I/E Slots During Library
Operation — Media are exported to the I/E (via backup

194 Quantum Scalar i6000 User’s Guide



Quantum Scalar i6000 User’s Guide

Chapter 3: Configuring Your Library
Setting Up Media Security Notifications

application or LMC) and are then physically removed from the

I/E station.

* Unexpected Removal Detection From I/E Slots During Library
Operation — Someone puts media in the I/E station for import,
the robot scans the media, and then the media are physically
removed from the I/E station.

Click OK to close the dia

log.

From the main console, select Setup > System Settings > Physical
Library. The Physical Library dialog box appears.

Physical Librar)ij ’ i e H 4 -

S

rAutomatic Inventory

) Enable| (® Disable
rAutomatic Drive Unload

{® Enable ) Disable
rLogical SN Addressing

® Enable {_) Disable
riPve

{® Enable () Disable
rExtended IE

) Enable (® Disable

rEKM Path Diagnostics

EKM Heartbeat Interval: |10 (0-60 minutes, 0 to disable.)

rSend Usage Statistics

®) Enable

) Disable

][ Cancel J[ Help J
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Viewing the Media
Security Events Report

6 For Automatic Inventory, click Enable.
7 Click OK.

You can view a report of media security events by selecting Tools >
Reports > Media > Security.

The log displays events which met the criteria you selected in the Media
Security Notifications dialog box (see Setting Up Media Security
Notifications on page 194).

Configuring Devices

196

You can change the way library components appear to the hosts. The
Setup > Device command enables you to change the way system
components appear to the hosts.

The Setup > Drives > SCSI IDs command is available while viewing a
partition. Use this command to set the SCSI ID for a SCSl-attached drive.
All hosts that view the drive will see the same SCSI ID associated with
the drive.

The Setup > Drives > FC Settings command is available when viewing
the physical library and allows you to configure speed, topology, or
Loop ID for a Fibre-attached drive.

The Setup > Blades > Access command gives you access to the
Channel Zoning, FC Host, and LUN Mapping Wizard commands,
which are available while viewing the physical library.

The Setup > Drives > Access > SNW Wizard is available when viewing
the physical library and gives you access to the SNW Drive Licenses,
Control Path, Data Path Failover, and Host Access.

* Use the Channel Zoning command to restrict host access to
particular I/0 blade ports.

* Use the FC Host commands to configure access to partition
accessors and drives on a per-host basis. If you have connected your
host to the FC port on the MCB, or to a port on one of the FC I/O
blades, you must map the appropriate partitions by using the FC
Host command. If you have connected your hosts directly to the
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drives, use third-party software of your choice to manage media
from the host itself.

* Use the SNW Wizard to select the drives you want managed by the
Storage Networking (SNW) feature. The selected drives can be
configured so client hosts can be granted or denied access. Only
IBM or HP LTO-5 or later drives are supported. Each drive selected
will consume a SNW license.

* Use the LUN Mapping Wizard command to set up LUN Mapping for
your Fibre Channel hosts

If you have not otherwise restricted access, FC Host has full control of
all LUNs on all FC and SCSI channels. Each FC host attached to an FC /O
blade can be configured to access a maximum of 255 LUNSs, up to an
overall system total of 2,048.

Configuring Drive SCSI ID

From a partition, you can change the SCSI ID for a SCSl-attached drive.
For example, the default SCSI ID for a drive that you are installing might
conflict with the assigned SCSI ID of an existing drive. You might be
using an application that expects to communicate with a device at a
specific SCSI ID, but that ID might already have been configured for use
in another partition. Use the Setup > Device > IDs command to correct
these situations.

1 Log on as an administrator.

2 Make sure that you are viewing the partition that includes the drive
you want to configure. From the View menu, click the name of the
appropriate partition.

3 Click Setup > Drives > SCSI ID’s. The SCSI ID’s dialog box appears.
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[ ] SCSlID's (x]

Select Device: (Drive-1,1, 1, 10, 1, 1 v|

Target 1D:

Current 1D: 6| MNewlD: |6 -

[ ] L Close J [ Help J

4 Select the drive who's SCSI ID you want to change from the Select
Device drop-down list. The drop-down list uses the drive’s location
coordinates to identify the drive.

For example, in the figure above, the drive is in position 10. The
following figure shows its location in the control module. For more
information about location coordinates, see Understanding
Location Coordinates on page 457.
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5 To specify a particular ID for a drive, click a new ID number from the

New ID drop-down list.
6 Click Set.
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Configuring Fibre Channel Drive Speed, Topology, and
Loop ID

Administrators can view and modify Speed, Topology, and Loop ID
settings for Fibre Channel tape drives.

If the affected partition is online, it will be taken offline before the
parameters are set, and brought back online after they are set.

1 Click Setup > Drives > FC Settings. The Drive Settings dialog box
appears.

The Drive Settings dialog provides the capability to configure the drivels)speed and connection parametars and alzo the

drives loop 1D.

MOTE: To change a drives settings the drive must be online and unloaded. Drives that are configured for Data Path

Failower must hawve the topology mode set to Paoint to Paint.

Partition Filter

[ [an ~]

Select Drives
[_] Select All | Changed [ Unavailable [ | Success MM Failed

Select | Serial Number Speed Topology Loop ID Location
0 |Foo1234001 |Auto v||Loop v||Soft v| 1,1,1,1,1,1
[ |Footlz234007 |Auto - | | Point to Point - | | Soft - | 1,1,1,2,1,1
0 |Foo123400D |Auto v||Loop v||Soft v| 1,1,1,3,1,1
7 |Foo1234013 |Auto v||Loop v||Soft v| 1,1,1,4,1,1
0 |Foo1234028 |Auto v||Loop v||Soft v| 1,1,1,8,1,1

4] »

[ ] [ Cancel J [ Help J

2 From the Partition Filter drop-down list, select all partitions or a
single partition whose drive settings you want to set.

3 Configure the settings as described below:
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Speed

The requested interface speed can be set to Auto (default;
autonegotiates to highest speed possible), 1 Gb/s, 2 Gb/s, 4 Gb/s, or 8
Gb/s (depending on drive type).

Caution: LTO-5 and later Fibre Channel tape drives can be
configured for speeds of up to 8 Gb/s. If they are
configured for 8 Gb/s, you should connect them directly to
a host and not to an FC I/O blade, because the FC I/O blade
only allows speeds up to 4 Gb/s. If you connect an LTO-5 or
later Fibre Channel tape drive to an FC I/O blade, you must
configure the tape drive speed of 4 Gb/s or less.

Note: The speed settings you choose are requested, not actual. If the
requested speed setting is not supported, the next appropriate
setting is negotiated.

Topology

The requested topology connection mode can be set to one of the
following:

* Loop (default) — Force L-Port
* Loop Preferred — Auto-configure trying L-Port first

¢ Point to Point — Force N-Port

Notes about point to point

* You can use Point to Point if the tape drive is connected via a switch
or directly to a host.

* You cannot use Point to Point if the tape drive is connected to an FC
I/O blade.

* You must use Point to Point if the tape drive is being used for
control path failover (see Configure Control Path on page 359).
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Loop ID

You can only set Loop ID when the Topology is set to Loop. You cannot
set the Loop ID if the Topology is set to Point to Point or Loop Preferred.

The loop ID can be set to Soft (default) or to a value from 0 to 125.
When set to Soft, a unique loop ID is selected for the drive. If you
change the Loop ID to a specific value, make sure that each FC tape
drive has a unique loop ID.

Configuring Fibre Channel I/O Blades

FC Host

202

The FC Host command enables you to manually modify host
information and set LUN mappings.

During device discovery, a particular partition or drive could map to a
higher LUN space than is optimal for a particular application. The FC
Host command enables you to create a virtual private remapping of
available LUNs for a specific Fibre Channel-attached host. LUN mapping
is required to give hosts access to partitions and devices. You also can
make devices appear to the host as if they were at lower LUNs in order
to optimize system performance.

Note: Use the FC Host command to map partitions when a Fibre
Channel host is connected either to the MCB or to an I/O blade.

Depending on host operating system constraints, it might be necessary
to reboot or reconfigure the host because of device map changes that
result from using the FC Host command.

Caution: If you change LUN mapping after host computers or
applications have already discovered devices, you must
make sure that device discovery occurs again. Device
discovery occurs automatically when you reboot the library.
Some host computers have plug and play capability, which
discovers devices automatically. In general, host
applications do not discover devices automatically.
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Note: EEBs connected to drives configured with a control path may
report certain library ready conditions differently than drives
without a control path configured.

Accessing FC Hosts

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Blades > Access > FC Host. The FC Host dialog box

appears.
' '
B FC Host ——— 5]
Selecta host:
Name | Type Port WWN | Status| Bl

unknown |unknown unknown |210100e0:8ba9ea76 |Online |QUANTUM FC IOE
unknown |unknown |unknown [210100e0:8ba13f61 |Online JQUANTUM FC IOf

[ Create ][ ][ Delete ]
| [ conwenns J[ Reesn | ciose | Hep |

. — — — J

Only the host’s port, blade, and World Wide Name (WWN) appear.

Note: Clicking Refresh allows you to update the current state of
the host devices.

Adding, Modifying, and Deleting FC Hosts

You can add and configure FC hosts without powering down the
system. Manually add an FC host if it was not already connected to the
library when it was turned on.
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Adding an FC Host
1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Blades > Access > FC Host. The FC Host dialog box
appears.

4 Click Create. The Add Host Data dialog box appears.

5 Use the check boxes under Select Blades to select at least one blade
that the host will access.

6 Using the text boxes provided, provide the following required
information:

* In the Name text box, type a host device name.

* From the Type drop-down list, click the appropriate host type by
operating system.

* In the Port text box, type the host device port.

Note: The Port field can be used for any free-form text to help
better describe the connectivity. This field otherwise has no
configuration functionality.

* In the WWN text box, type the host device World Wide Name
(WWN).

7 Click OK.

Modifying an FC Host

1 With the host selected in the FC Host dialog box, click Modify. The
Host Configuration dialog box appears.
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Host Configuration

Mame: [KINGFISHER |

Type: |LINU}{ | ~|
Port:  [FC5 |
WA

| QK | | Cancel | | Help |

2 As necessary, change the information in the Name and Port text
boxes, and then click the appropriate host type by operating system
from the Type drop-down list. You cannot change the World Wide
Name (WWN).

Caution: You also must make the necessary physical changes to
the name, operating system, or port connection.

3 Click OK.

Deleting an FC Host
1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Blades > Access > FC Host. The FC Host dialog box
appears.

Note: FC hosts can be reconfigured without powering down the
system.

Click the host from the list, and then click Delete. A message
appears that asks you whether you want to delete the host.

Note: The Delete button is unavailable if the host is online.

4 Click Yes. A message appears that indicates a successful deletion.
5 Click OK.
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Channel Zoning Channel zoning, also called port zoning, is an optional feature that
configures access to an entire Fibre Channel and all the LUNs on that
channel for the exclusive use of a host or group of hosts on a single
port. Channel zoning enables you to control access between specific
target Fibre Channel (FC) ports and initiator channels on an I/O blade in
your library. If you make changes to the channel zoning settings, you
must reboot the I/O blade for the new settings to take effect.

Caution: If you change channel zoning after host computers or
applications have already discovered devices, you must
make sure that device discovery occurs again. Device
discovery could occur automatically when you reboot the
library. Some host computers have plug and play capability,
which can discover devices automatically. Host applications
might discover devices automatically.

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Blades > Access > Channel Zoning. The Channel
Zoning dialog box appears.

Channel Zoning x|

Selectan 10 Blade

MName | Location |
FCICOB
FCICE
FCICOE

N
e
1

[N

4 Click the I/0O blade you want to configure to highlight it.

The same I/O blade may appear multiple times in the list depending
on the number of hosts assigned to the I/O blade. You only need to
select one instance of the blade to zone the entire blade.
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5 Click Configure. The Channel Zoning Settings dialog box appears
for the selected I/O blade. By default, all FC ports have access to all

channels.
Channel Zoning Settings - ADIC  FCB 1,1,1,1,4 1'
Check channel box to allow access
Fibre Fibre Fibre Fibre

@ SAN Connections Channel 3 | Channel 4 | Channel & | Channel &

Fibre Channel 1 [v] [v] v [v]

Fibre Channel 2 [v] [v] v ¥

| 0134 | | cancel | | Help |

6 If you want to permit access, select the check box in the cell where

the target port and the initiator channel meet. If you want to
restrict access, clear the check box in the cell where the target port
and the initiator channel meet.

If an FC port is set to target and initiator mode, the port appears in
both the horizontal row and vertical column. To prevent ghosting,
the FC port is not allowed access to itself. Ghosting is a condition
where hosts can see storage in two places.

Caution: When you select a check box in the cell, the entire
channel is zoned. This zoning affects any host that
might being accessing the I/O blade. Channel zoning
settings supersede any host LUN mapping on the I/O
blade.

7 To continue, click OK.

8 You must reboot the I/O blade for the new configuration settings to
take effect. In the Attention dialog box, click Yes to proceed. If you
do not want to continue with the configuration, click No.

9 After you complete your configuration changes, click Close.

FC Host LUN Mapping Use the FC Host LUN Mapping dialog box to give a selected host access
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Configuring LUN Mapping

1
2

Log on as an administrator.

To ensure you are working from the physical library, from the main

console, select View and click the name of the physical library.

Click Setup > Blades > Access > FC Host. The FC Host dialog box
appears.

Select a host on the FC Host dialog box, click LUN Mapping. The FC
Host LUN Mapping dialog box appears in its default view.

FC Host LUN Mapping - se42¥WHOL ﬂ
View
# To map a device to an external LUN: Select an internal device LUN, select the left arrow,
and then select the desired external LUN.
# Toremowve an external LUN mapping: Select an extarnal device LUN, and then select the
right arrows.
LUN External LUN Internal LUN
1] 0 Control LUN =
1 3 hpuxL1f
2 4 win03L1f
3
4
5
6
7
8 —|
-
| QK | | cancel | | Help |
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This dialog box displays all partitions and drives connected to the
blade to which the host is attached.

Note: If you delete a partition that is currently displayed on the
FC Host LUN Mapping dialog box, the internal LUN and
any external LUN mappings for the partition will no longer
appear on the dialog box.
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Note: If a partition is already presented via Control Path it will
not show up in the list of internal LUN devices.

5 Compare the default view with the Show Details view shown in the
following figure. To change from the default view to the detailed
view, see Setting the View for the FC Host Device Column on
page 213.

x

View

# To map a device to an external LUN: Select an internal dewice LUM, select the left arrow,
and then select the desired external LUN.
# Toremove an external LUN mapping: Select an external device LUN, and then select the
right arrow.
LUN ‘ External LUN Internal LUN
1] 0 Control LUN |~
1 3 hpuxLif
Product ID = Scalar
i2000

Vendor ID = ADIC
Serial Mumber =
203100004 _LLO

4 win03LAf

Product ID = Scalar i2000
Vendor ID = ADIC

Serial Number =
203100004_LL1

-

| QK | | Cancel | | Help |

In this figure, the Internal LUN column has been scrolled down. The
Show Details view for partitions shows the partition name, product
ID, vendor ID, and the serial number of the partition. For drives, the
LMC displays the device LUN, connection type, port connection,
vendor ID, serial number, and the associated partition.

The following table describes the descriptors that appear in the
Show Details view for partitions.
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Table 29 Show Details

Descriptor

Description

Partition Name

Name assigned during partition creation process.

Product ID

The Product ID setting controls the product ID string that is returned in a
standard SCSI INQUIRY response. The library can report that it is a Scalar i500,
Scalar i2000, or Scalar i6000. This feature can enable the library to be used
with host applications that do not yet include the Scalar i6000 in a list of
recognized devices. In addition, the various Microsoft Windows operating
systems maintain a list of recognized devices. If the Scalar i6000 is not in an
operating system’s list of recognized devices, the library will appear as an
“unknown” device in device lists. You might prevent the library from being
listed as “unknown” by setting Product ID to a library other than Scalar i6000.
This setting does not cause any library operational changes other than the SCSI
INQUIRY response.

Vendor ID

ADIC or QUANTUM (default is QUANTUM).

This information is used in the SCSI Inquiry command. Some backup
applications may only support or be configured for ADIC libraries, so if you
configure a logical library using the vendor ID of QUANTUM, the backup
application would not work with the library.

Serial Number

Partition ID, as shown by Monitor > System > Components tab.

The following table describes the descriptors that appear in the Show
Details view for drives.

Table 30 Descriptors

Descriptor

Description

[Number] [Connection
Type] [Port
Connection]

[LUN] [Fibre or SCSI] [Port Number].

Vendor ID

Drive manufacturer.

Serial Number

Drive serial number.

Partition

Name of the partition with which the drive is associated.
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In the default view, only the names of available partitions and the
names of the devices (drives) are shown. LUN spaces from 0-255 are
available. In the Show Details view, a partition that has not yet
been manually reassigned to a new map position appears in heavy
black type in the Internal LUN column. Partitions are treated by the
system as devices. You must assign a partition to the LUN/External
LUN column for the LMC to manage it and its media. In this
example, the control LUN has already been remapped as shown in
heavy black type in the LUN/External LUN column.

If you are working from the local touch screen, you must select an
internal device LUN, select the left arrow, and then select the desired
external LUN. If you are working from the remote client, you can use
the select method or you can drag and drop the devices from the
Internal LUN column to the appropriate LUN assignment in the
LUN/External LUN column. Always use LUN 0 for command and
control.

In the following figure, all devices have been mapped manually.

# To map a device to an external LUN: Select an internal device LUN, select the left armow,
and then select the desired external LUN.
# Toremove an external LUN mapping: Select an external device LUN, and then select the

right arrou.

LUN External LUN Internal LUN

1]

1

3

0 Control LUN
3 hpuxL1r

4 win03L1f

-

| QK | | Cancel | | Help |

The new map locations appear in heavy black type in the LUN/
External LUN column. The previous (default) device map position of
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a remapped device is shown in gray type in the Internal LUN
column.

7 To save the mapping, click OK. The FC host map is automatically
saved as part of the configuration.

For more information about device numbering in a SAN context, see the
Online Help.

Modifying FC Host Mapping

When a device has been mapped, it is still listed, though unavailable, in
the Internal LUN column.

In the following figure, the LUNs are not currently available for mapping
because they have already been mapped into the LUN/External LUN
column.

FC Hosk LUN Mapping - sed42WHQL 1'
View
# To map a device to an external LUN: Select an internal dewice LUN, select the left arrow,
and then select the desired external LUN.
# Toremowve an external LUN mapping: Select an external device LUN, and then select the
right arraw.
LUN External LUN Internal LUN
0 0 Control LUN |~
1 3 hpuxLif
2 4 win03L1f
3
4 ==
5
6
7
8 =
-
| QK | | Cancel | | Help |

The device that was formerly found at assigned LUN 4 is now found at
assigned LUN 2. Drag it back into the Internal LUN column to make it
available for re-mapping. If you are working from the local touch
screen, select an external device LUN, and then select the right arrow.
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Setting the View for the FC Host Device Column

Click View at the top of the FC Host LUN Mapping dialog box. If you
want to see product details, select the Show Details check box. If you
want to see only the names of the devices available for mapping, clear
the Show Details check box to toggle the display back to the default
view.

Using the LUN Mapping Wizard

LUN mapping is required to give hosts access to partitions and devices.
You can also make devices appear to the host as if they were at lower
LUNs in order to optimize library performance.

The LUN Mapping Wizard guides you through the setup of LUN
mapping for your Fibre Channel hosts.

Note: If you want to manually assign a target LUN, or want to add/
modify/delete the host, select Setup > Blades > Access > FC
Host on the menu bar. For more information, see FC Host on
page 202.

The LUN Mapping Wizard automatically assigns sequential numbers for
the external LUN of each mapped device, without any gaps between
them per blade. When using the LUN Mapping Wizard, the LUN for
some devices may change even if you did not specify the changes. If a
control LUN is mapped, it is always assigned LUN 0.

Depending upon host operating system constraints, it may be necessary
to reboot or reconfigure the host as a result of device map changes
resulting from the use of the LUN Mapping Wizard.

1 Click Setup > Blades > Access > LUN Mapping Wizard. The LUN
Mapping Wizard — Overview dialog box appears.
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LUN Mapping Wizard - Overview 1[

Thizwizard will walk vou through setting up the LUN mapping for your fibre
channel hosts. It follows these steps:

# Chooze the host

Library # Choose the partition
Internal Lun # Choose the blade
# Map/Unmap devices
External Lun # Repeat above steps if necessary
# Finizh and commit changes
Upan finish, the wizard will automatically assign sequential numbers for the
i external LUN of each mapped device such that there's no gap between them

per blade. Therefore it is possible forthe LUN of some devices to change even if
wou did not explicithy call for the changes. If a control LUN iz mapped, it will
always use LUN 0.

If you would like to manually assign target LUN, orwould like to

addimodifyfdelete host, please choose Setup/Deviceffccess’FC Host from the
menu bar.

Hosts

| Mext = || Cancel || Help |

2 Review the LUN Mapping Wizard Overview, then click Next to
continue. The LUN Mapping Wizard - Select Host dialog box
appears. All available hosts are listed on this dialog box.

x
To add/modifwtdelete host, please choose Setup/DevicedAccess/FC Host from the menu bar.

Host Mame | Type | Fort | AR | Status | |
fon WINDOWWS 123 1234567 3:1234567h Offline
Ken WD OWWS 12 1234567 8:23456789 Offline
Unkn o unknown unknown 210000e0:8h0desch Online

3 Select a host to configure and then click Next to continue. All
available partitions on the selected host are listed on this dialog
box. The LUN Mapping Wizard — Select Partition dialog box

appears.
x|
LUM Mapping - Ken
Partition MName | Status | Media Type | Interface | #Drives | |
TEST O Online SOLTEO0 FC 1
TEST 1 Online SOLT320 SCSI 1
TEST 2 Online LTC: Mixed FC 2
TEST 3 Online LTO: Mixed FC 2

4 Select a partition to configure and then click Next to continue. All
available blades on the selected partition are listed on this dialog
box. The LUN Mapping Wizard — Select Blade dialog box appears.
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[ 'LUN Mapping Wizard - Select Blade ll
LU Mapping - Ken - TEST 2

Blade Location | Firrmweare Wersion | LR | CoLUN | |
MCE 5H00A-GMOOTO1 0

5 Select a blade to configure and then click Next to continue. The LUN
Mapping Wizard - Map/Unmap Devices dialog box appears.

LUMN Mapping Wizard - Map/Unmap Devices 1'
LUK Mapping - ken - TEST 2 - MCE
Check to map the device, uncheck to unmap the device.
[ select Device Description Type ‘ Serial Mumber | T ‘ Partition
[v] Scalari2z000  |(Control LUM  (ADIC203100175_CCL
[¥] TEST 2 Partition 203100175_LLZ
[¥] Offline
[¥] Offline
[v] Offline
[ Offline
[¥] Offline
[v] Offline
| = Back || et = || Cancel || Help |

6 Select the check box to map a device or clear the check box to
unmap a device, then click Next to continue. The LUN Mapping
Wizard — What Next? dialog box appears.
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x
LUM Mapping - Blackhird - LTO2-1,1,1,1, 6,1

Wiould you like to:
() Map another blade

) Map another partition
) Map another host

r Continue and preview all the changes

| = Back || Mext = || Cancel || Help |

7 Select one of the following and click Next to continue:

* Map another blade - this allows you to map another blade on
the same partition.

* Map another partition - this allows you to map another
partition on the same host.

* Map another host - this allows you to map another host.

* Continue and preview all the changes - this allows you to
view an online printout of the change report which presents a
preview of all changes, showing whether you added, modified
or deleted any devices.

8 If your configurations are complete, select Continue and preview
all changes. The LUN Mapping Wizard — Preview All Changes
dialog box appears.

216 Quantum Scalar i6000 User’s Guide



Quantum Scalar i6000 User’s Guide

Chapter 3: Configuring Your Library
Configuring Fibre Channel I/O Blades

'LUN Mapping Wizard - Preview All Changes
rNew Mapped Devices

x|

Device Description | Host | Blade | Device SK | Device WWhH

LTOZ Blackhird [1,1,1,1,6,1 |213100019_LL1

IEM ULTRIUM-TD2-Fibre  |Blackbird [1,1,1,1,6,1 [1100000936 500308c001 382026
[ 2l

rNew Unmapped Devices
Device Description | Host | Elade | Device SM | Device WM
Blackhird 1,1,1,1,6,1

Wiew Change Report

| = Back ||

Finish || Cancel || Help |
9 Prior to finishing and saving your LUN mapping configuration

changes, review your newly mapped or unmapped devices in this
dialog box.

* If you would like to create a report of your changes, click View
Change Report.

If you are satisfied with your LUN mapping changes and want
complete the wizard process, click Finish. Your LUN mapping
changes are finalized, and then you have the option of viewing
the LUN Mapping Report.

made to all devices.

box appears. This dialog box displays what types of changes were

The changes on the report include:

* Added Mapping — (A)

The LUN Mapping Change Preview Report - Print Preview dialog

* Removed Mapping - (R)
e LUN Modified — (M)
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LUN Mapping Report by Host - Print Preview

LUN MupigRepat by Host. DVT14 (a1:213100019)

Devie Desoipton Dewice WWIH Dewie 5H Partitian LUH

Host: Blukhird (WWWI: 21000060 :5h0TE738)
Bhde: 1,1,1,1,61

Dffline - - - 0
LTO3 - 213100019_LLO LTO3 1
=T apped D evices=

Bhude: 1111,41

FCIOB - AMQO01007-0218

LTOL - 213100019_LL2 LTOLl

LTOZ2 - 213100019_LL1 LTO2

LTO3 - 213100019_LLO LTO3

Bhde: 1,1,1,1,61

FCIOB - ANIOO0139-0012

IEM UL TEIUL- TD 2-Fibre 500308c00138a028 1100000936 LTO2

LTOL - 213100019 _LL2 LTOLl

LTOZ - 213100019 _LL1 LTO2

Bhdde: MCE

Scalar 12000 - ADIC213100019

Scalar 12000 - ADIC213100019 -

Acalar 12000 - ADIC213100019_CCL -

LTO1 - 213100019_LL2 LTOL

LTO2 - 213100019_LL1 LTOZ

LTO3 - 213100019_LLO LTO3

10 On the LUN Mapping Change Preview Report — Print Preview
dialog box, you can select the following:

To save the report as a PDF file, click PDF. Specify a file path and
file name, and then click Confirm.

To print the report, click Print. Specify print options, and then
click OK.

To navigate through the pages of the report, click Back or Next.

To increase or decrease the magnification of the report, click
Zoom In or Zoom Out.

To access the Online Help, click Help.

11 After you have reviewed the LUN Mapping Change Preview
Report, click Close to return to the LUN Mapping Wizard -
Preview All Changes dialog box.
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12 If you are satisfied with your LUN mapping changes and want to
complete the wizard process, click Finish. Your LUN mapping
changes are finalized

You have the option of viewing the LUN Mapping Report.

Generating the LUN The LUN Mapping Report lets you view the current LUN configuration
Mapping Report settings for the library. The report displays information about tape
drives and other devices in the library, such as WWN (world wide name),
LUN (logical unit number), and serial number.

When generating the LUN Mapping Report, you can choose to group
devices by the associated host or by the associated partition.

Viewing the LUN Mapping Report

To view the LUN Mapping report, first choose a grouping criteria, then
view the report.

1 On the menu bar, click Tools > Reports > LUN Mapping. The Report
Criteria dialog box appears.
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Report Criteria
Specify Report Criteria:

® Group by Host

) Group by Partition

| Wiew || Cancel || Export.. || Help |

2 Under Specify Report Criteria, click a grouping option.

* Group by Host — The report lists the devices associated with
each host.

* Group by Partition — The report lists the devices associated
with each partition.

3 Click View. The Print Preview dialog box appears. Figure 41 on
page 221 shows an example of a LUN Mapping Report grouped
by host.
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Figure 41 LUN Mapping
Report grouped by host
preview

LUN Mapping Report by Host - Print Preview

LUM Migping Repet by Host Ty (e 213100002

Device Descriptim Device VWWH Devie 5N Prrtition. LUw

Haost: unlawvn (WWH: 21000060:5hi9eaTt)
Bhde:  1,1,11,4,1

Scalri2000 - AMQUO2753-0051 - 0
IEM UL TRIUM-TD 3-Fihre SO030BcO0138e02c 1210022331 EMIG 1
BN UL TRIUN- TD 3-Flhre SO0308c001386037 1200004347 EMIG 3
IEM UL TRIUN TD 3-Flhre 500308c00138026 1210003615 BMIG 3
IEM UL TRIUM-TD 3-Fibre SO030Bc00138038 1210003564 EM2G 4
EM2E - J13100002_L10 EMIG 5
Host: unbaovn (WWH: 21010060 -SadeaTd)

Bhde  1,1,11,81

ADIE Sealar 23000 - ANUO0DSTLO000 - 0
BM4G - 213100002_LL1 EMAG §
IEM UL TRIUM-TD 3-Fihre S00308c00138020 1210130412 EMAG 7
IEM UL TRIUM-TD 3-Flhre SO0308c00138e00 1200019430 EMAT g
IEM UL TRIUN TD 3-Flhre SO0308c00138014 1200115445 EMAE 9
IBM UL TRIUN- TD 3-Flhre 500308c0013801a 1200019535 EM4G 10
<Unnapped Devices>

Bhde  1,1,11,4,1

EMiG - 213100002_LL1 EMAG

Bhde 1,111,381

BM2G - 213100002_LL0 EMIG

Bhie  MCE

[ calar 2000 - ADICII3100003_CCL -

IBM2G - 213100002_LLO BMIG

EM4G - 213100002_LL1 EM4G
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Figure 42 LUN Mapping
Report grouped by partition
preview

222

Figure 42 on page 222 shows an example of a LUN Mapping
Report grouped by partition.

LUN Mapping Report by Partition - Print Preview @

# \ = . )
1 . - & = &) ] )
Close Print Back Next (Zoom Inf| {| | Eoom Ouf HELP,
LUN MippingRepat by Purtiiom. Ty s 213100002) [
Derie Description Device WY Device SH Elade Ly |
Pariition: BM 26
Host: unknwon (WWNN: 210000¢0: Thigea?6)
IBM UL TRIUM. T3 -File 5003080013803 1310032331 1
B UL TRIUM- TD3-Fhre 300308 33 1210004347 ]
IBM UL TRIUE D 3-Filre 00308 26 1210003615 3
IBM UL TRIUM- TD3-Fhre 0030800138038 1210003564 +
BMIG - 213100002_LLO 5
<Urmnapped D evices>
BMIG 213100002_LLO 111151
EMIG 213100002_LLO !
Pariition: IBM 46
Host: unknwovn (WWN: 210100¢0: Thadea?6)
BM4G - 213100002_LL1 11,1151 6
B UL TRIUN- TD3-Fhre 0030800138020 1210139413 LILLED 7
IBM UL TRIUE D 3-Filre S00308c00138e00: 1200019430 L1,1,1L,5,1 €
IBM UL TRIUM- TD3-Fhre 0030800138014 1210115443 L1,1,1,8,1 o
IBM UL TRIUM- TD3-Flire S00303C00138e0%a 1200019535 LLLLED 10
<Urmnapped D evices>
BM4G 213100002_LL1 L1141
EM4G - 213100002_LL1 MCE
Pariition: <Devices not assoriated with a partition>
Host: unknwon (WWN: 210000¢0: Thigea?s)
Scalar 2000 - AMQUO27S300ST  1,1,1,1,4,1 o
Host: unlwvn (WWN: 210L00€0; Shadea?s)
Scalar 23000 - AMMOOSTIO000  1,1,1,1,8,1 o
<Uranapped D evices>
Scalar 2000 ADIC213100002_CCL MCB
Fage 1071

4 Do one or more of the following:

To navigate through the pages of the report, click Back or Next.

To increase or decrease the magnification of the report, click
Zoom In or Zoom Out.

To print the report, click Print. Specify print options, and then

click OK.

To save the report as a PDF file, click PDF. Specify a file path and
file name, and then click Confirm.
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Note: You cannot print reports or save them to a PDF file using
the touch screen.

5 When you are finished working with the Print Preview dialog box,
click Close.

6 To close the Report Criteria dialog box, click Cancel.

Exporting a Report to an E-mail or a Text File

Instead of viewing or printing the report on the Print Preview dialog
box, you can e-mail the report data to an e-mail address. Or export the
report data to a comma delimited text file (*.csv) for use in other
programs.

1 On the menu bar, click Tools > Reports > LUN Mapping. The Report
Criteria dialog box appears.

2 Under Specify Report Criteria, click a grouping option.

* Group by Host — The report lists the devices associated with
each host.

* Group by Partition — The report lists the devices associated
with each partition.

3 Click Export. The Export Raw Data dialog box appears.
4 Do one of the following:

* To send the report data to an e-mail address, click Email. Type or
select the e-mail address, type an optional comment in the
Comment box, and then click OK.

* To save the report data to a comma delimited text file, click
Save. Specify a file path and file name, and then click OK.

5 To close the Report Criteria dialog box, click Cancel.

Generating the Library Configuration Report

The Library Configuration report lets you view the number of I/E
stations, drives, and storage slots in the library that are currently
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assigned to each logical partition. Generate the Library Configuration
report to help make sure you are using library resources effectively.

1 On the menu bar, click Tools > Reports > Library Configuration.
The Library Configuration - Print Preview dialog box appears.

Library Configuration - Print Preview

CIESSE

»

IE Distribution

[Fere}— y ——fCroiz]

Drive Distribution
\
[Croz=z—.

[Cor=i}—

Storage Slot Distribution

NOT ASSIGNED = 18
.
LTO1=6

LT03=120|—

- LTO2 = 114]

i

TR T T | =

1 1+

Fage 1 of2

2 Do one or more of the following:

224

To navigate through the pages of the report, click Back or Next.

To increase or decrease the magnification of the report, click
Zoom In or Zoom Out.

To print the report, click Print. Specify print options, and then
click OK.

To save the report as a PDF file, click PDF. Specify a file path and
file name, and then click Confirm.
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Note: You cannot print reports or save them to a PDF file using
the touch screen.

3 When you are finished working with the Library Configuration -
Print Preview dialog box, click Close.

Configuring Drive Cleaning

Quantum Scalar i6000 User’s Guide

When you create or modify a partition, you can specify that tape drives
in that partition be cleaned each time the library requests a cleaning
operation.

For drive cleaning to function, you must configure it for the library. To
configure drive cleaning, first assign cleaning magazines, and then
import cleaning media. Designated cleaning media can also be used
when manually cleaning drives. (Cleaning magazines and media are not
part of any logical partition, and so are not visible to the host
application).

If cleaning magazines are no longer needed, you can unassign them. In
addition, you can export expired cleaning media to remove it from the
library.

Note: Slots configured for drive cleaning affect the number of
licensed COD slots.

Note: Drive cleaning should be enabled for partitions only if the host
application does not support the coordination of drive
cleaning. If drive cleaning functionality is enabled on the host
application, do not enable drive cleaning for any partitions in
the library.

For more information about enabling automatic drive cleaning
for a partition, see Working With Partitions on page 126 on
page 171. For more information about manually cleaning
drives, see Cleaning a Drive on page 564.
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Note: For information about cleaning media, see Using Cleaning
Cartridges on page 690.

Assigning Cleaning To configure the library for drive cleaning, you must first assign one or
Magazines more magazines as cleaning magazines, and then import cleaning
media (see Importing Cleaning Media on page 228).

Note: At least one magazine must be assigned for cleaning before
you can import cleaning media. Also, only magazines that do
not belong to a partition can be assigned for cleaning.

1 Make sure that you are viewing the physical library. From the View
menu, select the name of the physical library.

2 On the menu bar, select Setup > Cleaning Slots. The Cleaning Slot
Configuration window displays.
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3 Click a magazine slot or tape cartridge to select it.

Details about the selected slot or media appear under Information,
including the type of media, barcode number, location, and the
number of times the media has been mounted in a drive.

4 If the library has more than one module, click the arrow buttons to
display the next or previous module.

5 To assign a magazine for cleaning, click any slot in the magazine to
select it. Click Menu, and then select Assign magazine for
cleaning. The magazine is assigned for cleaning.

Repeat this step to assign additional cleaning magazines.

Note: You can also right click any slot in the magazine to assign it

for cleaning.
Importing Cleaning 1 To import cleaning media, select Operations > Import Cleaning
Media Media....The Import Cleaning Media window displays.

- _ _ .
B Import Cleaning Media i - ‘ - i - ‘ @
I ne IMport vieaning Meala gia1og proviges tne capaollity 10 Import cieaning meala rom any 1=

Station in the library into configured cleaning slots. There are 6 empty cleaning slots avsilable for
new cleaning medis.

Slot Filter: [Cleaning Barcodes Only 'J

|| r Select Media To Import

Select|  MedialD | Slot | IEStation | Magazine Result
Il [T lcintorcu R 1

[ ][ Cancel ][ Refresh ]L Help ]

. ——— Y,

2 Click the check box in the Select column next to the cleaning tape
you want to import.

3 Click OK. The Working... dialog box displays.
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4 When complete, a dialog displays indicating if the import was
successful.

The cleaning media are moved to an available cleaning magazine,
and can be used for drive cleaning.

5 Click OK. On the Import Cleaning Media window, the cleaning
tape will be highlighted green.

6 Click Cancel to close the Import Cleaning Media window.

Note: If you are working on the remote LMC, you can right-click a
magazine slot or a piece of cleaning media to see a menu of
available options.

Exporting Cleaning Cleaning media can be used a limited number of times. If a cleaning
Media tape is expired, export it and remove it from the library. There are two
ways to export cleaning media:

* From the Cleaning Slots dialog, or

* From the Export Cleaning Media... dialog

Exporting Cleaning Media from the Cleaning Slots dialog

1 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

2 Select Setup > Cleaning Slots. The Cleaning Slot Configuration
dialog box appears. If the library has more than one module, click
the arrow buttons to display the next or previous module.

Note: To determine the number of cleanings the cleaning media
has performed, click the media to select it, and then check
the Mount Count value under Information.

3 Click the cleaning media in a cleaning magazine to select it, and
then do one of the following:

* To export only the selected piece of media, click Menu, and then
click Export cleaning media <barcode number>.

* To export all media in the selected magazine, click Menu, and
then click Export all cleaning media in magazine.
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The cleaning media are moved to an available I/E station magazine.

Note: You can also right click the piece of media and select
Export cleaning media <barcode number> or in the
magazine and select Export all cleaning media in
magazine.

4 Click Close to close the Drive Cleaning Configuration dialog box.

Exporting Cleaning Media from Export Cleaning Media dialog

1 Select Operations > Export Cleaning Media....The Export
Cleaning Media dialog box displays.

' Gi P
B Export Cleaning Media - [

The Export Cleaning Media dislog provides the capability to export cleaning medisa from the library to
available/empty |IE Station slots in the library. There are 23 empty |IE Station slots avsilable.

Slot Filter: | All Cleaning Slots ¥ |

r Select Media To Export
Selectl Media ID |Framel Rack l Section I Row| Column Result
[ |CLN107CU 0 2 10 2 1
| 0 2 10 2 2
[J 0 2 10 2 3
] 0 2 10 2 4
| 0 2 10 2 5
[J 0 2 10 |2 6
I
[ ] [ Cancel J L Refresh J [ Help J
o= _________ — Y

2 Click the check box in the Select column next to the cleaning tape
you want to export.

Click OK. The Working... dialog box displays.

4 When complete, a dialog displays indicating if the export was
successful.

The cleaning media are removed to an available slot in the I/E
station.

5 Click OK. On the Export Cleaning Media window, the exported
cleaning tape will be highlighted green.
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6 Click Cancel to close the Export Cleaning Media window.

Unassigning a Cleaning If a magazine is no longer needed for holding cleaning media, first
Magazine export all cleaning media from the magazine, and then unassign it.
1 Make sure that you are viewing the physical library. From the View

menu, select the name of the physical library.

On the menu bar, select Setup > Cleaning Slot. The Cleaning Slot
Configuration dialog box appears. If the library has more than one
module, click the arrow buttons to display the next or previous
module.

If the magazine you want to unassign contains cleaning media,
export all cleaning media to the I/E station.

For more information on exporting cleaning media, see Exporting
Cleaning Media on page 229.

Click any slot in the cleaning magazine to select it.

5 Click Menu, and then click Unassign magazine for cleaning. The

magazine is no longer assigned for cleaning.

Note: You can also right click in any slot in the cleaning magazine
and then select Unassign magazine for cleaning.

6 Click Close to close the Cleaning Slot Configuration dialog box.

Note: You cannot unassign a cleaning magazine that contains valid

cleaning media. You must first export the cleaning media and
then unassign the cleaning magazine.

Registering SNMP Traps

Because the library ignores all SNMP SET operations, external
management applications cannot register themselves to receive SNMP
traps from the library. The Trap Registration dialog box enables you to
manually register external applications.
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Registering an
Application

232

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Notifications > Trap Registration. The Trap

Registration dialog box appears.

X

: Trap Registration

The table below contains a list of all Hostsf/IP's curmently registered for traps. Please choose one of the following
actions:
4@ To create - Enter a Host/IF and UDF Fort, click"Create".
@ To delete - Select a Host/IP, click "Delete".
HostlP [ UDP Port
taos. hw.quantum.com 162
New registration
Hostilp: | | Port: [162 |
Create | Close | | Help |

4 In the Host/IP text box, type the iPv4 or iPv6 address or host name
of the host client running of the external application.

5 In the Port text box, type the number of the User Datagram Protocol
(UDP) port that you want to associate with the IP address or host
name.

6 Click Create.

The host application's IP address or name and UDP port number
appear in the table to indicate that the application is registered to
receive SNMP traps from the library.
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1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Notifications > Trap Registration. The Trap
Registration dialog box appears.

4 Click the IP address of the application for which you want to remove
trap registration to highlight it.

5 Click Delete.

Configuring Library Security

Accessing the Security
Configuration Dialog
Box

Quantum Scalar i6000 User’s Guide

You can change the library’s security settings, including enabling or
disabling network services, enabling or disabling remote access to the
library, setting up firewall access for server callbacks to remote clients,
and enabling or disabling SNMP or SMI-S access. You can configure the
library’'s security while viewing either the physical library or a partition.

Note: Changing security configuration settings using the remote
client might cause a loss of connectivity. If this happens, use
the local touch panel to reset the security configuration
settings and restore remote connectivity.

The Security Configuration dialog box enables you to restrict external
users and various remote services from accessing the library through the
Ethernet port on the MCB.

1 Log on as an admin user.

2 Click Setup > Security. The Security Configuration dialog box
appears with the Services tab displayed.
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Configuring Access for
Network Services

234

The Services tab on the Security Configuration dialog box enables you
to entirely prevent all external access to the library or allow access
according to other security settings on the Security Configuration
dialog box. It also enables you to allow or prevent access by SSH, SSHv1,
and to allow or prevent external attempts to discover the library by

pinging it.

1 Click the Services tab on the Security Configuration dialog box.

« Security Configuration

[ Services | LMC | SNMP/SMIS |

3

rSelect Services

MNetwark Interface:
ICMP:

SSH:

S5Hv1:

CLI:

HTTF:

XML Interface:

@ Enable
@ Enable
) Enable
@ Enable

@ Enable

) Disable
) Disable
@ Disable
1 Disable

") Disahle

[ ok J[ ey [ Cancel || Helo |

2 You can change the security settings for any of the following items:

* Network Interface — To entirely prevent all external access to
the library through the MCB Ethernet port, regardless of other
settings on the Security Configuration dialog box, select
Disable. To allow external access to the library in accordance
with other security settings on the Security Configuration
dialog box, select Enable. (The Network Interface option is
unavailable when accessing the LMC remotely.)

* ICMP — To prevent external attempts to discover the library by
pinging it (by means of Internet Control Message Protocol
[ICMP] Echo packets), select Disable. Using this setting can
prevent denial-of-service (DoS) attacks, which can flood the
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library with pings and cause loss of network connectivity and
services.

* SSH — To prevent Secure Shell access to the library, select
Disable. To allow SSH to access the library, select Enable.

e SSHv1 — To prevent Secure Shell version 1 protocol from
running on the library, select Disable. To allow SSHv1 to run on
the library, select Enable. SSHv1 is enabled by default. If you
choose to disable SSHv1, only SSHv2 will connect to the library.

* CLI — To access the library using a command line interface,
select Enable. For more information, see Chapter 14, Using the
Command Line Interface.

Note: Access is gained via SSH. Therefore, to use the CLI to
access the library, you must also enable SSH (see
above).

* HTTP — To prevent access to the library using the Web browser
client, select Disable. If you choose to disable HTTP, access to the
library is limited to the library’'s operator panel or the LMC
application. To permit access to the library GUI using a Web
browser client, select Enable. (The HTTP option is unavailable
when accessing the LMC remotely.)

* XML Interface — If Quantum Vision software is monitoring the
library, you need to enable the XML interface so Vision can get
the information it needs. In order to select XML Interface, the
HTTP option must also be enabled.

If Dynamic Host Configuration Protocol (DHCP) is enabled for your
library on the Network Configuration dialog box (Setup >
Network Configuration), you also should enable ICMP. This ensures
that the DHCP server can determine whether the IP address that is
assigned to the MCB is still valid. (ICMP is enabled by default.)

3 If you want to apply the changes, but you do not want to close the
dialog box, click Apply. Otherwise, click OK to apply the changes
and close the dialog box.

Configuring Access for You can use the LMC tab on the Security Configuration dialog box to
Remote LMC Clients configure the following options:
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* To allow or prevent remote LMC client access to the library
* To set up firewall access for server callbacks to remote clients
* To enable or disable service login
* To set up the length of time before a session timeout
1 Click the LMC tab on the Security Configuration dialog box.
x

(Services LMC SNMPISMI—S|
rRemote Access

[J Uge=sL

rCallback
Port Range: Starting Ending

rService Legin

®) Enable ) Disahle

rSession

Tirmeout |30 — min - (1-1440)

| Ok || Anplhy || Cancel || Help |

2 Change the security settings for any of the following items:

* Remote Access — To prevent all remote LMC clients from
accessing the library, select Disable. To allow them to access the
library, select Enable.

e Select Use SSL to enable secure communication between the
LMC client and the library.

Note: Enabling SSL can impact the network performance of
remote operations (for example, downloading new
library software).

* Callback Port Range — To configure firewall access for server
callbacks to remote clients, type the first port number of a
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range of ports that you want to be used for callbacks in the
Starting text box, and then type the last port number in the
Ending text box. Valid port ranges must fit within the range
1024 to 65535. Remote client service ports must be within the
range of ports specified here. Otherwise, callbacks fail because
the library’s firewall blocks outbound packets designated for
out-of-range ports.

* Service Login — To allow service login, select Enable. To
prevent service login, select Disable. The Admin user can enable
or disable the service user login on both the front panel access
and the remote client access.

Note: The default service login through the service port is still
available for use. For security purposes, the service port
can be physically locked down by locking the back door
of the Scalar i6000.

* Session — To configure the length of the session’s timeout,
type or use the arrow buttons to specify the length of a session
before it times out. Valid session timeouts are 1 — 1440 minutes
(1 minute to 24 hours). The default is 30 minutes.

Note: The Service login timeout is set to 4 hrs and cannot be
modified.

3 If you want to apply the changes, but you do not want to close the
dialog box, click Apply. Otherwise, click OK to apply the changes
and close the dialog box.
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Configuring Access for
SNMP and SMI-S
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The SNMP/SMI-S tab on the Security Configuration dialog box allows

you to e
port.

nable or prevent SNMP or SMI-S traffic across the MCB Ethernet

1 Click the SNMP/SMI-S tab on the Security Configuration dialog

box.

B Security Configuration

S

fSer\fices

r LMC SNMPISMI-S

rSMI-S

[V
[

Enable SMI-S
Enable Secure SMI-S

r SNMP
-
o

[l

Co

The authentication algorithm used in SNMP v3 is set to MD5 and the encryption is disabled system wide.
You can opticnally enable or disable SNMP v1 and SNMP v2 access to your SNMP agent.

Enable
Disable

Enable SNMP v1 and v2

mmunity String: |publichtyStr

[ OK ]L Apply ]L Cancel ]L Help ]

2 You

can change the security settings for any of the following items:

SMI-S — To allow SMI-S traffic (port 5988), select the Enable
SMI-S check box. To allow encryption of SMI-S traffic (SSL, port
5989), select the Enable Secure SMI-S check box.

Note: Port 427 is used for Service Location Protocol (SLP),
which is used along with the Common Information
Model (CIM) server.

SNMP — To prevent all SNMP traffic across the MCB Ethernet
port, select Disable. To allow SNMP Get operations, select
Enable.

If SNMP traffic is allowed, then SNMP v3 is always available. If
you want to permit less secure SNMP access, select Enable
SNMP v1 and v2. If you decide you do not want to use SNMP
v1 and v2, clear the Enable SNMP v1 and v2 check box.
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You can also change the community string from the default.

The library ignores all remotely issued SNMP SET operations
under any circumstance, which means that external applications
cannot register themselves to receive SNMP traps from the
library. However, the Trap Registration dialog box (Setup >
Notifications > Trap Registration) enables you to perform this
registration yourself by entering the necessary IP and port
information. For more information about the Trap Registration
dialog box, see Registering SNMP Traps on page 231.

3 If you want to apply the changes, but you do not want to close the
dialog box, click Apply. Otherwise, click OK to apply the changes
and close the dialog box.

Using LDAP

LDAP Server Guidelines

Quantum Scalar i6000 User’s Guide

Lightweight Directory Access Protocol (LDAP) is the industry standard

Internet protocol that provides centralized user account management.
The library supports LDAP Directory servers based on Microsoft Active
Directory and Novell eDirectory. For information on how to configure

library LDAP settings, see Configuring LDAP on page 240.

You can configure the Lightweight Directory Access Protocol (LDAP)
settings any time after the initial library configuration. Once you enable
and configure LDAP, you can view your current LDAP settings using the
LDAP menu.

Note: Active Directory no longer requires Windows Services for Unix
2.5.

Enabling LDAP allows existing user accounts residing on an LDAP server
to be integrated into the library’s current user account management
subsystem. User account information is centralized and shared by
different applications, simplifying user account management tasks. For
more information about local user accounts, see Creating Local User
Accounts on page 476.
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The remote client and operator panel do not allow you to create,
modify, or delete user account information on an LDAP server. This must
be done by the directory service provider.

User and Group Access

For LDAP accounts with user privileges, access to library partitions is
determined by group assignment on the LDAP server. Groups must be
created on the LDAP server with names that correspond to the library
partition names. User and library groups must reside in or below the
group context. Users without administrator privileges must be members
of both the user group defined in the LDAP server interface AND part of
a group with an identical name as the partition(s) on the library (RDN
[Relative Distinguished Name] only) in order to have access to the
corresponding partitions on the library. LDAP accounts with
administrator privileges have access to all partitions and administrative
functions and do not need to be assigned to partition-related groups on
the LDAP server.

Note: Usernames and group objects must be in LDAP Distinguished
Names formats.

OpenLDAP 2.4

You must install and run OpenLDAP 2.4 or later. The supported Objects
in OpenLDAP 2.4 and later are of type “Person” or derived objects, and
the group Objects must be of type “GroupOfNames.”

OpenLDAP must be compiled with Overlay Support and requires the
installation of “memberOf” overlay. More information can be found in
the man pages of OpenLDAP with the “man slapo-member of”
command.

You can configure the Lightweight Directory Access Protocol (LDAP)
settings any time after the initial library configuration.

1 From the LMC, select Setup > User Configuration > LDAP. The
LDAP Configuration dialog box displays with the General tab
displayed.
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- LDAP Configuration

[ Gereral | Aceess | Test |

[ Enahble LDAP

rServer Configuration

Frimary: | |

Alternate: | |

[[] Secure Part: |389

rSearch Information

USEer |

F'assword:l |

Ex Chl=Search, Ch=Ulser, DC=Cuantum, DC=Local

| ok || cancet || Test || Hew |

2 In the General tab, configure the following items:
* Enable LDAP:
* To enable LDAP, select Enable LDAP.
* To disable LDAP, clear the Enable LDAP check box.

Note: If you disable LDAP, single sign-on functionality will
not be available on the library.

* Server Configuration section:

* Primary: You must provide a primary IP address or DNS
name.

* Alternate: An alternate IP address or DNS name is optional.

* Secure: Use this check box to enable the setup options to
access a secure LDAP server, which can be done using any
port except 389. The default secure port is 636. If you
enable this option, you must retrieve the trusted root
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certificate from the LDAP servers. If you use secure LDAP,
both LDAP servers specified above MUST use the same
trusted root.

e Port: Enter the appropriate port in this field.

* Retrieve TR: Use this function to retrieve the trusted root
certificate from the primary LDAP server. An MD5 and SHA1
hash is shown to verify the LDAP's server identity.

Note: The first time you use Retrieve TR, the process can
take 5 to 10 minutes. To connect to a secure LDAP
server, you must complete the retrieval process.

Note: This button is only enabled if the Secure check box
is selected. Some directory servers (for example,

Novell eDirectory™) are secure only by default.

¢ Search Information section:

* Administrative user rights are not required, but the user
must have the right to search for all needed user names in
the LDAP directory.
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3 Click the Access tab. Use this tab to configure LDAP authentication.

"

x|

General | Access | Test |

rContext Information
UserContext:| |
Group Context:| |

Ex CM=Users, DC=0Quantum, DC=Local

rLibrary Access Groups
User:| |
Admin:| |

E:x: Fully gqualified LDAP Dk CR=Lib Admin, Ch=Users, DC=Guantum, DC=Local

| QK | | Cancel | | Test | | Help |
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Context Information section:

* User Context: The User Context is a fully qualified LDAP DN

and is used as the base to search for the login users. You
can search for a user in the context specified and all
contexts below it.

Group Context: Use this field to search and discover what
groups a users is a member of. Only groups which are in the
group context or below are considered for library access.

* Library Access Groups section:

* User: The group associated with the library. A user that

belongs to the library user access group is granted user level
permission to access the library. For a user to manage a
partition, that user must also be a member of a user group
with the same name as the library partition in question.

Admin: The group associated with the library administrator,
equivalent to the local administrative user privilege level.
Any member of this group has administrative privileges.
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Note: Non-admin library users also need to be members of

the groups that match the partition names for which
they are granted access. These group names do not
need to be specifically listed anywhere in the LDAP
setup on the library. When user logins are validated
during login, their group memberships for partition
access are validated automatically.

4 Test the LDAP configuration.

If you have administrative rights, you can use the Test functionality
to simulate an LDAP login for a specific user and quickly discover
what access rights the user has and to what partitions the user has

access.

Note:

If help from support is needed, it is important to run this
test. More information is logged using the Test option than
using the normal login.

Note:

The search filter for LDAP is

"(&(| (objectclass=User)(objectclass=person)(objectClass=p
osixAccount)(objectclass=inetOrgPerson))(| (cn=%USER%)(
uid=%USER%)(sAMAccountName=%USER%)))

This means that the objects the LDAP authentication looks
for are:

- User

- Person

- posixAccount

- inetOrgPerson

where the

-cnor

- uid or

- sAMAccountName

attributes match the actual username.

To test the LDAP configuration, do the following:

a Click the Test tab.

b Fill in the Test User section:
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* User: Type the appropriate user name.
* Password: Type the user password.

c After you have entered all the LDAP configurations you wish,
click Test to verify the LDAP connection.

A message box displays indicating the success or failure of the
LDAP connection.

* If the connection failed, the error message contains
information that you can use to resolve the issue. Click OK
to return to the LDAP Configuration dialog box.

* |f the connection succeeded, click OK.

| LDAP Configuration X
General r}\ccess rTest |

rTest User

User: || |

Passward: | |

Ex JohnDoe

| Qe | | cancel | | Test | | Help |

5 To accept and save the library configuration, in the LDAP
Configuration dialog box, click OK.
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Configuring Screen Saver Preferences

Use the Screen Saver preferences tab to customize the images that
display on the LMC screen when the library is not in use. The screen
saver starts automatically if the library is idle for a specified amount of
time.

Note: Screen saver preferences can only be configured remotely, not
using the touch panel.

1 From the menu bar, click Setup > System Settings > Preferences.
The Preferences dialog box appears with the Screen Saver tab

displayed.
x
Screen Saver |
) Default @ Custorn O OF
rActivation
Wiait: [15 i‘ minutes (11200
rMovement
@ Random
i) Stationary

O Linear  harizortal: Mi‘ pivel (0-50) vertical: Mi‘ picel (0-50)
Wotion Delay: [110 i‘ me (100-50000)

rimages
Marmal:  campany logo.jpg | Browse... || Previgw |
Warning: warning.jpg | Erowse... || Preview |
Failure:  |failjpgy | Erowse... || Preview |

2 Do one of the following:

¢ Select Default to use the default Quantum screen saver with
standard settings.

246 Quantum Scalar i6000 User’s Guide



Quantum Scalar i6000 User’s Guide

Chapter 3: Configuring Your Library
Configuring Screen Saver Preferences

* Select Custom to change screen saver settings such as
activation, movement, or images.

* Select Off to disable the screen saver. (The current settings are
cleared.)

If you selected Custom, go to Step 3. Otherwise, go to Step 6.

Under Activation, enter a value in the Wait box to specify how
much idle time must pass before the screen saver is activated.

The activation wait time can be 1 — 120 minutes.

Under Movement, specify the position and the motion of the
screen saver image on the screen.

* Select Random to display the screen saver image in a variety of
positions.

* Select Stationary to display a static screen saver image that
does not move.

* Select Linear to display the screen saver image as a floating
image.

* Enter values in the horizontal and vertical boxes to specify the
movement of the screen saver image in pixels.

* Enter a value in the Motion Delay box to specify the movement
speed of the screen saver image.

Under Images, specify the image files to display for normal
functions, warning notices, and failure notices. You must select
image files for all three functions.

* To specify an image file, click Browse. Select the image file and
then click Open. The image file must be in GIF, JPEG, or PNG
format, and cannot be larger than 1 MB. In addition, image
resolution is limited to 600 x 800 pixels.

* Click Preview to preview an image file.
Click OK to save the settings and close the Preferences dialog box.

Or click Apply to save the settings without closing the Preferences
dialog box.

Because you made system configuration changes, you are prompted
to save the configuration changes. For more information, see Saving
and Restoring Library Configuration on page 595.
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Working With Data Path Conditioning

The Scalar i6000 provides an automatic means of verifying, monitoring,
and protecting data path integrity between hosts and library drives. This
feature is referred to as data path conditioning. Using this feature,
administrators can proactively detect and resolve data path problems
before they affect backup, restore, and other data transfer operations.
Data path conditioning ensures that data transmissions are optimized
and reliable, resulting in improved system availability.

The FC I/O blade manages data path conditioning along the path
between itself and the library drives. Data path monitoring
automatically occurs at regular, configurable intervals. The I/O blade
generates a RAS ticket if monitoring tests fail for two intervals. This
indicates either loss of connectivity or drive failure. The FC I/O blades
include the data path conditioning feature, and administrators can
configure it using the LMC.

Configuring Datapath For the library, target-side data path monitoring is performed
Conditioning automatically and proactively. The Datapath Conditioning dialog box
allows you to set the level at which the data path is monitored between
an /O blade and the drive(s) connected to it. You also can set the time
interval between monitoring checks (up to 48 hours).

Note: 1/O blades must be present to access the Datapath
Conditioning dialog box.

1 Log on as an administrator.

2 Make sure that you are viewing the physical library. From the View
menu, click the name of the physical library.

3 Click Setup > Blades > Connectivity > Datapath Conditioning.
The Datapath Conditioning dialog box appears, showing all the I/O
blades found in the library. Each blade is identified by name and by
geographic location.
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x|
Select an |0 Blade:
Mame | Location |
FCIOB 1,1,1,1,3
FC OB 1,1,1,1,4
FCI0B 1,1,1,1,8
| Configure | | Clase |

4 Click a blade to highlight it, and then click Configure. The
Datapath Conditioning Setting dialog box appears.

]
r Level:

@ |nterface Test
) Device Datapath Tast

r Interwval:

Enter new Interval: |60 mins.

| QK | | Cancel | | Help |

5 In the Level area, select the appropriate level. The default level is
Interface Test. To enable data path monitoring tickets, set the level
to Device Datapath Test.

The following table describes the functionality for each data path
monitoring level.

Level Name

Functionality Description

Interface Test

Performs tests to verify that Fibre Channel controllers on I/O blades are responsive
to commands.

Device Datapath
Test

Performs tests at the Interface Test level, and also performs a device inquiry on
each target device.

Quantum Scalar i6000 User’s Guide 249



Chapter 3: Configuring Your Library

About the Configuration Record

6 In the Enter new Interval text box, type the amount of time that

should elapse between automatic monitoring checks. The interval
can range from 1 to 2,880 minutes (48 hours). The default interval is
60 minutes.

Note: The data path from I/O blade to the drive must experience
problems for two period intervals before a problem is
detected and a ticket is generated.

7 To save your configuration and return to the Datapath

Conditioning dialog box, click OK.

About the Configuration Record

250

The configuration record contains details about the library’s
configuration and can be sent to a specified e-mail address or saved as
a.txt file.

Information in the configuration record includes:

Product information — Product name and version, MCB and RCU
versions, serial number, and modules/drives/partitions
configuration

License information — License descriptions, quantities, and
installation dates

Network information — Hostname, DHCP status, IP address, and IP,
Netmask, and Gateway addresses

Partition information — Serial numbers, online/offline statuses, and
numbers of slots, drives, and I/E slots

Drive information, for each drive — Location, partition, SCSI
element address, online/offline status, vendor, model, serial number,
logical serial number, firmware version, drive type, and interface

type:
* SCSI tape drives — SCSI ID

* Fibre Channel (FC) tape drives — World Wide Name (WWN) and
loop ID, speed, and connection type
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Note: If the FC tape drive is attached to an FC I/O blade, the
WWN indicates the WWN of the I/O blade, not the tape
drive.

* |/O blade information — Blade type, location, firmware version,
serial number, WWN, and CC LUN

Before you can e-mail the configuration record, the library e-mail
account must be configured. For information on configuring the library
e-mail account, see Configuring E-mail on page 185.

For instructions on how to e-mail or save the configuration record, see
Mailing or Saving the Configuration Record on page 548.

Setting Aisle Lights

Aisle lights are optional on each module, and are mounted to the roof
of each module to illuminate the inside of the library.

To set the duration for aisle lighting:

1 From the main console, select Setup > System Settings > Aisle
Lights. The Aisle Light Settings dialog box appears.

2 Select a duration for the light to illuminate: 30 minutes, 1 hour, or
Always Off.

3 Click OK.

Note: Regardless of the selected setting, the aisle lights will turn off
automatically during all inventory and teach operations. At the
completion of these events the lights are automatically turned
back on if they were on prior to these operations.

Note: For the time limited settings, if the lights were on before the
operation, the timer starts over when the lights are
automatically turned on.
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Note: For time limited aisle light settings, user interaction, such as
using the touch panel or opening an I/E station or aisle door,
causes the timer to reset. The lights will automatically turn on if
they are not already.

Note: The default setting is Always Off.

Configuring a Webcam For Your Library

If desired, you can install a webcam in your library to monitor activity.

As of version 10.2, if you install a webcam in your library, the library
aisle lights turn on when the webcam is operating and then turn off
when it is stopped. In order to enable the library to control when the
aisle lights should be switched on and off in synchronization with
webcam usage, you must enter the webcam’s IP address.

To enter the webcam's IP address:

1 From the main console, select Setup > System Settings > Camera
Host/IP. The Camera Host/IP dialog box appears.

] Camera Host/IP |le

Enter the host name or IP address of the camera that you connected to your intranet.This
name/IF will be used by the library to determine when the camera is being used, so the library
can cantrol when to turn an the aisle lights.

Host/IF Address: |

ok J( cancet J[_ren ]

2 Specify the host name or IP address of the webcam that's connected
to your intranet.

3 Click OK.
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Additional Information

Note: As always, the aisle lights will continue to turn off
automatically during all inventory and teach operations. At the
completion of these events the lights are automatically turned
back on if they were on prior to these operations. For the time-
limited settings, if the lights were on before the operation, the
timer starts over when the lights are automatically turned on.
So even if the webcam is off, the aisle lights will turn on during
these operations.

For more information about purchasing a webcam for your library,
contact your Quantum sales representative.

For webcam installation instructions, refer to the Scalar /6000
Installation Guide.

After you install the webcam, you can learn about its operation by
referring to the documentation that came with the webcam, or by
downloading the user’s guide from www.axis.com.

Note: If the webcam timestamp is inaccurate, this may indicate that
the battery needs to be replaced. Refer to the webcam
documentation for instructions to replace the battery.

|
Working with Towers

New to the i6000 library are high-density expansion modules (HDEM) or
towers. These modules have larger storage capacities making them ideal
for libraries where space is an issue.

If your library has a tower installed, you can manage, monitor and
maintain it.

1 From the Tools menu, select Towers. The Towers dialog box
displays.

Quantum Scalar i6000 User’s Guide 253


www.axis.com

Chapter 3: Configuring Your Library
Working with Towers

B Towers - X

The following dislog sllows the user to change the current state (Vary On/Cff, Online/Cffline) of the tower. If you Vary
Cff or change state of a tower to Offline, all of the magsazines/slots in the tower will no longer be accessible from a
host application. You can also select to identify a tower, this sets the light on the operator panel to blink rapidly.

rSelect Tower

Tower # ] Status I Mode l Scanner I State Door Status
21 (Frame:12, Rack:1) |Ready Online Ready Varied On Closed
23 (Frame:13, Rack:1) |Ready Online Ready Varied On Closed
Control
[ |dentify ] [ Offline ] [ Vary Off } [ ]

254

( cancel | Refresn | Hep |

The Towers dialog box displays all the towers currently installed in
the library and gives details about them, including:

* Tower # — The index of the tower in the library.

Note: The Tower # column shows the physical addressing of
the tower (i.e. Frame 2, Rack 1) but also the index
number of the tower(s) in the library. Libraries with
multiple towers will see them listed in the Tower #
column as only odd numbers, 1, 3, 5, etc. This is to
accommodate future tower expansion.

e Status — If the tower is available.

e Mode — If the tower is online or offline. When a user sets the
tower to Offline mode, the tower will not be accessible to a host
but can be used for Ul operations, such as move media.

* Scanner — Status of the barcode scanner:
* Unknown - scanner is present but not working properly
* Not Present - scanner is not installed
* Removed - scanner has been taken out of the tower

* Failed - scanner is not working properly
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* Ready - scanner is installed and working properly

* State — Whether the tower is varied on or off. Varying Off a
tower allows a user to open the rear access door to perform any
necessary tower access or maintenance. If a tower is not Varied
Off before the rear access door is opened, the tower will
automatically go to a Varied Off state and the library will issue a

ticket. When a user Varies Off a tower it will no longer be
accessible to a host or Ul operations.

* Door Status - Whether the rear access door is open or closed.

2 In the Control section of the Towers dialog box, you can click the
following buttons:

* Identify — This identifies the tower by setting the Tower
Enable button to blink a pattern for a minute before returning
it to its original state. For more details on the blinking patterns
for the Tower, see Interpreting HDEM Tower Enable Button

Blinking Pattern on page 113.

» Offline/Online — Takes the tower offline or online depending
on what is displayed in the Mode column.

* Vary Off/On — Varies the tower either on or off depending
what is displayed in the State column.

¢ Reset — Resets the HDC in the selected tower. The selected
tower must be Varied Off.

* Cancel — Closes the Towers dialog box.

* Refresh — Refreshes the Towers dialog so it displays the most
current information.

* Help — Displays the i6000 online help page referencing the
tower.
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The Active Vault feature allows you to keep tape cartridges vaulted
within a physical library, rather than having to move them to other
onsite or offsite locations. These cartridges are stored in an “Active
Vault” partition that is not managed by a host and contains no tape
drives. You can configure policies on standard partitions to redirect SSCI
host initiated tape cartridge export MOVE operations directly to an
Active Vault partition, or you can configure a plug-in to query an
external application where the export move operation is intended for an
Active Vault partition. Additionally, Active Vault partitions can be
enabled for EDLM policies that provide for regularly timed media scan
operations.

This chapter covers:

* About Active Vault on page 258

» Configure Active Vault on page 258

* Create Active Vault Partitions on page 259

» Configure Access to External Applications on page 260

» Configure Active Vault Policies on Partitions on page 260

* View Active Vault Partition Policies on page 264
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About Active Vault

* The Active Vault feature requires an Active Vault license (see
Enabling Licenses on page 123).

* You can move tapes between Active Vault partitions and standard
partitions via the library user interface without exporting and
importing the tapes (for more information, see Moving Media
Between Active Vault or AMP and Standard Partitions on page 698).

Note: Manual movement between library managed partitions and
standard partitions will require inventory reconciliation with
the backup application managing the standard partition. SCSI
Unit Attention 6/2800 and 6/2801 inform host applications of
the need to refresh element status.

* Active Vault partitions are library managed partitions. They are not
accessible to hosts.

* Active Vault partitions are composed of unlicensed slots. If the size
of the Active Vault partition exceeds the number of available
unlicensed slots, then the partition will be composed of both
unlicensed and licensed slots, or use all licensed slots.

* Active Vault partitions may configure I/E station slots.
* Active Vault partitions do not contain drives.

* You may have multiple Active Vault partitions. However, the total
number of standard and library managed partitions cannot exceed
the maximum of 16 partitions.

* Library managed Active Vault partitions can be configured with
EDLM policies (see Chapter 9, Extended Data Lifecycle

Management).

Configure Active Vault

Active Vault policies are configured on standard partitions. The policies
intercept host commands that export tape cartridges to library
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managed Active Vault partitions. Configuring Active Vault involves the
following:

* Create Active Vault Partitions on page 259

» Configure Access to External Applications on page 260 (optional)

* Configure Active Vault Policies on Partitions on page 260

* View Active Vault Partition Policies on page 264

Note: Manual movement between library managed partitions and
standard partitions will require inventory reconciliation with
the backup application managing the standard partition. SCSI
Unit Authentication G/2800 and G/2801 is for host applications
with the need to refresh element status.

Create Active Vault Create one or more Active Vault partitions as follows:

Partitions 1 Make sure you are viewing the physical library. From the View

menu, select the name of the physical library.

2 Make sure the Active Vault license is installed on the library (see
Enabling Licenses on page 123).

3 Use Expert Mode to create one or more library managed Active
Vault partitions. Follow the instructions in Using Expert Mode on
page 139. When you get to the screen named Partitions - Step 2:
Choose Partition Properties, select Library Managed (Vault) from
the Partition Type drop-down menu.
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Configure Access to
External Applications

Configure Active Vault
Policies on Partitions

260

i [ Partitions - Step 2: Choose Partition Properties - - Léj
Create Partition
Start the wizard by entering the name of the partition.
Name: |t |
|
VendorID: | QUANTUM - |
ProductID: | Scalar i6000 |
Partition Type: | Standard v
Standard
EDLM
AMP
Vault
[ < Back ][ Next = ][ ][ Cancel ][ Help ]

This is optional. You only need to do it if you want to use the library to
determine if the external application has a vault name that matches the
name of an active vault partition in the library.

If you want to use an external application to direct media to Active Vault
partitions you first need to configure the library for external application
access. Follow the steps in Chapter 11, Configuring Access to StorNext,
and then return here. You will then be able to select external application
policies in the next step.

You can only configure an Active Vault Policy on standard partitions (not
library managed partitions). This policy redirects SCSI host initiated tape
cartridge export MOVE operations to an Active Vault.

1 Click Setup > Partitions > Policies > Active Vault Configuration.
The Active Vault Configuration Wizard appears.
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2 Click Next. The Select the Active Vault Configuration Option
screen appears.

« Active Vault Configuration E|

Select the Active Vault Configuration Option

Select an option to perform, and a padition on which to pedarm it. vou can enable, modify ar dizable Active
Wault policies on amy Standard partition in the librang.

@ Enable ) Modify () Disable

Select] Partition | Wault Policy | Status | Serial Number

[ Jetannrd JDiaskiled [Bffline_12021 A0 AR- 1LY

[ <Back J[ Next = J[ Cancel J[ Help

J

3 Create, modify, or remove policies on a standard partition by doing

one of the following:

To...

Do this...

Enable Active Vault policy

1 Select Enable.

2 Select a partition from the table that has Active Vault policies
disabled.

3 Proceed to Step 4.

Modify existing Active Vault
policy

1 Select Modify.

2 Select a partition from the table that has Active Vault policies
enabled.

3 Proceed to Step 4.
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To...

Do this...

Disable Active Vault policy

1 Select Disable.

2 Select a partition from the table that has Active Vault policies
enabled.

3 Click Finish.

A confirmation dialog box appears asking you to confirm you
want to disable the Active Vault policies on the partition.

4 Click Yes to confirm.
A “success” dialog box appears.
5 Click OK to close the dialog box.
Process is complete.

262

4 Click Next. The Active Vault Policies screen appears.

X

« Active Vault Configuration

Active Vault Policies

Selact the palicy you like to apphy to this partition. Vou can choose to export directly to the Active Wault
partition oryou can make a request to the Exdernal Application to determine what to do.

@ Redirect exports to specific Active Vault

|vault -

Media Filter: |

 Redirect exports to application-defined Active Vault

| <Back || Finish [ cancel |[ Help |

5 Choose one of these redirect options:
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Policy

Description

Redirect exports to specific Active Vault.

If you select this option, you must select an Active Vault
partition from the drop-down list.

All host-initiated export requests to move tapes from this
partition will redirect the tapes to the specified Active
Vault partition instead of the I/E station.

If desired, you can specify which media to move by typing
a value in the Filter Media field. For example, entering a
value of *123L4 will cause all media with barcodes
ending with 123L4 to be vaulted. Entering a value of
123* will cause all media with barcode starting with 123
to be vaulted.

Note: Only host-initiated export operations will be
redirected to the Active Vault. Ul-initiated export
operations will still move tape cartridges to an I/E
element.

Redirect exports to application-defined
Active Vault.

If you select this option, you must select an external
application plug-in from the drop-down list.

When a host-initiated export operation occurs, the library
queries the selected external application for the name of
the vault that may be associated with the export
operation. If the name of the application-tracked vault
matches the name of one of the Active Vault partitions in
the library, the export request is re-directed to that Active
Vault partition. If the name of the application-tracked
vault does not match the name of an Active Vault
partition in the library, the export request will be directed
to the I/E element as specified by the host command.

Note: Only host-initiated export operations will be
redirected to the Active Vault. Ul-initiated export
operations will still move tape cartridges to an I/E
element.

6 Click Finish. A confirmation dialog appears.

7 Click OK to close the dialog.
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View Active Vault To review the policies you configured, you can go back through the
Partition Policies Wizard, or you can click Monitor > Partitions > Policies. See
Monitoring Partition Policies on page 542 for more information.
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Advanced Reporting is a licensed features that gives you access to the
following reports:

* Drive Utilization Report (see Viewing the Drive Resource Utilization
Reports on page 604)

* Media Integrity (see Viewing Tape Alerts and Generating Media
Integrity Analysis Reports on page 67)

* Media Security Notifications (see Setting Up Media Security
Notifications on page 194 and Viewing the Media Security Events
Report on page 196)

* Media Usage (see Media Usage Report on page 266).

* Advanced Reporting Options (see Setting Up Advanced Reporting
Options on page 610
The Advanced Reporting reports can be found under the Tools >

Reports menu along with other library reports that do not require the
Advanced Reporting license.

In addition, Advanced Reporting feature allows you to schedule certain
library reports to be automatically generated and e-mailed to
designated recipients (Tools > Reports > Reporting Options). See
Setting Up Advanced Reporting Options on page 610.
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Media Usage Report

The Media Usage Report collects information on all media that have
ever been in the library, including media that is no longer in the library.
Lifetime media usage metrics are associated with the cartridge and are
kept on the embedded chip. The report reflects what the drive reports
from the media chip whenever the media is unloaded, and lists any
associated errors.

When the log reaches maximum size, old information is deleted as new
information is added.

1 Log on as an administrator.

2 From the main menu, select Tools > Reports > Media > Usage.

The Media Usage Report dialog box is displayed.

: Media Usage Report

Barcode Serial Number | Manufacturer Type Manufacturer Date Thread Count ME Read | MB Written
000735L3 0C21771590 IMATION L3 2006-01-20 00:00:00 275 100450 2236682
003120L3 1220337065 MAXELL L3 2004-12-17 00:00:00 184 12 10
003188L3 1180360389 MAXELL L3 2004-12-17 00:00:00 261 506 1612836
003332L3 1180360430 MAXELL L3 2004-12-17 00:00:00 490 1308 1770818

[ send J[ cancel |[ Help |

B Written | Recowvered Write Errors Recovered Read Errors | Unrecovered Write Errors | Unrecovered Read Errors | Encryption
5682 1 3 0 0 Unknown

0 0 0 0 Unknown
2836 0 0 0 0 Unknown
0818 1 0 0 0 Unknown

[ send J[ cancel |[ Help |
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The report provides the following information:
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Field

Description

Barcode

Media cartridge barcode label.

Serial Number

Media cartridge serial number.

Manufacturer

Media cartridge manufacturer.

Type

Media type (L1, L2, L3 L4, L5, L6, L7, LR,
LS, LT, LU, LV, LW, LX)

Manufacturer Date

Media cartridge manufacturing date
(format: YYYYMMDD)

Thread Count

Number of times the tape has been
mounted and threaded on the drive

MB Read

Cartridge lifetime MB read.

MB Written

Cartridge lifetime MB written.

Recovered Write Errors

Errors in writing data where an attempt
to re-write the data was successful.

Recovered Read Errors

Errors in reading data where an attempt
to re-write the data was successful.

Unrecovered Write Errors

Errors where all re-write attempts failed
and the data could not be successfully
written to the tape

Unrecovered Read Errors

Errors where all re-read attempts failed
and the data could not be successfully
read from the tape

Encryption

Cartridge Encryption Status
(U=Unknown, E=Encrypted, N=Not
Encrypted)
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3 To send the report to your e-mail, click Send.
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Viewing Cross-Partition Media Moves

The library creates a report for media moved across partitions which you
can view, save or e-mail.

To view cross-partition media moves
1 Log on as an administrator.

2 Click Tools > Reports/Media/Moves. The Cross Partition Media
Moves report appears.

rFilter List
Source F‘ﬂmuun:‘AH V‘
Target Partition: | Al -

Barcode | Source Parition | Source Element Addr | Target Partition | Target Eler
00312003 wvault 4118 edlm 2043 =
00312003 edim 2043 vault 4119 :
00318813 vault 4117 edlm 2048
003188L3 edim 2048 wvault 4117
001826LS Partition_1 4230 vault2 4163
\Joos74Ll1 Partition_1 4659 standard2_snw 4268
|Jons74L1 standard2_snwe 4268 Partition_1 4278
012365L4 Partition_1 4228 amp 4113
00040413 standard2_snw 4265 edlm 4152
000404L3 edim 4152 Partition_1 4656
012365L4 Partition_1 4658 standard2_snw 4207
003246L3 edim 4181 Partition_1 4286
IAZ2126L3 vault 4114 vault2 N7z
IAZ2126L3 vault2 472 Partition_1 4122
|AZ2126L3 standard2_snw 4269 Partition_1 4123
003246L3 edim 4181 Partition_1 4638
003246L3 Partition_1 4638 standard2_snw 4205
|AZ2126L3 Partition_1 4230 vault2 4169
003246L3 Partition_1 46539 standard2_snw 4268
003246L3 standard2_snw 4268 Partition_1 4279
00040413 Partition_1 4228 amp 4113
001826L5 standard2_snw 4265 edlm 4152
001826LS edim 4152 Partition_1 4556
00040413 Partition_1 4658 standard2_snw 4207
0123654 edim 4161 Partition_1 4286
O0874L1 vault 4114 wvault2 a7z
|Joos74L1 vault2 a7z Partition_1 4122
|Jooge74L1 standard2_snw 4269 Partition_1 4123 L
012365L4 edim 4151 Partition_1 4538 ||
N | v

[ Send ] L Close J [ Help ]

3 If desired, filter the report output by selecting a single source
partition and/or a single target partition from the Source Partition
and Target Partition fields respectively. Click Filter to apply your
selections and update the report.
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The Cross Partition Media Moves report provides the following
information pertaining to media moves across partitions:

Field

Description

Barcode

The barcode label number for the tape
cartridge moved across partitions

Source Partition

The partition in which the moved tape
cartridge originally resided

Source Element Addr.

The element address in the source
partition

Target Partition

The target partition to which the tape
cartridge was moved

Target Element Addr.

The element address in the target
partition

Date

The date on which the tape cartridge
move occurred
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4 Click Send to display the Print/Save/Email dialog box.

5 Do one of the following:

* Click Email and specify an e-mail recipient for the report. Click

OK.

* Click Save and navigate to the location where you want to save

the report. Click OK.

* Click Print to print the report. Click OK.

* Click Cancel to return to the report screen

6 When you are finished with the report, click Close.

269



Chapter 5: Advanced Reporting
Viewing Cross-Partition Media Moves

270 Quantum Scalar i6000 User’s Guide



H B
Chapter 6
™

Automated Media Pool

The Automated Media Pool (AMP) feature allows you to pool media,
such as scratch tapes, within a library managed partition to facilitate
selective tape cartridge assignments from the media pool to standard
partitions without the need for operator intervention to physically load/
import additional tape cartridges into standard partitions. Instead of
requiring physical import operations to each partition, the Automated
Media Pool can contain a number of tape cartridges that can be moved
or assigned to a partition via a user-interface-initiated media move or
magazine assignment selection at any time.

In addition, the AMP feature allows for the creation of standard
partition AMP extensions such that a standard partition gets created
with a specified number of actual and accessible storage elements as
well as logical, inaccessible element extensions. As a standard partition
requires additional accessible storage elements, logical elements can be
associated with physical magazines from the AMP such that the logical
element extension becomes an actual physical storage element that can
now report an accessible status to a host.

Benefits include:

* You can easily move and reassign tapes from the AMP to standard
partitions and from standard partitions to the AMP. This allows you
to adjust the amount of media within a partition as needed without
performing import/export operations (for more information, see
Moving Media Between Active Vault or AMP and Standard Partitions
on page 698).
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* The AMP can provide a “staging area” for scratch tapes and tapes
that are no longer needed for backup. When a tape is needed by a
partition, it can be moved from the AMP instead of having to be
physically imported into the library partition.

* The number of partition accessible storage units can be expanded or
reduced as needed without having to reconfigure the library,
partition or host application.

* Tapes can be auto-imported from an AMP partition to standard
partitions based on filters set up to associate tapes with standard
partitions by barcode range.

* Tapes can be auto-exported to an AMP partition via policies to
redirect standard partition export MOVE requests.

Note: Manual movement between library managed partitions and
standard partitions will require inventory reconciliation with
the backup application managing the standard partition. SCSI
Unit Attention 6/2800 and 6/2801 inform host applications of
the need to refresh element status.

This chapter includes:

* Requirements for Automated Media Pool on page 273

* Configure Automated Media Pool on page 273

* Create an AMP Partition on page 273

* Create Magazine Extensions in Standard Partitions on page 274

* Configure AMP Import Policies on page 275

* Configure AMP Auto Export Policies on page 275

* Use an Automated Media Pool on page 276
* Assign Storage Magazines to/from the AMP on page 277
* Move Media to/from the AMP on page 279

* Auto Import Media on page 281
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Requirements for Automated Media Pool

The AMP feature requires a Partition license (see Enabling Licenses
on page 123).

Multiple automated media pool partitions can exist. Since they are
library managed partitions, an AMP exists solely within the library
and is not accessible to hosts.

You may have multiple AMP partitions. However, the total number
of standard and library managed partitions cannot exceed the
maximum of 16 partitions.

All storage slots in the AMP partition must be licensed (via COD).

AMP partitions do not contain drives.

Configure Automated Media Pool

Create an AMP Partition

Quantum Scalar i6000 User’s Guide

To configure an AMP, you need to set up one or more AMP partitions
from which to draw media and optional magazine assignments. If you
want to use magazine assignments, you must also configure magazine
extensions in one or more standard partitions.

1

Create an AMP Partition on page 273

Create Magazine Extensions in Standard Partitions on page 274

Configure AMP Import Policies on page 275

Configure AMP Auto Export Policies on page 275

Use Expert Mode to create one or more AMP library managed
partitions. Follow the instructions in Using Expert Mode on
page 139.

When you get to the screen named Partitions - Step 2: Choose
Partition Properties, select AMP from the Partition Type drop-
down menu.
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Create Magazine
Extensions in Standard
Partitions

274

p —
B Partitions - Step 2: Choose Partition Properties &F

Create Partition

Start the wizard by entering the name of the partition.

Name: | ]
Vendor ID: | QUANTUM |
ProductID: | Scalar 6000 |

Partition Type: | Standard v
Standard
EDLM
P
Active Vault

[ < Back J[ Next = ][ f ][ Cancel ][ Help ]

_ = J

Magazine extensions are logical storage slot extensions of a standard
partition. You need at least one AMP partition to take advantage of
actually assigning storage element extensions, so you must create
magazine extensions in one or more standard partitions. You can use
magazines from an AMP partition to provide additional storage slots as
needed.

If the standard partition you want to use with the AMP partition doesn’t
have extensions defined, you must modify the standard partition (see
Modifying Partitions on page 145).

Note: You can only create magazine extensions in standard partitions
(not library managed partitions).
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Configure AMP Import You can only configure import AMP policies on standard partitions (not
Policies library managed partitions).

1 Click Setup > Partitions > Policies > Auto Import Configuration.
The Auto Import Configuration dialog appears.

-
B Auto Import Configuration &r

Select the partition you would like to modify from the list in the table below. Then enter or modify the filter
in the “"Enter Import Filter” table column cell.

Partition Name Enter Import Filter
7404 Partition
Mac 000100-000199; 000200-000299
P1_renamed
RHEL
Simpana

[ OK ][ Cancel ][ Help ]
J

[

2 For a specific partition, enter a range of barcode numbers in the
Enter Import Filter field. Multiple filters can be listed but must be
separated by a semi-colon.

3 Click OK.

Note: Import filters will be applied to the barcode label only. The
filters will not consider any media ID (e.g. L4, L5, etc) on the

barcode.
Configure AMP Auto You can only configure export AMP policies on standard partitions (not
Export Policies library managed partitions). However, this export function cannot be

performed from the user interface. Instead, any SCSI MOVE commands
performed on the standard partition to an assigned I/E elements will
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have the media redirected to the designated AMP partition. See Step 5
on page 262 in Chapter 4, Active Vault for redirect options.

1 Click Setup > Partitions > Policies > Auto Export Configuration.

The Auto Export Configuration dialog appears.

' A
B Auto Export Configuration @

Auto Export Configuration
Select an option to perform, and a partition on which to perform it. You can enable, modify or disable Auto
Export policies on any Standard partition in the library.

@ Enablel ) Modify (O Disable

Select Partition Policy Status Serial Number|
[l |7404 Partition Disabled Online |273100107_LL3

[ Imac Disabled Online |273100107_LL1
[] |P1_renamed Disabled Online |273100107_LL6
[] |RHEL Disabled Online |273100107_LLO
[] |Simpana Disabled Online |273100107_LL2

Destination: | AMP_CV - |

(o cance | Hep |

Select the partition for which you want to enable, modify or disable
the policy by clicking the check box in the Select column.

From the Destination drop-down menu, select the AMP partition to
which you want the tapes exported.

Click OK.

Use an Automated Media Pool

276

An AMP has two functions:
* Assign Storage Magazines to/from the AMP on page 277 — Assigns

storage elements from the AMP to a standard partition, or from a
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standard partition to the AMP. This allows you to control access to
partition storage elements without requiring partition
reconfiguration for host applications.

Move Media to/from the AMP on page 279 — Physically moves
media from the AMP to a standard partition, or from a standard
partition to the AMP. The media then belongs to the partition into
which it was moved.

If a standard partition has used all of its physical slots and needs more
storage elements, you can assign more slots from the storage pool in
the AMP to the partition’s logical element extension address range. The
host will then recognize these slots as accessible and begin using them.

Similarly, if a partition no longer needs all of its storage slots, you can
assign storage elements (magazines) back to the AMP so that these
magazines can be assigned and used by other standard partitions.

The following rules apply when assigning storage elements:

The AMP must have slots (at least one magazine) available.

The number of slots you want to reassign are referenced in
magazine increments.

The standard partition must have sufficient “magazine extensions”
configured to allow magazine assignments.

Magazines can be reassigned whether or not they contain tape
cartridges. Any cartridges in the magazines will be reassigned to the
new partition along with the magazines, so be careful when
reassigning magazines.

Operations to reassign magazines will not take standard partitions
offline since the slots were already configured and known to the
host.

To reassign storage:

1

Make sure you are viewing the physical library (from the View
menu, select the name of the physical library).

Make sure that the standard partition has sufficient “magazine
extensions” configured (see Create Magazine Extensions in Standard

Partitions on page 274.
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3 Click Setup > Partitions > Automated Media Pool > Assign

Magazines. The Assign Magazines: Select Partitions screen

appears.

) :
IBY Assign Media: Select Partiions 8 R

S

Select the partition from the Remove From table whose media you want to reassign to the partition you will select in the
Assign To table.Only Automated Media Pool partition media can be reassigned to Standard partitions and vice verss.

rRemove From:

Select Name Type Status Empty Slots # Media
[_] 7404 Partition Standard  |Online 6 (Storage) 0 (IE) 0
[ |AMP_CV AMP Offline 6 (Storage) 6 (IE) 0
[ |Mac Standard  |Online 21 (Storage) 6 (IE) 3
[] |P1_renamed Standard  |Online 4 (Storage) 0 (IE) 2
[_] |Partition01 Standard  |Online 0 (Storage) 0 (IE) 0
[ |RHEL Standard  |Online 9 (Storage) 9 (IE) 24
[] |testtest Standard  |Online 0 (Storage) 0 (IE) 0
[_] |Training1 Standard  |Online 0 (Storage) 0 (IE) 6

rAssign To:
Select Name Type Status Empty Slots # Media
[] |7404 Partition Standard  |Online 6 (Storage) 0 (IE) 0
[ |AMP_CV AMP Offline 6 (Storage) 6 (IE) 0
[ |Mac Standard  |Online 21 (Storage) 6 (IE) 3
[_] |P1_renamed Standard  |Online 4 (Storage) 0 (IE) 2
[]  |Partition01 Standard  |Online 0 (Storage) 0 (IE) 0
[] |RHEL Standard  |Online 9 (Storage) 9 (IE) 24
[ |testtest Standard  |Online 0 (Storage) 0 (IE) 0
[_] |Training1 Standard  |Online 0 (Storage) 0 (IE) 6

OK

][ Cancel ][

Help |

the Remove From list.

Assign To list.

Select the partition from which you wish to remove magazines from

Select the partition to which you wish to assign magazines from the

Note: The Empty Slots column displays both storage and IE slots.

Click OK. The Select Segments screen appears.
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= Assign Magazines g

Selact the segments from parition amp which will be re-assigned to parition Standardz.

rSelect Location— Select Segments
lisle 1 ] Number of Slots ] Location
@ Module 1 ] 5 1

[ J [ cancel ][ Hew ]

7 Select the module(s) and rack(s) from the Select Location column.
8 Select the magazine segment(s) from the Select Segments column.

9 Click OK. The magazines are reassigned.

Move Media to/from Moving media from an AMP to a standard partition and vice versa
the AMP physically moves the media into the target partition and reassigns the
media to that partition.

Note: You can also accomplish this by following the instructions in
Moving Media Between Active Vault or AMP and Standard
Partitions on page 698.

1 Make sure you are viewing the physical library (from the View
menu, select the name of the physical library).

2 Click Setup > Partitions > Automated Media Pool > Assign
Media. The Assign Media: Select Partitions screen appears.
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= Assign Media: Select Partitions

Selact the partition form the Remowve From table whoze media wou want to reaszign to the pardition ywou will select in the
Aszsign To table.Only Automated Media Pool parition media can be reassigned to Standard paritions and wiza verza.

rRemove From:

Select | Name | Type [ Status [ EmptySlots [ #Media
[ |amp AMP Offline 18
[  |Standard2 Standard Offline 82 2

[ »

[

rAssign To:
Select | Name | Type [ Status [ EmptySlots [ #Media
[ |amp AMP Offline 18
[  |Standard2 Standard Offline 82 2

[ J [ cancel ][ Hew ]

3 From the Remove From section, select a partition from which to
move media. From the Assign To section, select a partition into
which to move media.

4 Click OK. The Assign Media from Automated Media Pool screen
appears.
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= Assign Media from Automated Media Pool El

Selact the Slot Type (Storage or YE) whose media you want to reassign. Only the media from the
selectad slot Type will be reassigned. The Select Media table will be populated with media from the
Slot Type selected. The media selected from the Select Media table for the parition [Standard2)
will be mowved to parition [amp).

~Select Media Slot Type to move

Slot Type: Storage Slots

Select Media
[Z] Select All
| Barcode | Slot Type | Location | Element |
] |oo0404L3 Storage Slot  [1,1,1,1, 2, 2 a0a7
[J |ooiszels Storage Slat  [1,1,1,1, 2,1 4096

[ J [ cancel ][ Hew ]

5 From the Select Media Slot Type to move drop-down list, select
the area from which you want to move the media (Storage Slots or

I/E Slots).
6 From the Select Media list, select the tape(s) you want to move.
7 Click OK.
Auto Import Media 1 From the View menu, select the AMP partition from which you

want to import tapes.
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,
B Scalar i6000 Library Management Console -

——

user: admin

Operations Monitor Setup Tools

View | Connection Help

hubble (Physical)

o) |l | e

TICKET|

7404 Partition (Partition)

LOG OFF

AMP_CV (Partition "AMP")

1/E IMPORT
r System Information
Name: Physical Library: hubble
IP Address: 10.20.163.105
Contact: Kenton Meyer
Activity: Idle

AV_CV (Partition "Active Vault')
Mac (Partition)

P1_renamed (Partition)

RHEL (Partition)

Simpana (Partition)

Status: Online
#: 273100107
2014 11:41:47 MDT

Views...

|' Data Transfer———————
U

o

[ WRITE |

|

2 Select Operations > Auto Import...The Auto Import Media dialog

box displays.

.
B Auto Import Media

e

Automatically import media

- Media
MedialD | Partition Coordinate Results |
005091L5 Mac 1,0,1,8.4.1
005151L5 Mac 101,843
000573L5 |P1_renamed 11,0,1,842

[ Import J[ Refresh J[ Close J[ Help J

Click Import. The library will begin importing the media to their
respective destinations based on the configured barcode filters.
When complete, the Results column will display the new location,
in coordinates, of the media.

Click Refresh to refresh the Auto Import Media dialog box to
ensure the media was imported.

Click Close.
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The library is initially licensed for a default configuration of 100 storage
slots.

Capacity on Demand allows you to purchase capacity for your library as
needed. As your storage needs change, you can add storage in blocks of
100. Scalar i6000 licensing begins at 100 cartridges and can be
increased to as many as 7,146 LTO cartridges (for a single-robot library)
or 7,224 LTO cartridges (for a dual-robot library).

Note: Maximum numbers assume only one drive and one 24-slot I/E
station in the control module.

Note: Cleaning slots do not count against the libraries available COD
account.

To gain the use of additional storage slots, you must purchase a
Capacity on Demand license for the desired number of slots.

The library also accommodates the use of unlicensed slots in the
following circumstances:

* Your library ships with enough modules to meet your Capacity on
Demand needs. If you require additional physical capacity to be
physically prepared for non-disruptive future expansion, you can
order one or more Unlicensed Expansion Modules.
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* You can also use Unlicensed Expansion Modules to accommodate
the Active Vault and Extended Data Lifecycle Management (EDLM)
features, which do not require the use of licensed slots.
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Encryption Key
Management

This chapter covers:

* Encryption Key Management Systems on page 285

* KMIP-compliant Encryption Key Management on page 287

* FIPS-Certified Encryption Solution on page 287

* Setting up EKM on the Scalar i6000 on page 291

* Using EKM Path Diagnostics on page 309

* Monitoring EKM Server Status on page 311
* Using Q-EKM on page 313

* Using SKM on page 314

Encryption Key Management Systems

Encryption key management systems generate, protect, store, and
manage encryption keys. These keys are used by their respective tape
drives to encrypt information being written to tape, and decrypt
information being read from tape media.

Encryption Key Management (EKM) is a licensable feature. You must
have an EKM license installed on your library in order to use the
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Encryption Key Management features described in this chapter. For
more information on licensing, see Enabling Licenses on page 123 or
Step 1 — Installing the EKM License Key on page 291.

The Scalar i6000 supports four encryption key management systems:

Encryption System

Supported Tape Drives

Supported Media

Quantum Encryption Key Manager (Q-
EKM)

IBM LTO-4 Fibre Channel
IBM LTO-5 Fibre Channel
IBM LTO-6 Fibre Channel

IBM LTO-4, LTO-5, and
LTO-6

Scalar Key Manager (SKM)

HP LTO-4 Fibre Channel
HP LTO-5 Fibre Channel
HP LTO-6 Fibre Channel
IBM LTO-5 Fibre Channel
IBM LTO-6 Fibre Channel
IBM LTO-7 Fibre Channel

HP LTO-4, LTO-5 and
LTO-6

IBM LTO-5, and LTO-6
LTO-7

KMIP-compliant key management (see
KMIP-compliant Encryption Key

Management on page 287).

HP LTO-4 Fibre Channel
HP LTO-5 Fibre Channel
HP LTO-6 Fibre Channel
IBM LTO-5 Fibre Channel
IBM LTO-6 Fibre Channel
IBM LTO-7 Fibre Channel

HP LTO-4, LTO-5, and
LTO-6
IBM LTO-5, LTO-6 and
LTO-7

Note: The library does not support using more than one encryption

286

key management system on a single library.

Encryption on the Scalar i6000 tape library is enabled by partition only.
The default setting for encryption-capable drives permits external
application-managed encryption support on all encryption-capable tape
drives and media within a partition.

You cannot select individual drives for encryption; you must select an
entire partition to be encrypted. If you encrypt a partition, all
encryption-capable tape drives are enabled for encryption, and all data
written to supported media is encrypted. Non encryption-capable tape
drives will not be enabled for encryption, and non-supported media will
not be encrypted.
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You can only configure the encryption settings through the Setup >
Encryption > Partition Configuration functionality.

KMIP-compliant Encryption Key Management

The Key Management Interoperability Protocol (KMIP) is a specification
developed by OASIS®. Its function is to standardize communication
between enterprise key management systems and encryption systems.
With version i8.2.1, the Scalar i6000 provides a KMIP version 1.0
compliant encryption solution.

KMIP is only supported in certain environments. Contact your Quantum
representative for details.

Details about the Scalar i6000 KMIP-compliant implementation include:

* As with other encryption systems supported by the library, in order
to use KMIP-compliant encryption systems with the Scalar i6000,
you must have an Encryption Key Management license installed on
the library.

* A minimum of two KMIP-compliant encryption servers are required
for failover purposes. A total of 10 KMIP-compliant encryption
servers are allowed, for increased failover capability.

See Encryption Key Management Systems on page 285 for instructions
on how to configure KMIP-compliant encryption systems on the library.

FIPS-Certified Encryption Solution

FIPS (Federal Information Processing Standard) 140-2 is a U.S.
government standard relating to computer security and encryption.

The Quantum Scalar i6000 now offers a FIPS 140-2 Level 1 certified
encryption solution composed of the Scalar Key Manager and HP LTO-5
and laterFibre Channel tape drives in a Scalar i6000 library. FIPS mode
can be enabled on the HP LTO-5 and later tape drives via the library user
interface. Once in FIPS mode, all encryption key communication
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between the tape drive and the library controller is authenticated and
encrypted.

Details about configuring FIPS mode include:

Library firmware must be at version 630Q or later.

HP LTO-5 and later tape drive firmware must be at the latest version
qualified with the Scalar i6000 library (see the Scalar /6000 Release
Notes for qualified firmware levels).

An Encryption Key Management license must be installed on the
library sufficient to cover the tape drive(s) on which you want to
enable FIPS mode.

A Storage Networking license must be installed on the library.

Note: Use of FIPS on a drive does not count against the Storage
Networking license drive count. FIPS is not considered a
“Storage Networking feature;” however, the SNW license is
still required on the library.

FIPS mode is configured by partition. FIPS partitions must contain
only HP LTO-5 or later FC tape drives.

The partition encryption method must be set to Enable Library
Managed in order to set FIPS mode.

FIPS mode is disabled by default.

The library must be connected to Scalar Key Manager (SKM). SKM
software must be at version 2.0 or later in order to be FIPS certified.
FIPS currently only works with SKM.

Ethernet connectivity is required for the tape drives on which you
want to enable FIPS mode. This means that every HP LTO-5 or later
FC drive in the partition must be connected to an Ethernet
Expansion blade installed in the library.

Caution: If the Ethernet Expansion blade fails and the attached
tape drives have FIPS mode enabled, all encryption
operations (encrypting, decrypting, key requests) on
the attached tape drives will fail. If this happens,
contact Quantum Support for a replacement Ethernet
Expansion blade as soon as possible.
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Enabling and Disabling To operate your HP LTO-5 or later Fibre Channel tape drives to be
FIPS Mode on HP LTO-5 compliant with FIPS, you must enable “FIPS mode.” FIPS mode is
or Later Tape Drives enabled by partition. You enable FIPS mode on a partition, which
enables FIPS mode on all of the tape drives in the partition.

To change FIPS mode for a partition, do the following:
1 Log on as an administrator.

2 Make sure you are viewing the physical library (from the View
menu, select the name of the physical library).

3 Select Setup > Encryption > Partition Configuration. The EKM
Partition Configuration dialog box displays (see Figure 44).

4 Change the Encryption Method of a partition to Enable Library
Managed.

5 Select the FIPS check box to enable FIPS mode for the partition.
Clear the FIPS check box to disable FIPS mode for the partition.

6 Click OK.

Figure 44 Enabling FIPS Mode

—

B EKM Partition Configuration x]

el

Select to enable "Library Managed" encryption from the list of encryption capable partitions. Encryption is
only supported on media that are LTO-4 generation or later and IBM and HP Fibre Channel tape drives that
are LTO-4 generation or later. To enable FIPs, you must have an SNW license installed, the drives must be
HF LTOS or greater and be connacted to EEE's. Only the selactad parttion will be modified. Refer to the
docurmnertation for more details.

| Partition | Library Managed |  Type | FIPS | Reuse Keys |
{0 |HPLE : % |SKM | O
@ North East Partition v SKM 0| M

[ oK J[ Cancel ][ Help J
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Viewing FIPS Status on

To view FIPS status on partitions, do either of the following:
the Library

* The Partition Configuration dialog box (Setup > Encryption >

Partition Configuration) shows which partitions are enabled for
FIPS. All tape drives in FIPS partitions are enabled. See Figure 44 on

page

289.

* The Partitions Status report (Monitor > Partitions > Status) lists
FIPS in the Encryption column if FIPS is configured on the partition.

Partitions Status

x|
Jto Drive Clean | Encryption [ LCP WWPN [ Library Type

abled Unknown NAA Standard

abled Application Managed  |N/A Library Managed (EDLM)
abled |Library Managed A Standard

abled

|Library Managed (FIPS) |500308c001396020 |Standard

[

Details JL Refresh ][ Close JL Help ]
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Setting up EKM on the Scalar i6000

Step 1 — Installing the
EKM License Key

Quantum Scalar i6000 User’s Guide

The following features are available forthe library.
Enterthe license key to enable the features.
Mote: The license key is not case sensitive.

1 Click Setup > Licenses. The Licenses dialog box appears.

- Licenses g|

Name | Status | Expiration |  Quantity |
Active Vault Enabled |Permanent |1License
Advanced Reporting Enabled |Permanent |1License
Capacity On Demand Enabled |Permanent |65000 Slots
Encryption Key Management Enabled |Permanent |96 Drives
Extended Data Lifecycle Management |Enabled |Permanent |1 License
Partition Enabled |Permanent |16 Partitions
Partition Utilization Enabled |Permanent |1License
Storage Networking Enabled |Permanent |96 Drives

Enter License Key: |

[ DK J [ Cancel J [ Help J

This dialog box lists the licensed features for your library, plus
Status, Expiration, and Quantity. Quantity refers to the number
drives licensed to use this feature.

2 In the Enter License Key box, type the appropriate license key.

* License keys are not case sensitive and are all-inclusive. For

example, J2BGL-22622-52C22 can be entered as j2bgl-22622-
52c22.

If you are using the library’s touch screen, enter the library key
from the lowercase keyboard, which gives you access to the
dash (-) character.

If you cannot locate the license keys shipped with the library,
you can obtain them by contacting technical support or, if you
are an end user, by contacting your inside sales representative.

3 Click OK.
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Step 2 — Preparing
Partitions for Library-
managed Encryption

Step 3 — Installing TLS
Communication
Certificates on the
Library

1 If not already installed, install tape drives that are supported by the
encryption system you are using (see Supported Tape Drives on

page 286).

2 Ensure that the partition you are configuring for library-managed
encryption contains only tape drives that are supported by the
encryption system you are using.

3 On the tape drives, install the latest version of firmware that is
qualified for the library firmware installed on your library. Refer to
the library release notes for the correct version of tape drive

firmware.

Transport Layer Security (TLS) communication certificates are unique
certificates that must be installed on the library in order for the library
to communicate securely with attached EKM servers.

Take one the following actions, according to what encryption System

you are using.

Encryption System

Action

Quantum Encryption
Key Manager (Q-
EKM) or Tivoli Key
Lifecycle Manager
(TKLM) or Secure Key
Lifecycle Manager
(SKLMm)

Only one TLS certificate (the Root certificate)
is required. Libraries with code versions
600A.GS23201 and higher generate a self-
signed certificate when first booting up, and
regenerate the certificate if it expires. You do
not need to take any action unless you want
to install your own Root certificate to
supersede the existing certificate. If want to
install your own certificate, then follow the
instructions in Installing User-Provided
Certificates on page 297.

292
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Encryption System

Action

Scalar Key Manager
(SKM)

TLS certificates may already be pre-loaded on
the library.

1 Check to see if certificates are loaded. See
Checking for Current Certificates on
page 294,

Note: If certificates have already been pre-
loaded by Quantum, you can replace
them by installing your own
certificates, if desired.

2 If needed, install certificates following the
appropriate set of instructions:
* Installing SKM Library TLS Certificates
from Quantum CD on page 295, or

* |nstalling User-Provided Certificates on
page 297.

KMIP-compliant key
management

TLS certificates will be provided by your KMIP
server administrator. Install certificates per
Installing User-Provided Certificates on

page 297.
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Checking for Current Certificates

Follow the steps below to see what certificates are already loaded on
your library.

1 From the Tools menu, select EKM Management > Import
Communication Certificates. The Communication Certificate
Import dialog box appears.

B Communication Certificate Import (x]
 Select Certificates

Key Server Type: | SKM -

Root Certificate File: | | | Browse |

Admin Certificate File: | | | Browse |
Admin Certificate Password: | |

Client Certificate File: | | | Browse |

Client Certificate Password: | [C1 Use Admin's Password

[Z1 Use the Quantum Certificate Bundle

Current Certificates -

Type | Location | Serial Number | Valid Between Dates | Status |
| May 117:45:00 2009 GMT | |lssuer C: U5, S CA
Roov  |lbrary  (AC3L41FDA6. ay 117:45:00 2019 GMT Y3 Subject: € s, 5: €A,

May 1 19:01:00 2009 GMT [ Issu:'r CUS, 5 CA

Clent  ibrary cC May 11901002015 M7 |"¥  Eibjmct € U5 5 oA
- ; May 119.01.00 2009 GMT | lssuer. C. U5, 5. CA,
el s I May 119:01:002019 GMT  |“¥'?  Bupject: U5, 5 Ca

| 0] % || Cancel || Help |

Note: The Current Certificates section of the screen lists the
certificates currently loaded on the library. If you install
new certificates, they will overwrite the current certificates.

2 Confirm which certificates are appropriate for your installation.
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3 Install certificates if needed, following the instructions in the
following table for your encryption system.

Encryption
System

Action

Q-EKM or TKLM/
SKLM

If you wish to install your own Root certificate to
supersede the existing self-generated certificate
on the library, follow the instructions in Installing
User-Provided Certificates on page 297.

SKM

For SKM, you can either:

¢ Install from the Quantum certificate bundle on
CD. Refer to Installing SKM Library TLS
Certificates from Quantum CD on page 295.

* Install your own certificates. Refer to Installing
User-Provided Certificates on page 297.

KMIP-compliant
key
management

You must use certificates provided by the KMIP
server administrator. Refer to Installing User-
Provided Certificates on page 297.

Installing SKM Library TLS Certificates from Quantum CD

Note: The Quantum certificate bundle can be used only with SKM.
Quantum TLS certificates for use with SKM may already be pre-
loaded on your library. Check if these exist before adding new
TLS certificates for SKM. Refer to Checking for Current
Certificates on page 294.

1 Insert the CD into the CD ROM drive of your computer.

2 Either copy the file to a known location on your computer or use the
CD as the location from which you will retrieve the file.

3 From the Tools menu, select EKM Management > Import
Communication Certificates. The Communication Certificate
Import dialog box appears.
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B Communication Certificate Import [x]
- Select Certificates

Key Server Type: | SKM -

Root Certificate File: | | | Browse |

Admin Centificate File: | | | Browse |

Admin Certificate Password: | |

Client Certificate File: | | | Browse

Client Certificate Password: | | [C] Use Admin's Password

[ Use the Quantum Certificate Bundle

- Current Certificates

Type | Location | Serial Murmber | Valid Between Dates [ Status |
Rool |Lbrary  |AC3L41/D46. 0 117500 003010 anT |"Y9 ujest C LS, 5 CA
saminorary o May 115:01002015 aNT '™ Supject C- 15,5 A
[*]]
| [6].% || Cancel || Help |

4 In the Select Certificates section, select SKM from the Key Server
Type drop-down list.

5 Select the Use Quantum Certificate Bundle check box, and then
click Browse to locate the Quantum Bundle File.

Note: If you have installed certificates, they are listed in the
Current Certificates section.

6 Click OK.

Note: Whenever the Compact Flash (CF) is replaced, SKM certificates
must be reinstalled.
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Installing User-Provided Certificates

Follow these instructions to install your own TLS certificates, or when
installing TLS certificates for KMIP. When providing your own
certificates, it is assumed you understand the concepts of PKI and can
access the tools or third-party resources needed to generate or obtain
certificates.

Note: If you are using SKM, you must be running SKM 1.1 or higher
on your SKM servers in order to install your own TLS
certificates.

Note: If you are using RSA or KMIP, your server provider will provide
TLS communication certificates.

You need to provide the following certificates:

Encryption

System Certificates Required

Q-EKM or TKLM/ | ¢ Root Certificate (also called the CA certificate,
SKLM or Certificate Authority Certificate)

SKM ¢ Root Certificate (also called the CA certificate,

or Certificate Authority Certificate)
* Client Certificate
¢ Admin Certificate

KMIP-compliant | ¢ Root Certificate (also called the CA certificate,
key or Certificate Authority Certificate)

management * Client Certificate

These files must be in the proper format, as follows. If any of the
following requirements is not met, none of the certificates will be
imported.

* The Root Certificate must be 2048 bits.
* The Root Certificate must be in PEM format.

* The Admin and Client certificates must be in pkcs12 (.p12) format,
with a separate certificate and private key contained in each.
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